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الفصل الأول 
 

 الإنترنت وتطبيقاته في العملية التعليمية
 

- مقدمة : 
إن من معالم ثورة الاتصالات الحديثة الشبكة العالمية    

) التي انتشرت في Internet (للمعلومات أو ما يسمى الإنترنت
جميع دول العالم ودخلت معظم البيوت والمؤسسات التجارية 

والترفيهية والسياسية والتعليمية...الخ. 
 وتطبيقاته في Internetوفيما يلي نبذة مختصرة عن الإنترنت 

العملية التعليمية : 
 
  الإنتـرنـت:تعريف  -

هي مجموعة من الشبكات المتصلة ببعضها البعض حول    

. أي هي المنظومة العالمية العالم لتبادل المعلومات فيما بينها

التي تربط مجموعة من الحاسبات بشبكة واحدة وهي اختصار 

وقد بدأت شبكة الإنترنت في الولايات  internet workلكلمة 

المتحدة الأمريكية شبكة عسكرية للأغراض الدفاعية ، ولكن 

بانضمام الجامعات الأمريكية ثم المؤسسات الأهلية والتجارية – 

في أمريكا وخارجها – جعلها شبكة عالمية تستخدم في شتى 

مجالات الحياة 
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 أهم المميزات التي شجعت - مميزات شبكة الإنترنت:

التربويين على استخدام شبكة الإنترنت في التعليم ما يلي: 

 حيث يستطيع أي فرد أن :- سرعة وضمان انتقال المعلومات1

يرسل خطاباً إلى ملايين الأفراد في وقت واحد من خلال 

الإنترنت، بعكس البريد العادي الذي يستغرق أياماً بل أسابيع ، 

والعكس صحيح أيضاً ، إذ يستطيع ملايين الأفراد تعرف 

معلومة معينة أو رسالة أو نبأ في وقت واحد إذا عرفت مكانها، 

 CNN وهذا هو المتبع في وكالات الأنباء العالمية ، مثل 

وغيرها، حيث تضع الأخبار والنشرات الجوية على أجهزة 

الكمبيوتر ، ويستطيع ملايين الناس الحصول على هذه الأخبار 

دون انتظار. 

 وهذه السرية تأتي من أن كل جهاز  :- سرية المعلومات2

مرتبط بالإنترنت له رقم خاص به أو اسم معروف به ، 

وبالتالي يستطيع أي فرد أن يرسل رسالة إلى جهاز بعينه 

ويضمن أنها خزنت بداخله ، ويطمئن إن كانت وصلت أم لا ، 

ووقت الاستلام ، ويستطيع المرسل إليه الرد الفوري على 
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الرسالة . 

 يمكن إرسال واستقبال أي مستند من أي تبادل المستندات:- 3

جهاز كمبيوتر مرتبط بالإنترنت مهما كان نوع المستند 

وحجمه، سواء كان خطابا أو مذكرة أو كتاباً أو شريط كاسيت 

أو فيديو. 

 لا تحتاج إلى شراء :الحديث والمشاورة وعقد المؤتمرات- 4

كمبيوتر خاص أو أجهزة اتصال معتمدة، فأي جهاز كمبيوتر 

يصلح ما دام تم ربطه بخط تليفون، ولا يحتاج الإنترنت إلى 

مستوى علمي أو فني عال للتشغيل. 

 توفر شبكة الإنترنت مئات الألعاب :التسلية والترفيه-5

الإلكترونية البسيطة المجانية بما في ذلك: طاولة الزهر، 

الشطرنج، الورق، كرة القدم بأنواعها وغير ذلك. ، كما تمكنك 

شبكة الإنترنت من قراءة ما يكتبه النقاد السينمائيون عن الأفلام 

الحديثة التلفزيونية والأغاني ذات الموضوع الواحد ونصوص 

 الأفلام السينمائية.

 

 يمكن طلب مختلف :التسوق من خلال شبكة الإنترنت  -6



4 
 

أنواع البضائع التي ترغب الحصول عليها دون الذهاب إلى 

السوق أو مغادرة البيت، فيمكن شراء مختلف المواد كالكتب 

وبرامج الكمبيوتر والأزهار واسطوانات الموسيقى والبيتزا 

والأسهم والسيارات المستعملة وغيرها . 

:  يمكن الاشتراك مع مجموعات النقاش مجموعات النقاش- 7

من خلال شبكة الإنترنت للالتقاء بمختلف الأفراد والشخصيات 

حول العالم ممن لهم الاهتمامات ذاتها. ويمكن توجيه أسئلة 

إليهم أو تقديم أفكار أو مناقشة قضايا هامة أو قراءة قصص 

شائقة.،و هناك الآلاف من مجموعات النقاش التي تناقش 

مختلف الموضوعات مثل: البيئة والطعام والمرح والموسيقى 

والسياسة والدين والرياضة والتلفزيون وغيرها. 

إن شبكة الإنترنت تعد المساهم الرئيسي فيما يشهده العالم اليوم 

من انفجار معلوماتي ، وبالنظر إلى سهولة الوصول إلى 

المعلومات الموجودة على الشبكة مضافاً إليها المميزات 

الأخرى التي تتمتع بها الشبكة فقد أغرت كثيرين بالاستفادة 

منها كل في مجاله ، من جملة هؤلاء ، التربويون الذين بدءوا 

باستخدامها في مجال التعليم ، حتى أن بعض الجامعات 
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الأمريكية وغيرها ، تقدم بعض موادها التعليمية من خلال 

 الإنترنت إضافة إلى الطرق التقليدية .

 

  :الوفرة الهائلة في مصادر المعلومات- 8
 Electronicومن أمثال هذه المصادر ( الكتب الإلكترونية 

Book الدوريات ،Periodicals قواعد البيانات ،Data 

Bases الموسوعات ،Encyclopedias المواقع التعليمية ،

Educational Sites.(  

 يستطيع  ) :الاتصال غير المباشر (غير المتزامن- 9

الأشخاص الاتصال فيما بينهم بشكل غير مباشر ومن دون 

اشتراط حضورهم في نفس الوقت باستخدام : 

): حيث تكون الرسالة والرد E –mail- البريد الإلكتروني (

 كتابياً .

):  حيث تكون الرسالة والرد Voice- mail- البريد الصوتي (

 صوتياً .

 وعن طريقه يتم التخاطب الاتصال المباشر(المتزامن ):-10

في اللحظة نفسها بواسطة: 
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 ) حيث يكتب الشخص ما Relay-Chat- التخاطب الكتابي (

يريد قوله بواسطة لوحة المفاتيح والشخص المقابل يرى ما 

يكتب في اللحظة نفسها، فيرد عليه بالطريقة نفسها مباشرة بعد 

انتهاء الأول من كتابة ما يريد. 

 ) حيث يتم Voice-Conferencing- التخاطب الصوتي (

التخاطب صوتياً في اللحظة نفسها عن طريق الإنترنت. 

التخاطب بالصوت والصورة (المؤتمرات المرئية) (  -

Video-conferencing حيث يتم التخاطب حياً على الهواء (

بالصوت والصورة. 

- أسباب استخدام الإنترنت في التعليم: 
هناك أربعة أسباب رئيسية لاستخدام الإنترنت في التعليم:    

-الإنترنت مثال واقعي للقدرة على الحصول على المعلومات 1

من مختلف أنحاء العالم. 

 - يساعد الإنترنت على التعلم التعاوني الجماعي ، فنظراً 2

لكثرة المعلومات المتوفرة عبر الإنترنت فإنه يصعب على 

الطالب البحث في كل القوائم لذا يمكن استخدام طريقة العمل 

الجماعي بين الطلاب ، حيث يقوم كل طالب بالبحث في قائمة 
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معينة ثم يجتمع الطلاب لمناقشة ما تم التوصل إليه. 

- يساعد الإنترنت على الاتصال بالعالم بأسرع وقت وبأقل 3

تكلفة. 

- يساعد الإنترنت على توفير أكثر من طريقة في التدريس 4

ذلك أن الإنترنت هي بمثابة مكتبة كبيرة تتوفر فيها جميع الكتب 

سواء كانت سهلة أو صعبة. كما أنه يوجد في الإنترنت بعض 

البرامج التعليمية باختلاف المستويات . 

 :كما يتميز الإنترنت الكثير من الإيجابيات منها

 .- المرونة في الوقت والمكان1

- إمكانية الوصول إلى عدد أكبر من المتابعين في مختلف 2

 .الأماكن

- سرعة تطوير البرامج مقارنة بأنظمة الفيديو والأقراص 3

 .(CD-Rom)المدمجة 

- قلة التكلفة المادية مقارنة باستخدام الأقمار الصناعية 4

 .ومحطات التلفزيون والراديو

- تغيير نظم وطرق التدريس التقليدية يساعد على إيجاد فصل 5

 .مليء بالحيوية والنشاط
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 .- سرعة الحصول على المعلومات6

 .(Classroom without Walls)- إيجاد فصل بدون حائط 7

- تطوير مهارات الطلاب على استخدام الحاسوب 8

تطبيقات الإنترنت في التعليم: 
نظراً لكون الإنترنت من أهم وسائل المعلوماتية التي يمكن    

استخدامها في التعليم ،فإنه يمكن اقتراح مجموعة من أهم 

تطبيقات الإنترنت في التعليم وهى : 

 كوسيط  (Electronic Mail)- استخدام البريد الإلكتروني 1

 .بين المعلم والدارس لإرسال الرسائل لجميع الدارسين

 .- كوسيط لتسليم الواجب المنزلي2

- كوسيلة للاتصال بالمتخصصين من مختلف دول العالم 3

 .والاستفادة من خبراتهم وأبحاثهم في شتى المجالات

 .- كوسيط للاتصال بين أعضاء هيئة التدريس والإدارة4

- يساعد الطلاب على الاتصال بالمتخصصين في أي مكان 5

- كوسيط للاتصال بين 6 .بأقل تكلفة وتوفير للوقت والجهد

أن الجامعات  (Scott, 1997)فقد ذكر  .الجامعات في المستقبل

والصين وأوربا اعتمدت البريد الإلكتروني  في اليابان وأمريكا
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 .كوسيلة اتصال معتمدة

- كوسيلة اتصال بين الإدارة والدارسين وذلك بإرسال 7

 .والتعاميم والأوراق المهمة والإعلانات

- كوسيلة لإرسال اللوائح والتعاميم وما يستجد من أنظمة 8

 .لأعضاء هيئة التدريس وغيرهم

وبالجملة فإن هذه بعض التطبيقات في الوقت الحاضر لخدمة 

البريد الإلكتروني ولاشك أن الاستخدام سوف يولد استخدامات 

 .أخرى أكثر وأكثر مما ذكر

 أن البريد الإلكتروني أخيراً وكما سبقت الإشارة إلى

(Electronic Mail) يعتبر من أكثر خدمات الإنترنت شعبية 

 .واستخداماً 

 :وذلك راجع إلى الأمور التالية

 .- سرعة وصول الرسالة

- تتم قراءة الرسالة من المستخدم عادة في وقت قد يكون هيأ 

 .نفسه للقراءة والرد عليها أيضا

إلغاء جميع الحواجز )- لا يوجد وسيط بين المرسل والمستقبل 

 .(الإدارية
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 .- كلفة منخفضة للإرسال

 .- استلام الرد خلال مدة وجيزة من الزمن

 .- يمكن ربط ملفات إضافية بالبريد الإلكتروني

- يستطيع المستفيد أن يحصل على الرسالة في الوقت الذي 

 .يناسبه

- يستطيع المستفيد إرسال عدة رسائل إلى جهات مختلفة في 

 .الوقت نفسه

 
 : في التعليم (Mailing List) استخدامات القوائم البريدية - 

تتكون القوائم البريدية من عناوين بريدية تحتوي في العادة على 

عنوان بريدي واحد يقوم بتحويل جميع الرسائل المرسلة إليه، 

كما أن هناك قوائم بريدية عامة  .إلى كل عنوان في القائمة

  .وأخرى خاصة

إحدى خدمات  (Mailing List)وتعتبر خدمة القوائم البريدية 

الاتصال المهمة في الإنترنت، ولكن كثير من الناس أخفقوا في 

معرفة توظيف هذه الخدمة في جميع المجالات في الحياة 

العامة، ومن هنا يمكن القول إن توظيف هذه الخدمة في التعليم 
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يساعد على دعم العملية التربوية. 

 :ومن أهم مجالاتها التطبيقية ما يلي

 (الشعبة)- تأسيس قائمة بأسماء الطلاب في الفصل الواحد 

 .كوسيط للاتصال مع المجموعة

- توفر إمكانية أن يقوم المشرف الأكاديمي بوضع قائمة خاصة 

به تشتمل على أسماء الدارسين وعناوينهم بحيث يمكن إرسال 

الواجبات المنزلية ومتطلبات المادة عبر تلك القائمة، وهذا 

سوف يساعد على إزالة بعض عقبات الاتصال بين المعلم 

 .والدارسين

- يمكن تأسيس قوائم خاصة بجميع طلاب الجامعات والكليات 

المسجلين بمادة معينة لكي يتم التحاور فيما بينهم لتبادل 

 .الخبرات العلمية

- تأسيس قوائم خاصة بالمشرفين الأكاديميين حسب الاهتمام، 

 .وذلك لتبادل وجهات النظر فيما يخدم العملية التعليمية

- الاتصال بالمهتمين بنفس التخصص حيث يمكن للطلاب أو 

الأساتذة الاتصال بزملاء لهم في مختلف أنحاء العالم ممن 

يشاركونهم الاهتمام في موضوعات معينة لبحث الجديد فيها 
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 .وتبادل الخبرات

- تكوين قوائم بريدية للطلبة والطالبات المهتمين بشئون معينة،  

حيث تتيح الفرصة للطلاب لتبادل وجهات النظر مع أقرانهم 

 .المهتمين بنفس المجال بغض النظر عن أماكن تواجدهم

 

في مجال المناهج الدراسية : - 
- استخدام الإنترنت كوسيلة مساعدة في المناهج، بحيث يمكن 1

وضع المناهج الدراسية في صفحات مستقلة في الإنترنت وتتاح 

الفرص للطالب وولي الأمر بالدخول لتلك الصفحات في المنزل 

 .

- استخدام الإنترنت كوسيلة تعليمية مساعدة في تناول المناهج 2

وشرح موضوع معين. 

 
- في مجال التدريس: 

-استخدام الإنترنت في الحصول على المعلومات المطلوبة من 1

العديد من المواقع. 

- استخدام الإنترنت في تعزيز طرق وأساليب التدريس تفريد 2
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التعليم والتعليم التعاوني والحوار والنقاش . 

- استخدام الإنترنت في حل مشكلات الطلاب الذين يتخلفون 3

عن زملائهم لظروف قاهرة مثل المرض وغيره وذلك من 

 خلال المرونة في وقت ومكان التعلم وكيفيته

- استخدام الإنترنت في زيادة ثقة الطالب بنفسه وذلك بتنمية 4

المفاهيم الإيجابية تجاه التعليم الذاتي . 

- استخدام الإنترنت في عمل بنوك الأسئلة. 5

- استخدام الإنترنت في الاطلاع على الدروس النموذجية. 6

 
ي مجال تنمية الموارد البشرية: ف
-استخدام الإنترنت في عقد البرامج التدريبية سواء كانت 1

للهيئة الإدارية والتدريسية والتوجيهية  وهكذا يمكن متابعة 

الدورات التدريبية والاستفادة منها لأكبر عدد ممكن،ويمكن لأي 

فرد متابعة هذه الدورات من المنزل إذا كان مشترك في 

الإنترنت. 

-استخدام الإنترنت في عقد اجتماعات بين مد راء ومديرات 2

المدارس في دول الخليج العربية دون اللجوء إلى السفر إلى 
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مكان واحد،بهدف تبادل الخبرات والاطلاع على التجارب 

التربوية 

- استخدام الإنترنت في استقبال المحاضرات والندوات 3

وورش العمل من أي مكان في دول الخليج العربية. 

 
ي مجال تبادل المعلومات: ف
- استخدام الإنترنت كوسيلة للبحث والإطلاع، بحيث يمكن 1

البحوث  للطالب الدخول على مكتبات الجامعات ومراكز

التربوية والبحث فيها وطباعة الملخصات. 

- ربط الوزارة مع جميع أفرعها ومدارسها بحيث يمكن 2

بسرعة.  استقبال والتعاميم والمراسلات الصادرة من الوزارة

- ربط المدارس بشبكة معينة بحيث يمكن للهيئات الإدارية 3

والمستحدثات  والتدريسية فيها من تبادل الخبرات والتجارب

التربوية مما يؤدي إلى تحقيق الأهداف التربوية المقصودة. 

 العوائق التي تقف أمام استخدام الإنترنت في التعليم :

إن المتتبع لهذه التقنية يجد أن الإنترنت كغيرها من الوسائل 

الحديثة لها بعض العوائق، وهذه العوائق إما أن تكون مادية أو 
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بشرية. ثم إن المتتبع للعقبات التي تواجه الدول الأخرى يجد أن 

هناك توافق مع الواقع الحالي للتعليم العالي في المملكة العربية 

السعودية. وأهم العوائق هي: 

أولاً : التكلفة المادية: 
التكلفة المادية المتاحة لتوفير هذه الخدمة في مرحلة التأسيس 

أحد الأسباب الرئيسية من عدم استخدام الإنترنت في التعليم في 

المملكة العربية السعودية. ذلك أن تأسيس هذه الشبكة يحتاج 

لخطوط هاتف بمواصفات معينة، وحواسيب معينة. ونظراً 

لتطور البرامج والأجهزة فإن هذا يُضيف عبئاً آخر على 

الجامعات. ولاشك أن بعض الجامعات لا تستطيع أن توفر هذا 

خلال سنوات قليلة ثم إن ملاحقة التطور مطلب أساسي من 

مطالب القرن ولهذا لابد من النظر إلى هذا بعين الاعتبار عند 

التأسيس. 

ثانياً : المشاكل الفنية: 
الانقطاع أثناء البحث والتصفح وإرسال الرسائل لسبب فني أو 

غيره مشكلة تواجهها الجامعات في الوقت الحاضر، مما 

يضطر المستخدم إلى الرجوع مرة أخرى إلى الشبكة وقد يفقد 
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البيانات التي كتبها. وفي معظم الأحيان يكون من الصعوبة 

الدخول للشبكة أو الرجوع إلى مواقع البحث التي كان يتصفح 

فيها. 

ثالثاً : اتجاهات المعلمين نحو استخدام التقنية: 
ليست العوائق المالية أو الفنية هي السبب الرئيسي من استخدام 

التقنية، بل إن العنصر البشري له دور كبير في ذلك ، وقد ذكر 

)Michels,1996 في دراسته لنيل درجة الدكتوراه التي تقدم (

بها لجامعة مينسوتا والتي كانت بعنوان (استخدام الكليات 

المتوسطة للإنترنت : دراسة استخدام الإنترنت من قبل أعضاء 

هيئة التدريس) أنه بالرغم من تطبيقات الإنترنت في المصانع 

والغرف التجارية والأعمال الإدارية إلا أن تطبيقات(استخدام) 

هذه الشبكة في التعليم أقل من المتوقع ويسير ببطيء شديد عند 

على " إن البحث McNeilالمقارنة بما ينبغي أن يكون. وشدد 

في اتجاهات أعضاء هيئة التدريس نحو استخدام هذه التقنية 

وأهميتها في التعليم، أهم من معرفة تطبيقات هذه الشبكة في 

). McNeil, 1990, P.2التعليم" (

أما عن أسباب هذا العزوف من بعض أعضاء هيئة التدريس 
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فهو راجع إلى عدم الوعي بأهمية هذه التقنية أولاً، وعدم القدرة 

على الاستخدام ثانياً ، وعدم استخدام الحاسوب ثالثاً . والحل هو 

ضرورة وضع برامج تدريبية للمعلمين خاصة بكيفية استخدام 

الحاسب الآلي على وجه العموم أولاً وباستخدام الإنترنت على 

وجهة الخصوص ثانياً، وعن كيفية استخدام هذه التقنية في 

التعليم ثالثاً . 

ربعاً : اللغة: 
نظراً لأن معظم البحوث المكتوبة في الإنترنت باللغة الإنجليزية 

لذا فإن الاستفادة الكاملة من هذه الشبكة ستكون من نصيب من 

يتقن اللغة وهم قلة قليلة في الجامعات السعودية. ومن هنا يمكن 

القول لابد من إعادة النظر في ما يلي: 

- إعادة تأهيل أساتذة الجامعات في مجال اللغة. 1

- ضرورة بناء قواعد بيانات باللغة العربية لكي يتسنى 2

للباحثين الاستفادة من تلك الشبكة. 

خامساً : الدخول إلى الأماكن الممنوعة: 
إن الأمن الفكري والأخلاقي والاجتماعي والسياسي من أهم 

المبادئ التي تؤكد عليها المؤسسات التعليمية بجميع مراحلها 
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التعليمية، بل أن من أهداف المدارس توفير هذه الحماية السابقة 

الذكر. ونظراً لأن الاشتراك في شبكة الإنترنت ليس محصوراً 

على فئة معينة مثقفة وواعية للاستخدام ، لذا فمن أهم العوائق 

التي تقف أمام استخدام هذه الشبكة هي الدخول إلى بعض 

المواقع التي تدعو إما إلى الرذيلة ونبذ القيم والدين والأخلاق أو 

أنها تدعو إلى التمرد والعصيان على ولاة أمر المسلمين 

وعلمائهم و مشايخهم ، وكل هذا تحت اسم التحرر والتطور 

ونبذ الدين وحرية الرأي إلى غير ذلك من الشعارات الزائفة. 

وللحد من هذا قامت بعض المؤسسات التعليمية بوضع برامج 

) تمنع Firewallخاصة أو ما يسميه البعض بحاجز الحماية (

 Maddoxالدخول لتلك المواقع. لكن الحقيقة كما قال ماد وكس 

من الصعوبة حصر هذه المواقع لكن التوعية بأضرار هذه 

المواقع هو النتيجة الفعالة. 

 )Search Engines(سادساً : كثرة أدوات (مراكز) البحث 
من المشكلات أو العوائق التي تقف أمام مستخدمي شبكة 

الإنترنت هي كثرة أدوات البحث أو كما يسميها البعض بمراكز 

 ,Yahoo ،Lycos, Alta-Vistaالبحث والتي من أهمها 
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Excite, Info seek..… ،WebCrawler . 

والإنترنت عبارة عن محيط عظيم الاتساع والانتشار وبالتالي 

فإن عملية البحث عن معلومة معينة أو موقع معين أو شخص 

معين سوف تكون في غاية الصعوبة ما لم تتوفر الأدوات 

)). وهناك Search Enginesالمساعدة على عملية البحث 

العديد من مراكز البحوث (أدوات البحث) في الإنترنت وهي 

)Gopher, Wais, FTP, Telnet  وقد أشرت إليها عند (

الحديث عن البحث في الإنترنت. 

إن السؤال الحقيقي هو ما الطريقة المثلى للبحث في الإنترنت؟ 

ان الإجابة على هذا السؤال ليست صعبة وليست سهلة في نفس 

الوقت على حد تعبير مالو. 

إن البحث في الإنترنت هو بمثابة البحث في مكتبة كبيرة ، بل 

إن البعض  يسمي الإنترنت " بالمكتبة الكبرى " . 

) Malloyولهذا السبب - اتساع الإنترنت- يرى الباحث مالو (

 The Internetفي كتابة المعروف دليل الباحث في الإنترنت(

Research Guide أنه عند البحث في الإنترنت لابد من (

إتباع ما يلي: 
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- ضرورة تحديد الكلمة (الكلمات) الأساسية في البحث. 

- حدد الفن ( علوم، اجتماع…الخ) الذي سوف تبحث فيه. 

) الذي سوف تبحث Search Engine- حدد المركز أو الموقع(

 فيه.

ومما تجدر الإشارة إليه أن بعض أدوات البحث بدأت تتخصص 

 Info seekشيئاً فشيئاً، أعني بذلك أن بعض المواقع مثل 

اهتمت في المعلومات الجغرافية والأطالس وغيرها أو على 

 فقد ركز على الأمور التربوية Yahooالأقل ركزت عليها أما 

وهكذا. ويتوقع بعض الباحثين في هذه الشبكة نمو التخصص 

في الإنترنت في القريب العاجل. 

كما تجدر الإشارة إلى أن هناك برامج حديثة تقوم بالبحث في 

 أداة 20-10أكثر من أداة في آن واحد، وغالباً ما تجمع ما بين 

فقط لكل مرة. 

: اً : الدقة والصراحةبعسا

) إلى أن نتائج البحوث أشارت إلى أن Glisterأشار قليستر (

الباحثين عندما يحصلون على المعلومة من الإنترنت يعتقدون 

بصوابها وصحتها وهذا خطأ في البحث العلمي ذلك أن هناك 
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مواقع غير معروفة أو على الأقل مشبوهة.  ولهذا فقد نَصح 

) الباحثين والمستخدمين للشبكة بأن يتحروا Scottسكوت (

 الدقة والصراحة والحكم على الموجود قبل اعتماده في البحث.
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 الفصل الثاني
 

 تطبيقات تعليمية ومحركات بحث أكاديمية للطلاب
 
 

 أولاً : محركات بحث أكاديمية
 

1. Egyptian Knowledge Bank (www.ekb.eg): 
 
The Egyptian Knowledge Bank is an initiative that has been launched by 

President Abdel-Fattah El-Sissi During the National Science Day of 2014. And 

through it, the specialized councils of the presidency started to launch several 

national projects concerned with educational development. 
 
2. Google Scholar: 
   
Google Scholar provides a simple way to broadly search for scholarly 

literature. From one place, you can search across many disciplines and sources: 

articles, theses, books, abstracts and court opinions, from academic publishers, 

professional societies, online repositories, universities and other web sites. 

Google Scholar helps you find relevant work across the world of scholarly 

research. Google Scholar aims to rank documents the way researchers do, 

weighing the full text of each document, where it was published, who it was 

written by, as well as how often and how recently it has been cited in other 

scholarly literature. Major features of Google Scholar: 

 

http://www.ekb.eg/
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• Search all scholarly literature from one convenient place 

• Explore related works, citations, authors, and publications 

• Locate the complete document through your library or on the web 

• Keep up with recent developments in any area of research 

• Check who's citing your publications, create a public author profile 

3. Semantic Scholar https://www.semanticscholar.org/ 
Is a free, AI-powered research tool for scientific literature. 

 
 

 
 ثانياً : تطبيقات تعليمية

• 1) Khan Academy  
• 2) Quizlet  
• 3) Duolingo  
• 4) Read Along 
• 5) SoloLearn 
• 6) NASA 
• 7) Google Earth  
• 8) MemRise  
• 9) PhotoMath  
• 10) Google Arts & Culture  
• 11) GoNoodle  
• 12) EdX 
• 13) Brilliant 
• 14) zAmerican English  
• 15) Ted Talks for Kids 

 
 
 
 

https://www.semanticscholar.org/
https://arblog.skolera.com/educational-apps-students/#1_Khan_Academy
https://arblog.skolera.com/educational-apps-students/#2_Quizlet
https://arblog.skolera.com/educational-apps-students/#3_Duolingo
https://arblog.skolera.com/educational-apps-students/#4_Read_Along
https://arblog.skolera.com/educational-apps-students/#5_SoloLearn
https://arblog.skolera.com/educational-apps-students/#6_NASA
https://arblog.skolera.com/educational-apps-students/#7_Google_Earth
https://arblog.skolera.com/educational-apps-students/#8_MemRise
https://arblog.skolera.com/educational-apps-students/#9_PhotoMath
https://arblog.skolera.com/educational-apps-students/#10_Google_Arts_Culture
https://arblog.skolera.com/educational-apps-students/#11_GoNoodle
https://arblog.skolera.com/educational-apps-students/#12_EdX
https://arblog.skolera.com/educational-apps-students/#13_Brilliant
https://arblog.skolera.com/educational-apps-students/#14_National_Geographic_Kids
https://arblog.skolera.com/educational-apps-students/#15_Ted_Talks_for_Kids
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 Khan Academy (1  
 

 منظمة هي خان أكاديمية فإن خان. أكاديمية هي للطلاب تعليمية تطبيقات أفضل أحد

 عمه أبناء لمساعدة مشروعه البداية في بدأ أميركي معلم وهو خان، سال أنشأها تعليمية

 من تعليمهم في الطلاب مساعدة هو خان أكاديمية تأسيس من الغرض وكان التعلم. في

   .الفيديو باستخدام والتدريب الدروس توفير خلال

 مخصصة تعلم بتجربة تزويدهم خلال من الطلاب لتمكين جهودها الأكاديمية فتكرس

  .وإنتاجية بسهولة التعلم خلالها من يمكنهم

 التاريخ مثل K-14و K-12 موضوعات من مجموعة حول الدروس الموقع يقدم

  .والمزيد (SAT) ال اختبارات و والاقتصاد والتاريخ والعلوم والرياضيات

 مناسبة تكون قد التي الشاملة المجانية مواردها هي خان أكاديمية فوائد أفضل بين ومن

 المعلومات لوحة إلى الوصول للمعلمين يمكن  سواء. حد على والآباء والمعلمين للطلاب

 الفصل تفاصيل وكذلك الفرديين بالطلاب الخاصة الأداء تفاصيل وملاحظة بهم، الخاصة

 .ككل

 أكثر إلى الترجمة طور في بهم الخاصة التعلم موارد أن هي أيضا الموقع فوائد وإحدي

 والطلاب للمعلمين وشاملا متنوعا تعليميا ملاذا الأكاديمية من يجعل وهذا  لغة! 36 من

   .العالم أنحاء مختلف من

 

 

 

 

 

https://www.khanacademy.org/


25 
 

2) Quizlet 
  

 
 المرحلة على يركز موقع وهو – Quizlet موقع للطلاب التعلم تطبيقات أفضل بين من

 مثل بأنشطة القيام خلال من الدراسة على الطلاب يشجع وهو  التعلم. رحلة من التقييمية

   .اللعب على القائم التعلم في والمشاركة تعليمية بطاقات إنشاء

 إلى يحتاجون الذين الأولى السنة لطلاب التطبيق هذا استخدام فيمكنك معلما، كنت إذا

 الأكبر للطلاب مفردات لبناء استخدامه أيضا يمكنك  والمزيد. والترقيم الأبجدي الحفظ

   .للغة الدراسي الفصل في سنا

 على يركز صعب وقت لديه أو التذكر يرفض طفل ولديك الوالدين أحد كنت إذا

 يستطيع  والمشاركة. الثقة تعزيز في سيساعد التطبيق هذا أن المؤكد فمن دراساته،

 بهم خاصة تعليمية بطاقات إنشاء أو جاهزة تعليمية بطاقات على العثور الطلاب

 .الإدخال عملية لتسهيل Quizlet في التلقائي” “التعريف ميزة باستخدام
 

 

https://quizlet.com/latest
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3) Duolingo 
  

 فإن  المدرسي. والكتاب التعليم على قائما اللغة تعلم يكون أن الضروري من ليس

Duolingo  مع السهلة المستخدم واجهة خلال من مسليا اللغة تعلم يجعل تطبيق هو 

   .اليومية والألعاب والشارات التحديات

 لا الذين للأشخاص بالنسبة سهولة أكثر اللغة تعلم جعل هو المنصة من النهائي والهدف

   .جديدة لغة لتعلم الوقت لديهم ليس ببساطة أو تكلفتها تحمل يستطيعون

 الذين والمتعلمين للطلاب مثالي فهو لذا  مجانية! خدمة أنه هو الأمر في شيء أفضل

  .أموالهم توفير يريدون

 أسهل “التعلم أن يعتقدون وهم  وقت. أي وفي التنقل أثناء Duolingo استخدام يمكنك

 لأنهم Duolingo استخدام على يتكيفون اللغة متعلمي يجعل وهذا بوقتك.” تستمتع عندما

   .للبعض مملة تكون قد التي التقليدية الدراسية الفصول في يتعلمون لا

 الضمني التعلم فإن  التعليمي. تطبيقه ضمن الضمني” التعلم“ Duolingo يتضمن كما

   .التعلم لعملية واع بشكل مدركا يكون أن دون الشخص يتعلم عندما يحدث

 بناء على يساعد إنه حيث اللغة في المفاهيم من للعديد مثاليا التعلم من النمط هذا ويعد

 .وتكوينها اللغة لقواعد قوي أساس

https://www.duolingo.com/
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4) Read Along 
 

 في معلما كنت فإذا .Read along هي الصغار للطلاب التعليمية التطبيقات أفضل من

 فإن القراءة، ممارسة على طلابك يساعد لائق تطبيق إلى بحاجة وكنت الأولى السنوات

 استخدامه يمكنك   الصف! غرفة لاحتياجات رائع خيار هو دائما Read Along تطبيق

 خلال من القراءة على يساعدهم فهو  عاما؛ 5 عن أعمارهم تزيد الذين للطلاب

   .عال بصوت القصة قراءة أثناء الفورية والمرئية اللفظية الإشارات

https://readalong.google/
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 اللغات بإضافة باستمرار يقومون التطبيق مطوري أن هو التطبيق في شيء أفضل إن

 الكتب مجموعة نطاق وتوسيع الأمور اولياء ملاحظات خلال من نظامهم وتحديث

 الهندية مثل بلغات التطبيق على العثور يمكنك الإنجليزية، اللغة وبخلاف  لديهم.

  .وغيرها والفارسية والإسبانية والبرتغالية

 المناسب بالمحتوى للتوصية البداية في الطفل قراءة مستوى بتقييم التطبيق ويقوم

 مواصلة على الأطفال لتشجيع التحفيزي التعلم التطبيق يدمج كما  المختلفة. للمستويات

 وشارات نجوم شكل على الحوافز هذه تكون أن ويمكن  بأوقاتهم؛ والاستمتاع القراءة

   .وإنجازات
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5) SoloLearn 

 
 

 الاستعانة يمكن التي المجانية التفاعلية التعليمية البرامج أحد هو SoloLearn برنامج إن

 .الدراسي الفصل في بها

 فقد اليوم، الجامعات طلاب من للعديد جذابة دراسة إلى البرمجة دراسة تحول مع

 SoloLearn منصة تعد  سنا. الأحدث الجيل في مهاراتهم غرس إلى الحاجة تزايدت

   .المستويات مختلف من للمبرمجين العالم في ومنصة مجتمع أكبر

 عن الطفل كشف إذا SoloLearn خلال من للبرمجة الطالب تقديم والآباء للمعلمين يمكن

 صغيرة تدريبية دورات التطبيق فيوفر  مبكرة. سن من البرمجة في اهتمام علامات أي

https://www.sololearn.com/home
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  بالبرمجة. يتعلق ما كل والمحترفين المتوسطين والمتعلمين المبتدئين لتعليم الحجم

 وحتي بل المواقع وتطوير Javaوال Pythonال برامج في دورات يقدم والتطبيق

 خاصة مناقشة لوحة تماما المجاني التطبيق يقدم كما  التسويق. بهدف البرمجة

   .والأسئلة الأفكار مشاركة أجل من بالمتدربين

 الفريق فيها يجتمع مدونة يتضمن الموقع أن SoloLearn لتطبيق المزايا أفضل ومن

 وأخبار الوظيفي، التطوير مثل المهمة الموضوعات كل المدونة فتناقش  والمبرمج.

 .وغيره البرمجية التعليمات وتعلم الشركة،

6) NASA 
 إلى السفر الآن الطلاب فيستطيع .NASA هي أيضا  بالتعليم المرنبطة التطبيقات أحد 

 المزيد تعلم فبإمكانهم  الفضاء. عن شيء كل يعلم الذي NASA تطبيق خلال من الفضاء

 الأخبار، آخر وقراءة ناسا، وكالة من المباشر التلفزيوني البث مشاهدة خلال من

 الآلاف ومشاهدة الإنترنت، على الصوتي البث إلى والاستماع الافتراضية، والجولات

   .الفيديو مقاطع من

 إلى بأكمله الكون يجلب الذي NASA Visualization explorer هو الشقيق التطبيق

 الشمس ب يتعلق ما كل عن المزيد بمعرفة المهتمين الطلاب فسيعجب  المستخدم.

   .التطبيق بهذا والكون

 يتوفر  الفلك. بعلم المدرسة في الطلاب لتعريف التطبيقين هذين استخدام للمعلمين يمكن

.  .Kindleو iOS و Android على عليه العثور ويمكن مجانا التطبيق

 

 

7) Google Earth 
  

Google Earth في المعلمون يستخدمها ما عادة التي الطلاب تحفيز تطبيقات أحد هو 

 .الطلاب علي النشاط لإضافة الفصل

https://play.google.com/store/apps/details?id=gov.nasa&hl=en&gl=US
https://earth.google.com/web/
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 إلى يعود الواقع في فإنه جديد، علم هو الفلك علم أن يعتقدون قد الناس أن من الرغم على

 والتخطيط للملاحة إليه تحتاج المبكرة الثقافات كانت عندما القديمة النهرين بين ما بلاد

  الباحثين. من أجيال الآن حتى يشغل الفلك بعلم الاهتمام فهذا  الوقت. وحفظ الزراعي

   .مبكرة سن في حتى المدارس في العلم بهذا الطلاب تعريف وينبغي

Google Earth الصناعية الأقمار صور باستخدام الأرض يعرض كمبيوتر برنامج هو 

  في المعلمون يستخدمه أن يستطيع مجاني برنامج وهو الأبعاد. ثلاثي الوضع في

 أنه هو Google Earth في رائعا يعد وما  بالجغرافيا. متعلق هو ما كل لتعليم المدارس

   .الجغرافية المفاهيم تصور على الطلاب يساعد

 ويحتوي  الجغرافيا. خلال من هي للطلاب والتاريخ الثقافة لتدريس الأمثل الطريقة فإن

 بين الأدوات هذه وتتراوح  فردية. مشاريع لإنشاء استخدامها يمكن أدوات على التطبيق

  .مدرسية مشاريع لإنشاء الفيديو ومقاطع والصور والنص النقاط إضافة

 

8) MemRise  

 
 

MemRise لتعلم مصمم تطبيق فهو باللغات المتعلقة الدروس لشرح تطبيقات أحد هو 

 تقديم مبادئ: 3 بـ فلسفتهم وتسترشد   المدرسية. الكتب من وخالية ممتعة بطريقة اللغات

 برحلة والوعد التكنولوجيا، على تعتمد تعلم تجربة وتوفير الحياة، واقع من قيم محتوى

   .اللغة لتعلم ممتعة

https://www.memrise.com/


32 
 

 متعلمي لتمكين لغة 16 من لأكثر الإلكترونية الكتب يقدمون الإلكتروني، موقعهم وعلى

 سيعجب  الأصليون. المتحدثون يستخدمها التي اليومية العبارات على التعرف من اللغة

 المحليين” مع “التعلم بخيار ومجهز الاستخدام وسهل مجاني لأنه التطبيق بهذا الطلاب

   .نفسها اللغة متحدثون مع النطق مهارات لزيادة

 اللغة، تعلم نصائح حول المقالات من المئات قراءة يمكنك حيث مدونة أيضا لديهم

   .والمزيد اليومية والإصدارات الشائعة، والعبارات

 

9) PhotoMath  
 

 الواجبات في أطفاله مساعدة أراد محبط أب قبل من البداية في التطبيق إنشاء تم

  .بسهولة المعقدة المفاهيم لشرح كطريقة التطبيق تطوير فأراد  المنزلية.

 معادلتك أو تصويرمشكلتك هو فعله عليك ما كل  ما؛ حد إلى الاستخدام سهل التطبيق

 إلى بالإضافة الإجابة يقدم فهو  المهام. ببقية التطبيق  وسيقوم الهاتف كاميرا باستخدام

   .الإجابة تقنية تذكر على الطالب لمساعدة وتلميحات نصائح يقدم كما الخطوات

 من استخدامه يمكن بحيث الرياضيات، مواضيع من واسعة مجموعة التطبيق ويشمل

 المثلثات وعلم الحسابات وتعتبر جامعي. طالب أو الثاني الصف في طالب قبل

 معها يتعامل التي المختلفة الموضوعات بين من الكلمات ومشاكل والإحصائيات

   .التطبيق

10) Google Arts & Culture  
 

 يمكنكف  .Google Arts & Culture هي الرائعة للطلاب التعليمية التطبيقات من

 تعلم تجربة فإنها  جوجل. طورته الذي التطبيق هذا خلال من الفن تاريخ طلابك تعليم

 على والتعرف الأبعاد ثلاثية النماذج فى الفنية اللوحات مشاهدة يمكنك حيث غامرة

https://photomath.com/en/
https://artsandculture.google.com/
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 واستكشاف بالثقافة الصلة ذات المتقاطعة الكلمات ولعب الشهيرة العالمية اللوحات تاريخ

   !والمزيد الألعاب ولعب الشارع عرض بخاصية الفن

  تريد. كنت ومهما متى استخدامها في مجانية فهي لذا الربح، إلى تهدف لا مبادرة إنها

 ومنحهم معينة فنية حركة حول الأبحاث بعض إجراء طلابك من تطلب أن ويمكنك

 الحصة أثناء افتراضية فنية بجولة القيام يمكنك أو التالي، الصف في لمناقشتها المساحة

   .نفسه الوقت في للطلاب ذلك شرح مع

 درس تخطيط في للمساعدة للتحميل قابلة دروس خطط على العثور أيضا يمكنك

 الخارقين”، الأبطال مع العلوم “تعلم مثل دروس خطط يقدمون وهم  التالي. المحفوظات

 .”الديناصورات مع و”امش الخطير”، كوكبنا و”اكتشف

 

11) GoNoodle  
 

 سكوت قبل من تصميمه تم الذي GoNoodle تطبيق هو للأطفال التعليمية التطبيقات من

 يجعل أن عليه أنه أدرك  ما، يوم وفي الصحي. التعليم مجال في أعمال رجل فهو مكويج

  .اليوم طوال الشاشات إلى النظر من بدلا البدني النشاط من بالمزيد يقومون أطفاله

 مع التفاعل على الأطفال تشجيع خلال من لصالحه الشاشة وقت استخدام قرر لذلك،

   .والتعلم والرقص اللعب خلال من فعليا الشاشة

 (K-5) الابتدائية المرحلة معلمو يستطيع عظيم تعليمي موقع عن عبارة GoNoodle إن

 من كبير عدد على الموقع يحتوي  الدراسي. اليوم في طلابهم طاقة لتعزيز يستخدموه أن

 يمكن  الموضوعات؛ حسب تنظيمها يتم التي الفيديو ومقاطع والمشوقة التفاعلية الأنشطة

 البدنية المهارات الإسبانية، اللغة القراءة، الاجتماعية، الدراسات الرياضيات، تكون أن

   .والمزيد

https://www.gonoodle.com/
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 تخصيص سوى عليك ما  بدايته. في الدراسي للفصل كمقدمة الموقع استخدام فيمكنك

 يعزز أن شأنه من وهذا  .GoNoodle مع اثنتين أو للعبة الدرس بداية في دقيقة 15 مدة

   .ذلك بعد للتركيز مستعدين يصبحون وسوف الطلاب طاقة من

 

12) EdX 

 

 

 إكس، مالكولم – ”.اليوم له يعدون لمن ملك فالغد للمستقبل، السفر جواز هو التعليم“

  الإنسان حقوق مجال في الناشط

 EdX منصة فإن الجامعات. لطلاب تطبيقات أيضا هناك المدرسة، تطبيقات عن بعبدا

 3,500 من أكثر الموقع فيقدم  الإنترنت. عبر تدريبية دورات توفر مفتوحة منصة هي

 أساتذة بواسطة الدورات هذه تدريس ويتم  العالم. حول للمتعلمين الجودة عالية دورات

 ومعهد هارفارد مثل المستويات أعلى من وجامعات منظمات من وخبراء الجامعة

  .للتكنولوجيا ماساتشوستس

  مختلفة. وتقييمات للمناقشة ومنتديات نصي ومحتوى فيديو مقاطع على دورة كل تحتوي

 شهادة تلقي للمتعلم يمكن كما مجانا استخدامهه يمكن أنه هو edX عن عظيم هو وما

   .بسيطة رسوم دفع بعد الدورة بنهاية

https://www.edx.org/
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 مجموعة يقدم لأنه بالتأكيد التطبيق هذا وظائف عن يبحثون الذين الجامعة طلاب سيحب

 يعملون الذين للأشخاص وبالنسبة الجميع. تناسب التي التدريبية الدورات من واسعة

 مهاراتهم لتوسيع المتوفرة التدريبية الدورات من أي في المشاركة يمكنهم بالفعل،

  .أخرى مجالات في معرفتهم وتحسين

 

13) Brilliant 
 تعلم للطلاب تتيح الألعاب على قائمة خاصة تعلم منصة عن عبارة Brilliant إن

 فريقا المنصة فتضم   وودية. إبداعية بطريقة (STEM)ال مناهج  في معقدة موضوعات

 من ومحترفين وباحثين معلمين يتضمنون الذين التدريبية الدورات منشئي من كبيرا

Google وMicrosoft.   

 والرياضيات الكمبيوتر علوم وأسس والجبر العلمي التفكير هي الشائعة البرامج أحد

 أساس على الإلكتروني الموقع مطورو أنشأ فقد  الكثير. وغيرها الفلكية والفيزياء اليومية

   :أهداف أربعة

  بالحفظ تقم ولا اتقن

  المسائل حل

 STEMال مناهج حدس ابن

  مطلوب الصراع بعض
 

14- zAmerican English 
 

 بكل الأمريكية، باللهجة الإنجليزية اللغة لتعلم التطبيقات أفضل من التطبيق هذا يعتبر

 كورسات مستوى لكل مستويات 4 البرنامج يضم المعتاد، من أسرع وبطريقة سهولة

 اللغة أساسيات الطلاب بتعليم يبدأ والقراءة، والكتابة المحادثة كورسات يضم متعددة.

 .والكتابة للمحادثات تأهيله ثم الإنجليزية
 

https://brilliant.org/
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15) Ted Talks for Kids 
 

 الفيديو مقاطع من مجموعة هناك أن تعلم هل ولكن تيد، محادثات عن بالفعل سمعت ربما

 للتفكير الشابة العقول لإلهام وجذابة مثيرة محادثات تقدم فهي  للأطفال؟ المخصصة

  .الأفكار وخلق واكتشاف

 أو طلابك، مع محادثة ومشاهدة الصف غرفة في الموقع زيارة فيمكنك معلما، كنت إذا

 تستفيد فسوف  جماعية. لمناقشة للتحضير بأنفسهم لمشاهدته لهم فيديو تعيين يمكنك

 الأطفال نمنح أن حال، أية على الرائع، فمن  الصف؛ غرفة في هذا الموقع من بالتأكيد

   .جديدة إمكانيات واكتشاف إبداعية بطريقة للتفكير الحيز

 الأسئلة: هذه نفسك اسأل ، فصلك في لتستخدمه تعليمي تطبيق تقرر أن قبل النهاية، في

 التعلم أساليب لتوفير أفعل أن يمكنني ماذا ؟ اجتماعيين أم بصريين متعلمين طلابي هل

 لأكثر مختلفة وتطبيقات تقنيات استخدام يمكنني هل ؟ قدراتهم علي والتكييّف المناسبة

 من طويلة قائمة تجد سوف قرار، إلى تصل عندما ؟ الطلاب من واحدة مجموعة من

 .أبنائك أو طلابك لإشراك والمفيدة لمسليةا المنزل من للتعلم للطلاب التعليمية التطبيقات

 

 

 

 

 

 

 

 

https://www.ted.com/playlists/86/talks_to_watch_with_kids
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Chapter Three 

Using the internet for academic research 

The new MLA Handbook recommends including URLs in works-cited-

list entries for online works, but it also notes their drawbacks: they can 

cause clutter, become obsolete, and have limited use in a print work. 

URLs may also be inaccessible when the pages to which they refer are 

behind a paywall. Although writers can avoid these problems by 

following the handbook’s recommendation to use permalinks and DOIs 

when such information is available, URLs are often the only option. In 

this post, I offer commonsense guidelines on treating URLs in works-

cited-list entries. 

First, it is important to keep in mind that documentation has two main 

goals: it should testify to the veracity of your research and provide 

readers with information about your source that allows them to retrace 

your steps. Ensuring the enduring availability and retrievability of a 

source is not the primary objective of documentation, even though the 

Internet allows for the retrieval of online works referred to in other 

online works. You would document a performance, even though your 
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readers can’t attend it. Similarly, you would document a letter in a 

private collection, even though it might not be accessible to your 

readers. By doing so, you are vouching, “I was here.” 

When deciding whether and how to include a URL in a works-cited-list 

entry, you should balance the goals of testifying and retracing. A good 

litmus test might be this: if your works-cited-list entry adequately 

achieves the primary goal of vouching for your work, then ask yourself 

whether providing a URL will help readers wishing to retrace your 

footsteps. 

Basic Rule of Thumb 

The MLA Handbook encourages writers to list the URL that they see in 

their browsers unless the source identifies a DOI or permalink 

associated with it. 

Inaccessible URLs 

If the URL leads to a source that is behind a paywall or defunct by the 

time you submit or publish your work or if the URL cannot be publicly 

resolved, then retrieving becomes difficult or even impossible, but 

readers may still glean information from the URL that helps them 
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understand the path of your research. For example, the root of the URL 

may lead to a home page where readers can log in with their own 

credentials, pay to see the source, evaluate the credibility of the site that 

published the source, or locate the source under a new URL. 

Ridiculously Long URLs 

So you have a ten-page-long URL. Now what? As Russell W. Grooms 

writes, the MLA Handbook “values concise citations and one of its 

guiding principles is, ‘Make your documentation useful to readers.’ 

How useful is it to my reader to have six lines of random letters and 

numbers at the end of every citation?” Indeed, when URLs are so long 

that they become unreadable, truncating them will be necessary. 

(Omitting the URL altogether, however, may not make it clear that the 

source you are citing appears online.) 

The question is, How long is too long? If the URL compromises the 

readability of your entry, then it is too long. Thus judgment is called for, 

since whether a URL hinders the readability of the works-cited-list 

entry will depend on the entry. The length of the entry is one factor: if a 

URL is several lines longer than the rest of the entry, it will run the 

show. The placement of the URL is another factor: a URL at the end of 
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an entry generally makes the entry easier to read than does a URL that 

appears before optional information that is appended to the entry. As a 

general guideline, a URL running more than three full lines is likely to 

interfere with the readability of the entry. 

Guidelines on Truncating 

URLs are composed of a few basic components: 

• the protocol (basically anything before //) 

• the double forward slash 

• the host (which encompasses the domain–like World Wide web, or 

www) 

• the path 

In addition, sometimes file-specific information or a query string is 

appended: 

https://style.mla.org/app/uploads/sites/3/2016/04/practice-template.pdf 

https://www.mla.org/search/?query=pmla 

The MLA Handbook advises writers to truncate a URL in one specific 

way (by omitting the protocol and //). If you need to shorten it further, 
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retain the host, which will allow readers to evaluate the site and search 

for the source. 

Guidelines on Breaking 

As long as the URL is accurately recorded, writers of unpublished 

material should not worry about how a URL breaks. To ensure that a 

URL is accurately reproduced, never introduce a hyphen or space in it. 

Note that the freely available formatting guidelines on this site advise 

writers to turn off their word processors’ automatic hyphenation 

features for just this reason. 

Professionally typeset publications in fixed formats, like print or PDF, 

normally follow rigorous conventions for breaking URLs. Publishers 

vary in their practices. In its own professionally typeset publications, 

the MLA breaks URLs before a period and before or after any other 

punctuation or symbol (e.g., /, //, _, @). We do not break URLs after a 

hyphen in such publications, to avoid ambiguity. 

 

 

 

https://style.mla.org/formatting-papers/
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When is a website a container? 

Works-cited-list entries in MLA style are structured according to the 

concept of containers. But it’s often tricky to determine when a work 

accessed online is contained in another work. This post provides some 

examples to help you see when a website is and is not a container.  

Rule of Thumb 

A website is a container when it is the platform of publication of the 

particular version of the work you consult. It is not a container when it 

is a passive conduit providing access to the work. 

Sites That Are Containers 

Here are a few examples of sites that are containers: 

• Twitter is the platform of publication for tweets. 

• Google Books is the platform of publication for digitized versions 

of complete print books. 

• Facebook is the platform of publication for comments by your 

friends. 

https://style.mla.org/works-cited-a-quick-guide/
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In all these instances, what we are calling a container is the platform of 

publication of the source.  

Sites That Aren’t Containers 

So what’s not a container? A website is not a container when it merely 

provides a link to a work. Here are some examples: 

• Any site that acts as a mere portal to a work published elsewhere 

is not a container. 

• Online stores. If you purchase and download a song or book from 

the Apple store, the website Apple.com is not the container of the 

song or book. It’s the store you purchased the work from and thus 

a conduit for access. 

• Search engine results, like the thumbnail from a Google image 

search or the results displayed for books by the “look inside” 

function on Amazon are not works, and thus they are not 

containers. To consult the work, you must click through to the site 

hosting the image or buy the complete book sold through the 

Amazon website. 

• An app downloaded from a website to a personal device is also not 

a container for the purposes of the style. 

https://style.mla.org/2016/12/08/citing-apps/
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emoticons packets
FTP portal
Gopher pull technology
HTML push technology
HTTP synchronous communication
instant messaging TCP/IP
Internet Telnet
Internet2 thread
Internet videoconferencing URL
Internet whiteboard Usenet
intranet Web browser
listserv Webcasting
Majordomo Web log
message board Webmail
Netiquette Web server
newsgroup World Wide Web

National Educational Technology
Standards for Teachers

The following NETS•T are addressed by the lesson
content and learning activities in this chapter:

I. Technology Operations and Concepts

A. Demonstrate understanding of technology
concepts and skills

B. Demonstrate continual growth in technology
knowledge and skills

VI. Social, Ethical, Legal, and Human Issues

A. Model and teach legal and ethical practice related
to technology use

B. Enable and empower diverse learners
C. Identify and use technology resources that affirm

diversity
D. Promote safe and healthy use of technology

resources
E. Facilitate equitable access to technology

resources

National Educational Technology
Standards for Students

The following NETS•S are addressed by the lesson
content and learning activities in this chapter:

1. Basic Operations and Concepts
• Demonstrate sound understanding of technology 
• Be proficient in the use of technology

2. Social, Ethical, and Human Issues
• Understand ethical, cultural, and societal issues

related to technology
• Practice responsible use of technology
• Develop positive attitudes toward technology

3. Technology Productivity Tools
• Use technology to enhance learning, increase

productivity, and promote creativity
• Use tools to collaborate, prepare publications,

and produce creative works

4. Technology Communications Tools
• Use telecommunications to collaborate, publish,

and interact with others
• Use varied media and formats to communicate

information and ideas

OVERVIEW

The Internet is a loosely structured network of computers that cross geographical, political,
educational, and cultural boundaries. The Internet has two main features that can support a
wide range of learning activities in the classroom: information resources and communication
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■ AN OVERVIEW OF INTERNET TECHNOLOGIES

Although we use the term Internet to refer to a single entity or structure, the Internet is ac-
tually the infrastructure that provides access to or exchanges of information using several
telecommunication services, or technologies, across numerous networks. In contrast to the
Internet, an intranet is a private network that resides within an organization and is not ac-
cessible to the public. It uses networking hardware and software for communicating and
storing or sharing files within the intranet. Usually a networked computer can access both
an intranet and the Internet.

Internet technologies provide access to information that would have been impossible
to access just a few years ago. Using the World Wide Web, students have access to virtual
libraries, electronic databases, and powerful search engines.They can manipulate and gen-
erate information in artificial or exploratory learning environments.The Internet also per-
mits interaction and communication among peers and with experts outside the local
classroom, both synchronously and asynchronously. Internet technologies support inter-
action and collaboration that allow students to share ideas, ask questions, and discuss
classroom projects.

The two salient features of the Internet—information resources and communication
technologies—can support a wide range of learning activities. Harris (1998) calls these fea-
tures teleresearch and telecollaboration processes.The information features of the Internet
provide access to and manipulation of the vast resources available on the Internet by locat-
ing, organizing, and structuring information in ways that help students build new knowl-
edge and understandings. The communication features of the Internet support multiple
formats and contexts for interaction and exchange of information with other persons or in-
teractive programs in ways that, again, help students build new knowledge and under-
standings. Both of these features of the Internet offer a number of tools and resources that
can support varied instructional methodologies to address a variety of learning goals.

As the Internet has evolved, some technologies have been replaced by newer ones or
have evolved with the Internet. For example, the use of the World Wide Web has, for the
most part, made Gopher obsolete.Yet e-mail, one of the original Internet technologies, has
grown in use and popularity as the Internet has grown.The following discussion provides
summaries of most of the Internet technologies you may encounter in the classroom but is
not intended to be comprehensive. Some technologies may not be appropriate for use in
classroom instruction.

The establishment of the World Wide Web is the focal point for classifying Internet tech-
nologies as old, recycled, or new (see Table 3–1).Technologies that were created prior to
the World Wide Web and are not widely used now are considered to be old technologies.
Those that were designed primarily to support the delivery of information or communica-
tion through the World Wide Web are new technologies. And those that predated the Inter-
net but have been modified or updated to deliver services through the World Wide Web or
are still widely used on the Internet are considered to have been recycled.

Old Internet Technologies

Old Internet technologies were used on the Internet prior to the beginning of the World
Wide Web and now are not widely used.

Gopher

Gopher brought hierarchically organized text files from servers all over the world to a
user’s computer.Gopher was developed at the University of Minnesota (where sports teams
are called the Golden Gophers) and was prominently used from about 1992 through 1996,
when it was effectively replaced by the World Wide Web. For the most part, Gopher servers
are no longer active on the Internet because almost all of the original Gopher content has
been made accessible on the World Wide Web.
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Telnet

Telnet is a protocol that permits basic communication between two host computers. It was
developed in the early days of the Internet as an accommodation to overcome simple dif-
ferences among computers, such as what kind of character set to use.Telnet allowed a per-
son to log on to a host computer through the Internet as a regular user with whatever
privileges were granted to the specific application and data on that computer.

Recycled Internet Technologies

Recycled Internet technologies were used on the Internet prior to the beginning of the
World Wide Web but were modified to work as a Web service or are still widely used.

Bulletin Board Services

Bulletin board services (BBSs) are electronic message centers that host specific interest
groups. A BBS may provide archives of files,personal electronic mail,and any other services
or activities of interest to the bulletin board’s system operator. Bulletin boards are a partic-
ularly good place to find free or inexpensive software products. Messages on BBSs are typi-
cally categorized by topics, and any user can submit or read any message.

BBSs were originally a single computer hooked up through a modem to a phone line
with special software running that allowed anyone with a modem who called the phone
line to connect to the computer, read and leave (i.e., send) messages, and download files.
The BBS is unique as an electronic telecommunications service whose origins were not
with military or defense organizations but with computer hobbyists and scientists.

The beginning of computer bulletin boards is attributed to Ward Christensen and
Randy Suess, who opened the first public BBS in Chicago in the late 1970s. Their Comput-
erized Bulletin Board System went online to the public in 1979 and operated like a virtual
thumbtack bulletin board, where participants could read and post messages. As others
responded to the messages, an ongoing virtual discussion was created. Christensen and

TABLE 3–1 Classification of Internet Technologies

Internet technology Old Recycled New

Bulletin board service ✓

Chat ✓

Discussion lists ✓

E-mail ✓

File transfer protocol (FTP) ✓

Gopher ✓

Hypertext markup language (HTML) ✓

Hypertext transfer protocol (HTTP) ✓

Instant messaging ✓

Message boards ✓

Telnet ✓

Transmission control protocol/Internet protocol (TCP/IP) ✓

Uniform resource locator (URL) ✓

UseNet ✓

Videoconferencing ✓

Web log (blog) ✓

World Wide Web (WWW or Web) ✓
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Suess published an article describing the technology they used, and virtual bulletin boards
begin popping up all around the country. America Online (AOL) and CompuServe are ex-
amples of commercial BBSs; Microsoft Network (MSN) was originally a commercial BBS.

BBSs supplied their own content and sometimes interconnected with other BBSs, but
in the early 1990s BBSs began connecting to the Internet, expanding the range of content
available to BBS members, who had previously operated within the confines of one BBS or
several interconnected BBSs.By the mid-1990s membership in BBSs began to decline as the
graphics-oriented World Wide Web became more widely available, and eventually BBSs
either became Web portals or were absorbed into the World Wide Web and were reconsti-
tuted as individual websites operated by government,educational,and research institutions.

Electronic Mail

E-mail was one of the original Internet technologies,yet it remains probably the most pop-
ular technology used on the Internet. E-mail allows messages comprised of text and other
media to be sent between computers. It was invented during the 1960s, when computer
scientists devised ways of exchanging short messages within a large time-sharing computer
system. By 1970 electronic message traffic was moving smoothly on the Department of
Defense network, and by the early 1980s network mail was called e-mail and the @ sign
became an indispensable component of e-mail addresses.The rise in e-mail traffic was the
largest early force contributing to the growth and development of the Internet (Hafner &
Lyon, 1996).

E-mail applications usually require both a client program that runs on an individual
computer and a server connected to the Internet. Many e-mail servers allow e-mail mes-
sages to be retrieved and sent using an application called Webmail, which allows e-mail
accounts to be accessed through a Web browser program.To use e-mail, you must have an
e-mail account on a mail server.Most schools and universities operate mail servers on a local
network that is connected to the Internet. You can also obtain e-mail accounts with an
Internet service provider (ISP),such as Yahoo! or MSN Hotmail.Students may have accounts
at home as well as at school.

An e-mail account is identified by an e-mail address, which has two parts, separated by
an @ symbol. To the left of the @ symbol is the account or user name; the part on the right
identifies the domain of the mail server where your account resides.The account or user
name can be chosen or assigned, but it must be unique within the domain in which it is
used. Figure 3–2 illustrates the structure of the e-mail account scm777@hotmail.com. All
who use MSN Hotmail will have the same domain—hotmail.com—as the second part of
their e-mail addresses; all who use Yahoo! mail will have yahoo.com as the second part of
their e-mail addresses; and all who use America Online e-mail will have aol.com as the sec-
ond part of their e-mail addresses.

There are several ways to set up an e-mail account, but the basics of using e-mail are
essentially the same for all applications. Even though different e-mail programs may have

FIGURE 3–2: The Structure of an E-Mail Address

scm777@hotmail.com

The Internet domain for
the e-mail account is
hotmail.com.

The @ sign
identifies this as an

e-mail address.

The e-mail account
name is      scm777.
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different looks, they all operate fundamentally the same way. An e-mail account will usually
operate from one of the following sources:

■ An e-mail account through an ISP—ISPs usually provide e-mail accounts as part of
the fee for a connection to the Internet. This type of account is usually accessed
through a phone line or cable connection.

■ An e-mail account through a school or university (or business) network—These
accounts often use a full-featured e-mail program, such as Microsoft Outlook, Out-
look Express, or Eudora.These client e-mail applications often come preloaded on a
computer or may be downloaded for free or for a small license fee.These programs
have many features and are configured by the individual user or a network adminis-
trator to operate with an Internet connection through a local area network.

■ An e-mail account through a Web-based e-mail service—Several portal sites that pro-
vide a structured gateway to the Internet with supporting tools and resources,such as
Yahoo! (http://www.mail.yahoo.com) or MSN (http://www.hotmail.com), provide
free e-mail in exchange for exposure to advertisements.These e-mail services are easy
to use and are usually accessible through any computer connected to the Internet.

Two popular uses of e-mail are e-mail announcement lists and e-mail discussion lists.
Announcement lists are used to send messages to a small or large group or a collection of
e-mail accounts. Such lists are usually created around particular products or organizations.
When you purchase a product,use a service,or join an organization,you may be subscribed
to an announcement list. Discussion lists are used to generate information, comments, or
feedback from others subscribing to the lists. Discussion lists are usually organized around
a particular topic, and you usually subscribe to the list voluntarily because of your interest
in the topic.

Announcement lists use a top-down approach: E-mail announcements flow from the
manager of the list to the subscribers.Discussion lists use a bottom-up approach:E-mail dis-
cussions flow from subscribers to the list manager and then out to other subscribers.With
a discussion list you send an e-mail to a specific e-mail address,and the message goes to pos-
sibly hundreds or thousands of people who have subscribed to the list.

File Transfer Protocol

File transfer protocol (FTP) is a standard Internet protocol that permits the exchange of
files between computers on the Internet. Like Telnet, FTP was developed in the early days
of the Internet (it was released as a standard protocol in 1972) to make it possible to share
files between computers. FTP is now commonly used to transfer Web page files from the
Web page author’s computer to a Web server. FTP is also commonly used to download pro-
grams and other files from a Web server to a user or client computer. FTP permits deleting,
renaming, moving, and copying of files on a server. It can be used as a stand-alone program
or application, or it can be built into other programs, such as a program for authoring Web
pages that requires the author to move files back and forth between the user computer and
the Web server. A Web browser can also perform FTP requests to download programs
selected from a Web page.You need to log on to an FTP server, but publicly available files
are easily accessed using an anonymous FTP.

Listservs or Discussion Lists

Discussion lists (or listservs, discussion forums, electronic mailing lists, or just mailing
lists) are automated mail lists—basically, e-mail distributed to a large group. A listserv, or
mailing list manager, is a program that receives messages and automatically sends them out
to the e-mail addresses of a group of users who have subscribed to the list.Thus, list sub-
scribers can communicate with other list subscribers without having to send individual
e-mails to everyone on the list. Each subscriber can post a message to the e-mail address of
the mailing list, which serves as an alias for all list subscribers’ addresses.
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Messages to and from mailing lists are sent and received in the same way that other
e-mail messages are. Some of the most popular mailing list management programs are LIST-
SERV, ListProc, and Majordomo. Even though LISTSERV is a proprietary and copyrighted
name owned by L-Soft International, Inc., the term listserv has become the generic name to
describe discussion lists. This textbook will use the terms discussion list, listserv, and
mailing list interchangeably to refer to the same asynchronous communication tool so that
you will become comfortable with all the terms.

Discussion lists allow many people in diverse locations to exchange information and/or
have a discussion through a single e-mail address.Discussion lists focus on a common topic,
such as online education in the classroom.To use a discussion list,you subscribe by sending
an e-mail message to the specific list address.Once you subscribe,you will usually receive a
confirmation message that tells you the guidelines of the list and the way to unsubscribe.
You should always save the confirmation message so you will have information about how
to send messages to the list or how to unsubscribe from the list.

Discussion lists can be structured in several ways:

■ Moderated—A discussion list can have a moderator who reviews and approves each
message posted to the list.

■ Unmoderated—Without a moderator messages are automatically posted to all sub-
scribers on the list without approval.

■ Open—A discussion list can allow anyone to subscribe.

■ Closed—A discussion list can be limited to certain subscribers, who must get
approval before joining.

■ One-way or broadcast—A discussion list can allow subscribers to receive messages
from the list but not post new ones.

■ Two-way—A discussion list can allow subscribers to post as well as receive messages.

There are several primary ways to host and manage a discussion list. First, the discus-
sion list can be hosted on your own server, using mailing list software such as Majordomo
or LISTSERV. Your school or school district network may provide the capability of setting
up and hosting a classroom discussion list. If not, you can pay an Internet service provider
to host a discussion list for you, although the best choice for a classroom is to use a free
mailing list hosting service. However, free services usually include advertisements attached
to the bottom of posted messages, which may not be appropriate for some classrooms. For
a small fee most free services allow you to run an advertisement-free list. For example,
Yahoo Groups charges a small monthly fee per list for messages without advertisements.

Newsgroups

Newsgroups began as a means of communication between mainframe computers at large
universities.Newsgroups use a network service called Usenet, which was originally imple-
mented between 1979 and 1980 by Steve Bellovin, Jim Ellis,Tom Truscott, and Steve Daniel
at Duke University and has evolved into a large distributed news network (Hafner & Lyon,
1996).Usenet permits any member to participate in a public dialogue with everyone else in
the newsgroup.As it grew to become international in scope, it became probably the largest
decentralized information resource in existence until the advent of the World Wide Web.

UseNet is not a formal network but is comprised of networked computers that ex-
change articles tagged with predetermined subject headers for groups with specific areas
of interest (i.e., newsgroups). Any computer that can attach itself to the Internet can be-
come part of UseNet. News articles are handled as electronic mail messages by most com-
puters and are processed as news information by applications called news readers, which
send and receive the messages, although most Web browsers are capable of processing
Usenet articles.

Usenet newsgroups are distributed among thousands of computers called news servers,
which are operated by Internet service providers, universities, companies, and other
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organizations. Each server receives copies of all messages in a newsgroup and stores them
in a database. News servers automatically exchange, or propagate, these messages among
themselves, to keep each other’s databases up to date.

Newsgroups can be unmoderated,with anyone able to post submissions,or moderated,
with submissions automatically directed to a moderator, who edits or filters and then posts
the article. Postings to unmoderated groups are automatically propagated to the news-
group, whereas postings to moderated groups are not propagated until approved by the
moderator.

Newsgroups are hierarchically classified (see Figure 3–3). Newsgroup discussion cate-
gories,such as alt,are organized into topics,such as alt.animals, which are again divided into
even more specific topics, such as alt.animals.dogs. Ultimately, the classification leads to a
newsgroup containing messages from people who are interested in one particular topic,
such as alt.animals.dogs.beagles. The different parts of a newsgroup’s name are always sep-
arated by a period.

Each newsgroup contains threads that are more or less a continuous chain of messages
on a single topic. Messages, or articles or postings, are linked to one another by a common
subject in much the same way that you link to an originating e-mail message when you reply
to it.

Because alt newsgroups,especially,may contain content and discussions that are inappro-
priate for classroom use,Internet filters in schools may limit or prevent access to newsgroups.

Newsgroups are different from discussion lists in several ways.Postings to a newsgroup
are made to a central location rather than to e-mail accounts, and Usenet articles remain on
a server, whereas discussion list messages come to an e-mail account. Further, discussion
lists need only an e-mail program to view the discussion; newsgroups need a news reader
or Web browser.

Transmission Control Protocol/Internet Protocol

TCP/IP (transmission control protocol/Internet protocol) is the basic communication
language, or protocol, of the Internet. It can also be used in a local area network.The col-
lection of networks eventually called the Internet was named for the first word of Internet
protocol (Hafner & Lyon, 1996).

The Internet can best be described as one large worldwide network connecting many
smaller networks. It is a packet-switching network. Packets are like little envelopes of
information packaged and routed according to network availability. Each packet has a
destination address and is transported from one place to another until it is delivered to the
correct address. A packet may go through a series of networks before it reaches its final
destination; the protocols that make the packet transformation possible are called trans-
mission control protocol and Internet protocol, or TCP/IP.

FIGURE 3–3 Newsgroup Discussion Categories

• alt. Any conceivable topic

• news. Info about Usenet news

• biz. Business products, services, reviews

• rec. Games, hobbies, sports

• comp. Hardware, software, consumer info

• sci. Applied science, social science

• humanities. Fine art, literature, philosophy

• soc. Social issues, culture

• misc. Employment, health, and much more

• talk. Current issues and debates
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TCP/IP is a two-layer program.TCP manages the assembling of a message or file into
smaller packets that are transmitted over the Internet and are then reassembled into the
original message.The other layer, IP, handles the address part of each packet so that it gets
to the right destination.A Gateway computer checks the address to see where to forward
the message.

TCP/IP uses a client/server model of communication, in which a computer user (i.e., a
client) requests and is provided a service, such as receiving a Web page, by another com-
puter (i.e., a server) in the network. TCP/IP communication is primarily point to point,
meaning each communication is from one point, or host computer, in the network to
another point, or host computer.

New Internet Technologies

New Internet technologies support the use of the World Wide Web.

Chat

Chat is real-time communication between two or more people using computers, usually
through the Internet.Any online, real-time conversation is chat or a form of chat. Most net-
works,online services,and conferencing programs offer a chat feature.A chat room is a vir-
tual space where a chat session takes place. Technically, a chat room is a communications
channel, but the term room supports the chat metaphor.

Because chat is intended for two-way communication, it supports a high level of inter-
activity among users. The client application installed on the user computer transmits every
character typed in real time or a complete message that is sent when the user presses the
ENTER key. The standard for establishing chat among large groups of people is known as
Internet relay chat (IRC). IRC uses chat rooms for people to meet and discuss topical issues
related to the overall theme set by the room. IRC could be considered the real-time equiva-
lent of newsgroups.

In a chat session the participants may be physically located anywhere in the world but
are able to communicate almost instantly by typing text,which immediately appears on the
screens of all participants in the chat session. A newer browser, such as Netscape Commu-
nicator 4.x or Internet Explorer 4.x, is often all that is needed to participate in Web-based
chats.

Chat can be used effectively to support Web-enhanced learning in the classroom.Some
of the benefits include the following:

■ Chat sessions are a good way to access experts in a field of study. For example, a sci-
ence class might invite a renowned scientist to join the class’s chat session at a spe-
cific time, allowing the expert to remain at home or in the office.

■ Teachers can provide online office hours as a chat session, allowing more than one
person to benefit from the discussion.When others participate,varied points of view
are expressed to all participants.

■ Most chat tools keep a record or a log of conversations. Students can then use the
transcript of the conversation to recall important parts of the discussion. And students
who are unable to participate in the chat can review the transcript of the discussion.
Transcripts can also be used by the teacher to evaluate student participation.

■ Chat sessions can be relatively spontaneous. For example, if a controversial topic is
in the news, an instructor can schedule a chat session that day to discuss it.

Hypertext Transfer Protocol

Hypertext transfer protocol (HTTP) is the underlying protocol used by the World Wide
Web. HTTP defines how messages are formatted and transmitted and what actions Web
servers and Web browsers should take in response to various commands. For example,
when you enter a URL in your browser, you send an HTTP command to the Web server
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directing it to fetch and transmit the requested Web page. In contrast to FTP, HTTP transfers
the contents of a Web page into a Web browser only for viewing, whereas FTP transfers the
contents of entire files from one device to another and stores them on the receiving com-
puter. FTP is a two-way system in which files can be transferred back and forth between
server and client computers. HTTP is a one-way system in which files are transferred from
the Web server into the Web browser of the client computer.When HTTP appears in a URL,
it means that the user is connecting to a Web server and files are transferred but not down-
loaded and stored.

Hypertext Markup Language

Hypertext markup language (HTML) is the language in which Web pages are written.HTML
uses a simple system for denoting instructions,called tags, to convey the content and struc-
ture of a hypertext document, or Web page. Hypertext is a term coined by Ted Nelson in
1965 to describe text that includes links or shortcuts to other documents, allowing the
reader to easily jump from one text to related texts, and consequently from one idea to an-
other, in a nonlinear fashion. In addition to hypertext,Web pages now commonly include
other media,and it may be more accurate to use the term hypermedia instead of hypertext.
HTML files, or Web pages, use HTTP to transfer Web pages from a Web server through the
World Wide Web to a client computer, where they are parsed and displayed using a Web
browser program.

Instant Messaging

Instant messaging is a form of chat that provides a more personal or private interaction
between chatters but requires specialized software to be downloaded to a user’s computer.
There are several different instant messaging systems available, including ICQ (I Seek You),
AOL Instant Messenger,Yahoo! Messenger, and MSN Messenger.With instant messaging you
create buddy or contact lists of other users with whom you wish to correspond, all of
whom must be using the same instant messaging program.When one of the people on your
list logs on to the system,you are notified by some means, such as a sound,a pop-up box on
the screen, a flashing menu bar, or some other attention-getting device.You can then chat
interactively or transfer files. If you happen not to be online, a message may still be sent but
is not delivered until you log in. In this case, instant messaging reverts to an asynchronous
communication similar to e-mail.

Because of the lack of an instant messaging standard, instant messaging may not be a
good choice for Web-enhanced learning in the classroom. It is difficult for a teacher to pro-
vide instant messaging support to students without installing multiple programs. If you do
use instant messaging in your classroom, you must decide which program to use and then
provide students with instruction.Each student should establish buddy lists and should add
the teacher to the list so that the teacher will be notified and can simply respond instead of
having to actively enroll each student. Students can take responsibility for creating their
own contact lists with each other.

Instant messaging has a number of advantages over online chat rooms. Instant messag-
ing programs are popular, and many students will have some form of instant messaging
installed on their computers. In addition, instant messages are delivered even if the contact
is not currently online.However, the best use of instant messaging is for online office hours.
Students with questions usually like to receive help immediately, and instant messaging lets
them know whether the teacher is currently available.

Internet2

Internet2 is a consortium of over 200 universities working in partnership with industry
and government to develop and deploy advanced applications for learning and research.
The Internet2 project is not a single, separate network but joins its members together
through many advanced campus, regional, and national networks.
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Internet2 is itself a collection of communication and information-sharing technologies.
For example, a major function of Internet2 is adding sufficient network infrastructure to
support real-time multimedia and high-bandwidth interconnections and thus to enable
applications such as telemedicine, digital libraries, and virtual laboratories that are not
possible with the technology underlying today’s Internet.

Internet2 is not intended to be a future replacement for the Internet but is intended to
investigate and develop new ways to use the Internet and the Internet2 infrastructure for
educational and research purposes. Its organizers plan to share their developments with
other networks, including the Internet.

Message Boards

Message boards, bulletin boards or forums,or threaded discussions usually refer to a Web-
based asynchronous communication tool that allows you to post a message for people to
read at their own convenience. Message boards work similarly to newsgroups but function
differently from discussion lists.With discussion or mailing lists, messages are received in
subscribers’ e-mail inboxes because messages are pushed from the Web server to the client
computer. Message boards require messages to be pushed from the client computer to a
Web server, participants go to a bulletin board on a Web server to read the messages. A
message or bulletin board is the equivalent of a newsgroup on the Web.

With an Internet-based message board, you go to a specific location on the Web and
post a message consisting of a subject title and a message body.When other people have
read the message, they can post a message in reply or post a different message with a dif-
ferent subject heading. Multiple posts referring to one particular subject title are called a
thread of discussion.The series of messages, or posts, can evolve into complex, multilay-
ered conversations that are similar in many respects to face-to-face conversations.

Uniform Resource Locator

A uniform resource locator (URL) is the address or location on the World Wide Web of a
document or file that resides on a Web server connected to the Internet.The URL is the
most fundamental innovation of the Web, it is the specification used by any program, com-
puter, or server connected to the Internet to locate a resource on the Web.The URL allows
a Web document or resource that is published on a Web server to be found by any Web
browser.

Because URLs generally use HTTP to transfer documents or files to the Web
browser of a requesting computer, URLs usually begin with http://. An under-

standing of the structure of URLs is useful for determining the accuracy and
reliability of information on a website. For example, a Web address of
http://www.mysite.com/myfolder/mydoc.html uses http to transfer
a Web document named mydoc.html from the folder, my folder, in a

➞ domain named www.mysite.com on a public Web server (see Figure
3–4) to a Web browser on a computer connected to the Internet.

Videoconferencing Technologies

Webcasting is a term taken from World Wide Web and broadcast. Sometimes called Net-
casting,Webcasting refers to the real-time transmission of encoded video under the control
of a server to multiple recipients who all receive the same content at the same time.Web-
casting is used to deliver live or delayed versions of sound or video broadcasts. It also refers
to the delayed or preview versions of movies, music videos, or regular radio and television
broadcasts, which promote the live broadcasts.

Webcasting uses so-called push technology, in which a Web server seemingly pushes
information to the user, in contrast to pull technology, in which the user seeks and down-
loads information, as with a Web browser. In reality, the pushing of information is triggered
by a user or a network administrator who preselects the service, it arrives only as the result
of client requests.Webcasting is a feature of the Microsoft Internet Explorer browser and
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Netscape’s Netcaster, part of its Communicator suite.Webcasting is also available through
separate applications, such as Pointcast and Backweb, which run on current versions of
browsers.

An Internet whiteboard is an Internet application that allows users to draw objects
that can then be transmitted to other users who are simultaneously using the same appli-
cation.This electronic concept is similar to that of a real-world whiteboard:One participant
draws objects that others can see,and the other participants can then add to or delete these
drawings. An electronic whiteboard allows communicating parties to share textual and
graphic information in real time. Internet whiteboards are used in the context of some
other communication channel, such as an Internet videoconference or a presentation.

Internet videoconferencing is becoming a widely used technology. Its applications
and services are usually based on technologies that allow real-time video and audio to be
sent and received through computer networks.The advantage of these technologies over
older videoconferencing is that they allow videoconferencing to occur over the Internet
rather than only through phone lines.Two popular software programs that allow videocon-
ferences are CUSee-Me from Cornell University and NetMeeting from Microsoft. In both
cases you need a video camera and a digitizing card to transmit video signals. A micro-
phone, speakers (or headset), and an audio card are required for audio transmission.

Web Log

A Web log, or blog, is an online journal in the form of a Web page that is comprised of links
and postings in reverse chronological order. The activity of updating a blog is called
blogging, and the person who maintains a blog is a blogger.The totality of Web logs on the
World Wide Web is often called the blogosphere.

Web logs are not actually an Internet technology but use Web publishing technologies
and tools to disseminate information on the Web.The format of Web logs varies from simple
bullet lists of hyperlinks to article summaries with user-provided comments and ratings. In-
dividual Web log entries are usually date- and time-stamped,with the newest post at the top
of the page. Some Web logs are maintained by single authors, whereas others have multiple
authors. Most are interactive and allow visitors to leave public comments, creating a com-
munity of readers centered around the Web log.

Two features common to Web logs are blogrolls and commenting, or feedback. A
blogroll is a list of other Web logs that are linked to a Web log entry or article. Blogrolls are
one way a blogger creates a context for a blog by listing other blogs that are similar.
Blogrolls can be used as a measure of blog authority, ranking blogs according to the number
of references found in other blogs—much like Google rankings of search results.

A feedback or comment system allows users to post their own comments on a Web
log entry or an article. Some blogs do not allow comments or have a closed commenting

FIGURE 3–4: The Structure of a URL

www.mysite.com/myfolder/mydoc.html

The Web document 
 is named mydoc.html.

The Web document is
located in a folder
named  myfolder.

The Web document is
located in the domain
www.mysite.com.
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system, which requires approval from those running the blog. However, for many bloggers
comments are a critical feature. Regular comments on a blog are referred to as the blog’s
community.

Many Web logs are syndicated on the Web by distributing their headlines along with hy-
perlinks and summaries through a technology called Really Simple Syndication (RSS). An
RSS feed simply repackages the content of an entry in a Web log as a list of data items, such
as the date of the posting, a summary of the article, and a link to it.A program known as an
RSS aggregator, or feed reader,can then check RSS-enabled Web log pages for a user and dis-
play any updated articles it finds.This process is more convenient than repeated visits to fa-
vorite Web logs because it ensures that the reader sees only material that has not been
previously viewed.

World Wide Web

The World Wide Web (WWW, or just Web) is the second most popular Internet applica-
tion, second only to e-mail.The Web is an application built on top of the Internet and used
to access information resources through the Internet, using specific protocols to identify
and locate that information.The Web allows documents to be viewed in a semiformatted
manner, regardless of what brand of computer is viewing them.Although the World Wide
Web is one Internet technology, or application, like e-mail,Web browsers such as Internet
Explorer or Netscape Navigator are used so extensively to access the Internet that we often

think of the Internet in terms of the World Wide Web. Certainly in everyday use the Inter-
net and the World Wide Web can be considered one and the same.

The World Wide Web was invented in 1989 by Tim Berners-Lee while
working at CERN (Conseil Européen pour la Recherche Nucléaire), the

European Particle Physics Laboratory. Berners-Lee, now director of the
➞World Wide Web Consortium (W3C),wrote the first Web browser and
Web server programs in 1990 (Berners-Lee, 1999).The World Wide Web

is a body of software, protocols, and conventions that provide for the
viewing and publication of text and multimedia documents stored on

computers known as Web servers.

Go
to the Companion

Website and browse Chapter 3

Lesson Links: World Wide Web

Consortium to learn more
about this topic.

Building Your Toolkit:
Using a Web Browser

To create learning activities that are supported by Internet technologies, you need to be proficient in surfing the Net so that
you can model this skill for your students. You surf the Net (actually the World Wide Web) using a computer program called
a Web browser, which allows you to view Web pages and other Web documents, usually stored on Web servers.
Microsoft Internet Explorer and Netscape Browser are the most widely used Web browsers.

Current statistics indicate that most Web surfers are using Microsoft Internet Explorer running on a computer that uses
the Microsoft Windows operating system. Therefore, many of the screen shots in this book will also follow that conven-
tion. The tutorials, however, will be applicable to any browser, any browser version, and any computer operating system
(e.g., Microsoft Windows, Macintosh, and Linux) on which the Web browser is running.

You probably already know how to use a Web browser and already have your preferred Web browser. The follow-
ing exercise is intended to review the basic skills needed to use a Web browser and to sharpen and expand those skills.
Start by opening the Web browser program on your computer. Opening the browser also opens the website that has
been set as the home or default website. Thus, home is the website to which the browser links when you first start the
program (or when you click on the Home icon or button on your browser). The following steps demonstrate the use of
the main features of a Web browser on a computer using the Windows operating system. These steps may differ slightly
for different browser versions or for browsers on a Macintosh computer. Figure 3–5 illustrates all the buttons that are used
in Steps 2–13 in the following exercise using the Internet Explorer browser.

(Continued)
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Building Your Toolkit:
Using a Web Browser (Continued)

STEP INTERNET EXPLORER NETSCAPE BROWSER

3. Click the Back icon or button. The Back button reverts the browser display to one page back in the sequence
of Web pages to which you have hyperlinked (or just linked) during the current browser session.

(Continued)

NOTE: Because most versions of Web browsers now add http:// to the Web address, you do not need to include it when
entering Web addresses in the Address or Location bar of your browser window.

URL (Web
address)
displayed on
Address or
Location bar

Home button to return to the
default browser page 

Favorites button to add or

edit links to favorite  

Web    sites

History button to
show links for
Web pages
visited in
previous days
and weeks

Back button to go one page back in
the hyperlink sequence

Forward button to go one page
forward in the hyperlink sequence

Refresh button to
force a reload of the
page from its
original location on
the Web

Print button to
print a Web page
on a printer

FIGURE 3–5: Components of the Internet Explorer Web Browser

To view home Web address, select Tools >
Internet Options, and then select the General tab.
Click OK to close the Internet Options dialog box.

1. To view home Web address, select Edit >
Preferences and then select the Navigator cate-
gory. Click OK to close the Preferences dialog box.

In the Address bar of the browser window, type in
the following URL: www.w3c.org. Press ENTER.

In the Location bar of the browser window, type in
the following URL: www.w3c.org. Press ENTER.

2.
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Building Your Toolkit:
Using a Web Browser (Continued)

4. Click the Forward icon or button. The Forward button advances the browser display one page ahead in the
sequence of pages you have hyperlinked (or just linked) to during the current browser session.

5. Click the Home icon or button. The Home button returns you to the page set as the default home page for
the browser program on your computer.

NOTE: When you start typing the information in the Address or Location bar—or in a field on a Web page or in a box for a
user name or password—the AutoComplete lists possible matches as you type, if you’ve typed a similar entry before. If a
suggestion in the list matches what you want to enter in that field, click the suggestion. If no suggestion matches what you
are typing, continue typing.

7. Surf the Discovery website by clicking hyperlinks on the Web page and by using the navigation bars and buttons
(displayed as either text or graphics) on the sides, top, or bottom of the Web page. Consider how you might
use some of the information found on the website as content for a lesson or instructional activity.

9. Print the content of the Web page you are viewing by selecting File > Print or clicking the Print icon. (Check
with your instructor before actually printing.)

12. Your Web browser stores Web pages and related files (such as graphics) in a temporary folder. These files are
stored on your computer to increase the speed with which a Web page is displayed for pages you frequently visit
or have already visited by opening Web pages first from your hard disk instead of from a remote Web server.

Enter the following URL into the Address bar:
www.discovery.com. Press ENTER.

Enter the following URL into the Location bar:
www.discovery.com. Press ENTER.

6.

When you view a Web page with content that is
interesting or appropriate for a subject you teach,
bookmark it for future reference by selecting
Favorites from the menu bar and then selecting
Add to Favorites from the pop-up menu. Enter
different information in the Name box if the default
information does not provide a distinctive title for the
Web page name. Click OK.

When you view a Web page with content that is
interesting or appropriate for a subject you teach,
bookmark it for future reference by clicking the
Bookmarks button and selecting Add a 
Bookmark from the pop-up menu. (You can use
Edit Bookmark to change the name of the page.
Click OK.)

8.

To view a list of the sites you have previously visited,
click the History button. The History bar appears on
the left side of the window, listing links for websites and
pages visited in previous days and weeks. In the 
History bar, click a week or day, then click a website
folder to display individual pages, and then click the page
icon to display the Web page. You can hide the History
bar by clicking the History button again. A drop-down
list of recently viewed pages is also available by clicking
the down arrow at the right end of the Address bar.

To view a list of the sites you have previously visited,
select Communicator > Tools and then select
History. A window with a list of links for websites
and pages visited in previous days and weeks is dis-
played. Close the History window after viewing it.

10.

To delete Web address history from the browser,
click Tools > Internet Options and select the
General tab. Under History click Clear History.
All Web address history (including history used for the
AutoComplete feature) is deleted from the computer.
Click OK to close the Internet Options dialog box.

To delete Web address history from the browser,
select Edit > Preferences and select the Navigator
category. Under History click Clear History. All
Web address history (including history used for the
AutoComplete feature) is deleted from the com-
puter. Click OK to close the Preferences dialog box.

11.

This folder is named the Temporary Internet Files folder.
If you think a newer version of a Web page is available
after you have already viewed it, click the Refresh icon
or button to force the browser to reload the Web page
from its original location on the Web server.

This folder is named Cache. If you think a newer ver-
sion of a Web page is available after you have already
viewed it, click the Reload icon or button to force
the browser to reload the Web page from its original
location on the Web server.

(Continued)

STEP INTERNET EXPLORER NETSCAPE BROWSER
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Lesson 3.2 Online Communication

FOCUS QUESTIONS
■ What is the difference between synchronous and asynchronous communication on the

Internet? 
■ What are examples of synchronous and asynchronous communication technologies? 
■ What rules, social conventions, and techniques are used for online communication? 

■ SYNCHRONOUS AND ASYNCHRONOUS MODES

The Internet supports both synchronous and asynchronous communication channels.
Asynchronous communication is communication that occurs without regard to time or
location;it is not necessary for all communicating parties to be present when communication
occurs.With asynchronous communication a message is sent but is not necessarily received
(accessed and read) immediately. Synchronous communication is communication that
occurs in real time and is highly interactive; all communicating parties are simultaneously
present.With synchronous communication a message is sent and immediately received.

Information exchanges using the Internet, whether synchronous or asynchronous, can
support both individual and group learning.Communication over the Internet can take place
by individuals communicating with other individuals, individuals communicating with
groups,or groups communicating with other groups (Harris,1998).For educational purposes
this textbook classifies Internet communication technologies in two categories: interpersonal
communication and group communication. Interpersonal communication occurs one to one

Building Your Toolkit:
Using a Web Browser (Continued)

STEP INTERNET EXPLORER NETSCAPE BROWSER

13. Increasing the size of the Temporary Internet Files or Cache folder can increase how fast previously visited
pages are displayed while also decreasing the space available for other files on your computer. Emptying the
folder decreases the amount of space it uses on your hard disk. You may find it necessary occasionally to clear
the Temporary Internet Files or Cache folder when files become corrupted and do not display correctly or
when a newer version of the Web page is available.

Go
to the Companion Website

and browse 3.1 Building Your Toolkit

Enrichment Activity: Creating a Web

Archive for Off-Line Browsing. Follow the
procedure in the enrichment activity for

storing Web pages on your computer
in a Web archive for off-line

browsing.

Go
to the Companion Website

and browse 3.1 Project Sample:

Understanding the Internet. Use the project
sample as the foundation for a learning activity
to introduce the Internet into the classroom.

Adapt the project sample to the subject
area and/or grade level that you

teach.

To delete the file contents of the Temporary Internet
Folder from the browser, select Tools > Internet
Options, then select the General tab, and click the
Delete Files button.

To delete the file contents of the Cache folder from
the browser, select Edit > Preferences and
expand the Advanced category, then select Cache,
and click the Clear Disk Cache button.
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between individuals holding a private or public conversation. A student having an e-mail con-
versation with a teacher or a chat with a peer is an example of interpersonal communication.
Group communication is used to communicate the same information to multiple individuals
and occurs when an individual communicates with a group.Group communication is always
a public conversation.A teacher distributing assignment information to a class, using a distri-
bution list or message board, is an example of group communication.

When using synchronous or asynchronous communication to support information
exchanges, it is important to establish classroom guidelines for online communication and
specific learning objectives for each information exchange assignment. Additionally, stu-
dents should learn online communication techniques and use appropriate communication
practices when engaging in information exchanges.

■ NETIQUETTE

Because of the unstructured nature of asynchronous and synchronous communication, it is
important to establish clear rules and expectations for Internet communication sessions.
You should establish ground rules ahead of time that focus discussions on learning goals
and make it easier to evaluate student participation. For example, prior to an information
exchange,you might provide a list of topics for discussion so that students can be prepared
to conduct a meaningful conversation. Complex questions should also be distributed prior
to the session, but online brainstorming activities may not need advance preparation.

Rules and expectations for information exchanges should be made clear in general
guidelines for online communication. Netiquette means network etiquette and refers to
the dos and don’ts of online communication. It covers both common courtesy and the
informal rules of surfing the Net (see Figure 3–6).

FIGURE 3–6 The Core Rules of Netiquette

Rule 1: Remember the human. Be polite and courteous. Do not be offensive. There’s a real person behind the computer that is
accessing your online communication. Furthermore, whenever you communicate through the Internet, your words are written, and
chances are good that they are stored somewhere where you have no control over them.

Rule 2: Adhere to the same standards of behavior online that you follow in real life. Be ethical and do your best to act
within the laws of society and cyberspace.

Rule 3: Know where you are in cyberspace. When you enter a domain of cyberspace that is new to you, spend some time lis-
tening to the chat or reading the archives. Get a sense of how the people who are already there act before you participate.

Rule 4: Respect other people’s time and bandwidth. It’s your responsibility to ensure that the time spent reading your e-mail
or posting to a discussion list is not wasted.

Rule 5: Make yourself look good online. In cyberspace you will be judged by the quality of your writing, so spelling and grammar
do count.

Rule 6: Share expert knowledge. Do not be afraid to share what you know. It is especially polite to share the results of your
questions with others.

Rule 7: Help keep flame wars under control. Flaming is what people do when they express a strongly held opinion without
holding back any emotion. Netiquette forbids the perpetuation of flame wars, that is, a series of angry letters, most of which come from
two or three people and are directed toward each other, dominating the tone and destroying the camaraderie of a discussion group.

Rule 8: Respect other people’s privacy. Do not snoop into other people’s e-mail.

Rule 9: Don’t abuse your power. Knowing more than others, or having more power than they do online, does not give you the
right to take advantage of them.

Rule 10: Be forgiving of other people’s mistakes. If you do decide to inform someone of a mistake, point it out politely and
preferably by private e-mail rather than in public. Give people the benefit of the doubt; assume they don’t know any better.

Adapted from Netiquette by V. Shea, 1994, San Francisco: Albion Books. Available online at http://www.albion.com/netiquette/book/.
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The composition of online messages often ignores conventional rules of capitalization,
punctuation,and other grammatical rules.Although online communication facilitates a sense
of freedom, it does not accommodate nonverbal communication or changes in inflection,
thus making it much easier for the recipient of a message to misunderstand its meaning or to
draw the wrong conclusion based solely on its written content, style, and formatting.

Using written communication styles and techniques that are appropriate, positive, and
easy to understand is important for Web-enhanced learning activities. Messages should not
contain ambiguous or inaccurate content but should clearly communicate and clarify the
positions of the sender. The appropriate use of emoticons can be a good way to express
emotion in written, text-based,asynchronous communications.Emoticons use text symbols
to represent a face that is turned 90 degrees counterclockwise (see Figure 3–7).

FIGURE 3–7 Emoticons for Online Conversations

EYES : � NOSE � * ^ (or blank) MOUTH � ) 0 ( �

:�� ambivalent or indifferent :-9 delicious, yummy : O shocked

:�( angry or frowning :-6 exhausted : ) or :�) or =) smile

��] asleep :�0 surprised

(: : ( ) : : : ) bandage ^5 high five ^ thumbs up

\�0 bored :�& tongue tied

:�c bummed out :�# lips are sealed :�\ Undecided

: ( ) can’t stop talking :~/ mixed up :�0 wow

: *) clowning :�@ screaming >�O Yawning

Building Your Toolkit:
Subscribing to a Professional Discussion List

K–12 teachers can sometimes become isolated in their classrooms because of scheduling requirements and teaching du-
ties. Professional discussion groups provide an opportunity for ongoing discussions among teachers without interrupting the
class schedule. Teachers.net (http://www.teachers.net/) is a sponsored website containing a variety of resources, including
chat rooms, lessons plans, live meetings, discussion groups, and an online newsletter. Teachers.net calls its discussion lists
mailrings and offers several, including grade-level and subject groups. There is no cost to join, you subscribe to a group(s)
by completing a Web form. Anyone who subscribes receives instructions for posting to and receiving e-mail from teacher
colleagues around the world.

STEP PROCEDURE

1. Open your Web browser and then the Teachers.net discussion group page at
www.teachers.net/mailrings. A Web page with a form similar to that in Figure 3–8 should be displayed.

2. Complete the form to join a discussion group appropriate to the grade level and/or subject area you teach.
• Select one or more discussion groups by clicking the check box beside the name of the discussion group you

want to join.
• If you want to join a discussion group with teachers in your state, click on the down arrow of the pull-down

list for Your State Mailrings, and select your state from the list. If you do not want to join a state mailring,
uncheck the check box beside Select State.

• If you do not want to receive the online newsletter or information about events, uncheck the
Teachers.Net Gazette and EVENTS@Teachers.Net check boxes.

• Enter your e-mail address in the E-Mail field.
• Click the Subscribe button to join the discussion group(s) you have selected.

(Continued)
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Building Your Toolkit:
Subscribing to a Professional Discussion List (Continued)

3. Teachers.net mailrings and many other discussion lists use a common Internet management program called
Majordomo, which automates the management of Internet mailing lists. Majordomo controls a list of addresses
through existing e-mail systems but performs no mail delivery itself. When you click the subscribe button, Majordomo
requires you to confirm your subscription by sending a message similar to the following to your e-mail account:

Someone (possibly you) has requested that your e-mail address be added to or deleted from the mailing list
“[group]@lists.teachers.net.”

If you really want this action to be taken, please send the following commands (exactly as shown) back to
“majordomo@lists.teachers.net”: 

auth [authorization number] subscribe [group] [e-mail address]

If you do not want this action to be taken, simply ignore this message and the request will be disregarded.

(Continued)

FIGURE 3–8: A Subscription Form for Teachers.net Mailrings
Source: Retrieved from http:// teachers.net. @ Copyright 2004 Teachers.net. All rights
reserved. Reproduced with permission.
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REFLECTIONS

Internet technologies and information resources make it possible to organize classrooms
into learning communities with students, teachers,and community members all playing vital
roles in directing the course of education (Riel,1998).Using synchronous and asynchronous
communications on the Internet, students can interact with many more people and ideas.
According to Riel, the structure of future learning environments will be determined by how
students, teachers, and the community use these new educational tools (see Table 3–2).

The powerful technologies and information resources available on the Internet can bring
learning to life in the classroom. It can even make learning exciting and fun. Internet tech-
nologies and resources have the potential to motivate and engage students as active learners
because of the capacity for informative communication and collaboration and relevant multi-
media resources.There are a number of ways teachers can use the Internet in the classroom:

• Access worldwide information sources such as newspapers and magazines, online
encyclopedias, historical documents, government documents, research papers,
books, maps, directories, and guides

Building Your Toolkit:
Subscribing to a Professional Discussion List (Continued)

STEP PROCEDURE

4. The best way to confirm your subscription without making any typing errors is to copy and paste the authoriza-
tion command to a new e-mail message. You would copy the command, reply to the Majordomo confirmation
e-mail, paste the authorization command into the body of the e-mail, delete all other text from the e-mail, and
send your confirmation. When you have successfully confirmed your subscription to a discussion list, Majordomo
sends you a notification and a welcome message.

5. Once you receive notification that you have successfully joined the discus-
sion list, you should enter an e-mail address into your address book
for the discussion group(s) you have joined. (If you had joined
the WebTalk group, you would enter webtalk@lists. 
teachers.net into your address book.) You can initiate a
discussion by sending an original e-mail to your discussion
group, or you can reply to messages received from other
members of your discussion group.

6. Send an e-mail message to the discussion group you have
joined concerning a question or issue appropriate to the dis-
cussion group, and solicit the views of other members of the
group. Respond to someone’s comments, being sure to use appro-
priate netiquette when writing your messages.

7. Majordomo provides instructions for unsubscribing from a
discussion group, but you can easily unsubscribe by using
the Web form at Teachers.net. On the Web form at
www.teachers.net/mailrings, scroll down to the
Unsubscribe from a Mailring section of the form,
click on the down arrow for the pull-down list, and se-
lect the appropriate discussion group(s) from the list. If
you wish to unsubscribe, enter your e-mail address 
(exactly as you subscribed), and click the Unsubscribe
button. You will receive a confirmation from Majordomo
when you have successfully unsubscribed.

Go
to the Companion Website

and browse 3.2 Building Your Toolkit

Enrichment Activity: Joining a Student

Discussion Group. Use the information in
the enrichment activity for creating

learning activities using online
communication among 

students.

Go
to the Companion Website

and browse 3.2 Project Sample:

Netiquette and Internet Ethics. Use the
project sample as the foundation for a

learning activity to introduce guidelines for
participation in online communication. Adapt

the project sample to the subject area
and/or grade level that 

you teach.
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• Communicate with experts on almost any subject

• Take a virtual field trip to the Smithsonian or other museums,space missions,sports
teams, or television and movie studios

• Work on projects with schools located thousands of miles away

• Listen to music while your class learns about composers and musicians

• View video clips created by other students from around the world

• Obtain access to free government and scientific databases worldwide

• Find thousands of free graphics, pictures, and animations

• Use online programs and simulations to demonstrate scientific and mathematical
principles and calculations

• Access thousands of educational resources such as lesson plans and WebQuests,
most of which are free for use in your classroom

EXERCISES TO REVIEW AND EXPAND YOUR SKILLS

Set 1: Reflecting on Practice

■ Closing the Case. The case study scenario presented a middle-school computer
teacher, Carla Hockenbury, who has identified the 10 best ways to use the Internet
in the classroom.What role would you want the computer teacher in your school to
have in relation to your students and the other teachers in the school? What tech-
nology information and assistance should the computer teacher provide to your stu-
dents and the other teachers in your school? What is your favorite example of a way
to use the Internet in the classroom, and why is it your favorite?

■ World Wide Web Consortium. In small groups discuss the role and importance of the
W3C for

• developing common protocols to ensure the interoperability of the Web and pro-
mote its evolution

• encouraging an open forum for discussion of the technical evolution of the Web

Should the Internet have more control? Who/what should control the Internet?
Summarize those points on which the group reaches consensus, and report to the
whole class.

■ Domain Names. You (or your team) have been assigned the task of recreating a new
system or hierarchy for naming locations on the Internet. Develop a new naming

TABLE 3–2 The Evolution of Instructional Tools

Past tools for learning Promising power tools for learning

Textbooks and worksheets Primary sources and student-created materials

Linear text student writing Hypertext, multimedia productions

Models and materials Virtual creatures and simulations

Direct observations Tools for remote observations

Educational films, broadcast reality Virtual worlds interact with reality

Teacher delivers lectures Many expert voices in classroom

Student reports to teacher on learning Student generates lessons for others

Source: From Education in the 21st Century: Just-in-Time Learning or Learning Communities by M. Riel, 1998. Retrieved
September 25, 2003, from http://gsep.pepperdine.edu/~mriel/office/papers/jit-learning/index.html. 
Reprinted with permission.

�
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66 Chapter 3 Internet Technologies for Teaching and Learning: An Overview

system, and use charts or graphs and narrative as necessary to demonstrate how
your new naming system works.You might want to use design or outline software
such as Inspiration for this activity.

■ Emoticons. The use of emotion in asynchronous conversations is often discouraged,
especially when it leads to heated discussions that result in flaming.

• What role should emotion play in asynchronous communication? 

• Do emoticons provide an appropriate outlet for displaying emotion or nonverbal
behavior in an asynchronous conversation? Why?

• Do emoticons serve to increase understanding about the intentions of the au-
thor? Why?

Create one or two emoticons for emotions or nonverbal behavior that are not included
in Figure 3–7.

■ Newsgroups. Setting up a newsgroup may not be feasible for most teachers because
it is a much more complex procedure than setting up a message board. Because
newsgroup articles are propagated throughout Usenet,you must have the consent of
Usenet administrators, and different hierarchies of newsgroups have different rules
for creating new groups. If the topic is of broad international interest, one of the
so-called Big 8 hierarchies (comp, humanities, misc, news, rec, sci, soc, or talk) or alt
is logical. If the topic is basically of local or regional interest, you should look for an
appropriate national, regional, or local newsgroup hierarchy. On the Google Groups
website (http://www.google.com/groups) you can select the link for Help and find
an FAQ about setting up a newsgroup. Then just follow the links that describe the
official procedures for setting up a newsgroup.

• What newsgroup hierarchy would be appropriate for setting up a classroom
newsgroup? 

• List the procedures for starting a newsgroup under the hierarchy that you have
selected.

Set 2: Expanding Your Skills

Advanced Web Browsing and Customizing Your Browser. You can customize the
operation of the Web browser on your computer through several settings:You can set the
home page, set default programs, and customize the look and feel of the browser.

■ Setting Your Home Page. You can change the home page that comes up when you
load your Web browser program. For Internet Explorer select Tools > Internet
Options and then select the General tab (see Figure 3–9). For Netscape Browser
select Edit > Preferences. Then enter the URL for the Web page you want to use as
the home page for your browser and click OK to close the dialog box. Test what you
have done by clicking on the Home button on your Web browser.

FIGURE 3–9: Setting the Internet Explorer Home Page
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■ Setting Default Programs in Internet Explorer. You can set which program the
browser automatically uses for different Internet services.For Internet Explorer select
Tools > Internet Options, and then select the Programs tab (see Figure 3–10). If
you set your e-mail program to Outlook Express,your browser will automatically run
Outlook Express if you click on an e-mail address on a website.You can configure
other programs, such as your HTML editor, your newsgroup reader, your calendar,
and so on.You can also set whether you want Internet Explorer to be the default
Web browser.(You may not want it to be if you use another Web browser more often
than Internet Explorer.)

■ Customizing the Look and Feel of the Web Browser. By modifying the advanced
options, you can control the look and feel of the Web browser. For Internet
Explorer select Tools > Internet Options, and then select the Advanced tab
(see Figure 3–11). For Netscape Browser select Edit > Preferences, and then
expand Advanced in the Category frame on the left side of the dialog box (see
Figure 3–12). Features include launching the Web browser directly into a full screen
window when you run it, displaying error messages or not, automatically checking
for updates or not,and showing friendly URLs. In Internet Explorer if you are unsure
of what a feature does,you can click the ? icon in the top right-hand corner and then
click on the option you want more information about. A dialog box will appear with
more information.You can always restore the default settings by clicking the Restore
Defaults button on the bottom right.

FIGURE 3–10: Setting Default Programs in Internet Explorer
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FIGURE 3–12: Customizing Netscape Browser

FIGURE 3–11: Customizing the Internet Explorer Browser
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Set 3: Using Productivity and Web-Authoring Tools

■ Internet Technologies Presentation. Use a multimedia presentation program such as
PowerPoint to create a lesson you can present to your class on Internet technologies.
Use the information in this chapter to develop the talking points for your presenta-
tion and make the content appropriate for the grade level you teach. Insert clip art in
your presentation to correspond to each of the Internet technologies you include.

■ Internet Technologies Handout. Create a student handout of Internet technologies
that is appropriate for the grade level you teach.Insert clip art to correspond to each
of the Internet technologies you describe. Use Inspiration or another diagramming
tool to create a diagram that identifies and gives an overview of the Internet tech-
nologies you describe and any relationships among them.Paste the diagram into the
student handout document.

■ Workshop on the Best Uses of the Internet in the Classroom. Use Ms.Hockenbury’s
10 best uses of the Internet in the classroom as the basis for a multimedia presenta-
tion you could share with other teachers in a workshop on using the Internet in the
classroom.As you advance through this textbook,use the information in the various
chapters to determine your own top 10 list of best uses and to develop the talking
points for your presentation.

Set 4: Creating Your Own Web-Enhanced Project

■ Internet Technologies. Plan a project that uses one or more of the Internet tech-
nologies described in this chapter.You can use the project sample you developed in
Set 4 at the end of chapter 2 or a new topic.Plan a curriculum-based,Web-enhanced
learning project using the WEL project sample template,and include an element that
addresses Internet technologies and resources (see Figure 3–13).

■ WEL Lesson Plans. Expand one of the project samples for this chapter from the
Companion Website—Understanding the Internet or Netiquette and Internet
Ethics—into a WEL lesson plan that is appropriate for the grade level and/or subject
that you teach.

FIGURE 3–13

Title/topic State an interesting, attention-getting title.

Standards of learning State subject-specific standards and grade-specific technology standards to be addressed by the project.

Problem/task  State the problem or task the learner needs to solve or perform.
and/or

Background information Provide orienting or organizing information about the project.

Procedures Describe proposed procedures the learner should follow to complete the project. Describe any
alternative approaches or adaptations that learners may use.

Resources State what Web resources are available for the learner to appropriately and successfully complete the
project’s stated goals, objectives, or purpose. Identify other resources that would enhance the learning
experience.

Teaching/learning strategies Describe the teaching and learning methods used to complete the project (may be included in the
procedures). Consider teaching methods that address different learning needs. If appropriate, consider
alternative teaching methods for teaching the same information or skills.

Assessment State what the learner will do to demonstrate understanding and mastery of objectives.

Credits/references If the project was adapted from another project or lesson plan, provide credits or URL.
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CHAPTER 4

Using the Internet 
for Communication
Using the Internet 
for Communication

Janet Peterson is a high-school English teacher in a large suburban high school. She has been a teacher for
almost 30 years and has taught at the same school for most of that time. During her career she has expe-
rienced many initiatives intended to engage students in learning and make the educational experience
more meaningful. Although some of these educational initiatives have been useful, from her point of view
none of them has been as effective for engaging students as online discussions. She maintains that the com-
munication features of the Internet have motivated her students to engage in more meaningful discussions
about their reading assignments than have any other innovations she has implemented in the classroom. 

For the last several years Ms. Peterson has been creating a closed online discussion group for her
two literature classes using Yahoo’s e-groups. A closed group is a members-only group.The discussion
group has allowed her students another option for entering into classroom discussions; they can
continue discussions started in class or start discussions that can be continued in class. In addition, Ms.
Peterson can pose questions for discussions, provide links to related information, take polls, and post
messages to the class. She can also remind students of upcoming events, homework assignments,
schedule changes, and even days when there is no school.

Ms. Peterson has found that with the online discussion group some students who might otherwise
hesitate to ask a question in class or enter into a classroom debate are more likely to become engaged be-
cause they have time to reflect before asking questions or making comments. Ms. Peterson says that for
other students the online discussion group is a great way to keep them on track. Although she is nearing
the end of her career, Ms. Peterson thinks that Internet technologies make it a great time to be a teacher.

NEW TERMS

chatiquette spam
flaming virus
keypals
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OVERVIEW

Communication and information sharing among computers on the Internet occur through
a number of technologies, including e-mail and the World Wide Web. Person-to-person on-
line communication occurs between two or more individuals holding a private or public
conversation—for example, a student can have an e-mail conversation or a chat with a
teacher or a peer. Online group communication includes more participants and is used to
communicate the same information to multiple individuals—for example, a teacher can
pose a question to a discussion list, and students can respond at any time. Person-to-person
communication tools include e-mail and chat, and group communication tools include dis-
cussion groups and message boards.

As was mentioned earlier, e-mail (electronic mail) refers to messages sent via the Inter-
net. Many Internet users got their start using e-mail, which is a fast and easy way to send
messages from one person to another or to a group.Messages are typically delivered within
seconds or minutes of the time the message is sent.

As discussed in chapter 3, chat is real-time communication between two or more peo-
ple using computers, usually through the Internet.A chat room is a virtual space where a
chat session takes place. During a chat session participants can be physically located any-
where in the world but are able to communicate almost instantly by typing text that imme-
diately appears on the screens of all participants in the chat session.

Listservs or discussion lists are useful for facilitating communication among a group of
individuals. A listserv is basically a program on an e-mail server that keeps track of the e-mail
discussion lists that are available and the members of each discussion list.When messages
come in for a particular list, the listserv program rebroadcasts that message to all of the
members of the list.

National Educational Technology
Standards for Teachers

The following NETS•T are addressed by the lesson
content and learning activities in this chapter:

I. Technology Operations and Concepts

A. Demonstrate understanding of technology
concepts and skills

B. Demonstrate continual growth in technology
knowledge and skills

VI. Social, Ethical, Legal, and Human Issues

A. Model and teach legal and ethical practice related
to technology use

B. Enable and empower diverse learners
C. Identify and use technology resources that affirm

diversity
D. Promote safe and healthy use of technology

resources
E. Facilitate equitable access to technology

resources

National Educational Technology
Standards for Students

The following NETS•S are addressed by the lesson
content and learning activities in this chapter:

1. Basic Operations and Concepts
• Demonstrate sound understanding of technology
• Be proficient in the use of technology

2. Social, Ethical, and Human Issues
• Understand ethical, cultural, and societal issues

related to technology
• Practice responsible use of technology
• Develop positive attitudes toward technology

3. Technology Productivity Tools
• Use technology to enhance learning, increase

productivity, and promote creativity
• Use tools to collaborate, prepare publications,

and produce creative works

4. Technology Communications Tools
• Use telecommunications to collaborate, publish,

and interact with others
• Use varied media and formats to communicate

information and ideas
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Message boards or Web-based bulletin boards allow users to post a message that can be
read by anyone who accesses the bulletin board. Message board discussions are threaded,
meaning that messages about a particular topic are grouped together. Thus, users are able
to reply and associate their messages with a specific message already posted.

Lesson 4.1 Person-to-Person Information Exchanges on the Internet

FOCUS QUESTIONS
■ How can e-mail be used to enhance teaching and learning in the classroom?
■ What are keypals, and how can you use keypal projects in the classroom?
■ How can chat be used to enhance teaching and learning in the classroom?
■ What are the rules and procedures for communicating with others using chat?

■ USING ELECTRONIC MAIL

When Ms. Peterson started using the Internet in the classroom, she soon realized that it
is important for students to have a personal or classroom e-mail account. In the class-
room free e-mail service is a good option; although students may have to endure some
advertising, these accounts are accessible, functional, and easy to use. However, you
should always check with your network administrator and school district policies to
learn how e-mail works at your school and what is the best way to create student e-mail
accounts.

Although e-mail and the other online communication tools discussed in this chapter
have several distinct advantages, they may not always be the best choice for every class-
room at every grade level. School policies may limit or prohibit the use of e-mail by stu-
dents, and filtering programs may prevent access to Web-based e-mail services. If such
services can be used, you should remember that they demand no accountability on the
part of students and, therefore, may circumvent your school district’s policy on proper use
of e-mail.Elementary-school teachers may want to set up a classroom e-mail account so that
they can monitor messages that are sent and received by young students.

E-mail is a simple way to begin using asynchronous tools in the classroom. Because
e-mail programs are relatively simple to use, it does not take long for students to use
them effectively; many students probably already have personal e-mail accounts. At least
one computer with a connection to the Internet is needed, and access to a computer
network connected to the Internet is better. Many classrooms in schools and universities
have computers or computer labs that are connected to the Internet.

E-mail penpals, or keypals, are the most basic form of student e-mail projects (see
Harris, 1998). Keypals are penpals who communicate with one another through the In-
ternet. In a keypal project students are paired with students in classes at other schools;
they use e-mail to communicate on any topic and at a frequency they determine between
themselves.To be worthwhile, a keypal’s project should include assignments that students
work on in teams or groups and for which a product is required as the final goal.

The primary advantage of using e-mail in classroom learning activities is that students
become engaged in intellectual conversations that are less contrived than those of text-
book- or teacher-centered activities. Using e-mail requires students to use and type words
carefully and appropriately to express their thoughts.A lot of time is needed, however, to
plan and conduct learning activities using e-mail, which often require finding classes with
similar learning goals. There are websites available on the Internet to help you find other
classrooms to participate in a keypals project.

E-mail and other online communication tools can effectively complement instructional
activities. Synchronous and asynchronous online discussions are a pedagogically sound

�
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practice because they provide more opportunities for students to become actively involved
with curriculum content (Markel, 2001). Online discussion, however, should be used pri-
marily as an addition to in-class discussion, rather than as a substitution for it (Tiene, 2000).

An e-mail assignment can be used as an introductory device for using asynchronous
communication.For example,students can e-mail one another and the teacher,and the mes-
sages received can be used to create an address book for the class. Later, students can send
mail to students in other classes and to keypals in other parts of the country or the world,
or they can contact experts and sources for research projects.

Because the amount of correspondence can be overwhelming when you use e-mail for
learning activities, you should establish a structure for asynchronous communications in the
classroom and should state your policies to students. For example, you might notify your stu-
dents that you will reply to e-mails within 24 hours. You might also want to set up an addi-
tional e-mail account for assignments and then use the auto-reply feature to automatically let
your students know that you have received their e-mails.You can use folders to help organize
the messages according to their appropriate project, group, or class; students should use key
words such as a project title or a class name in the subject line of their messages to assist in
sorting and grouping the messages.You should also require students to use signature files so
that their names and important contact information appear at the bottom of every message.

When using student e-mail accounts in the classroom,students should be instructed about
➞ e-mail spam and viruses.Spam is unsolicited e-mail sent by an individual or a company with

which the recipient has had no previous dealings.Viruses are self-replicating pieces
of computer code,which can be spread by e-mail and can damage a computer

by partially or fully attaching themselves to files or applications.Most e-mail
programs, including those offered by Internet portals and service
providers, have features that allow users to filter in-coming e-mail mes-
sages. These filters,however,are not always effective in blocking spam and
questionable e-mail messages. Before using e-mail accounts with young

children, teachers should be knowledgeable about available measures to
prevent or reduce the impact of spam and virus attacks. School or school dis-

trict networks that provide e-mail accounts for students may offer some antispam
and antivirus measures at the server level.

Go
to the Companion

Website and browse Chapter 4

Lesson Links: E-Mail Spam and

Viruses: The Dark Side of E-Mail

to learn more about this
topic.

Building Your Toolkit:
Managing E-Mail Accounts and Sending/Receiving File Attachments

An e-mail address is becoming as common as a phone number; it provides a convenient method of communicating with
friends, family, colleagues, and students. E-mail accounts have several advanced features that you should be able to use—
adding signature information to e-mail messages, sending and receiving file attachments, forwarding e-mail messages from
one person to others, and informing others that you are away from your account for an extended period of time. These
features allow you to use your e-mail account more productively and effectively. For this tutorial you will need to have a
personal e-mail account. If you do not already have an e-mail account, you can sign up for a free Yahoo! Mail account at
http://mail.yahoo.com/ or an MSN Hotmail account at http://www.hotmail.com/. Use the e-mail application of
your e-mail account to perform each of the following operations:

STEP PROCEDURE

1. Locate the formatting options for your e-mail program. Then set up a signature for your e-mail account that in-
cludes your name, e-mail address, mail address, phone number, and other appropriate information, perhaps a
title or position and institution name. Apply the signature to all new e-mail messages you send.

2. Send an e-mail with one or more file attachments. E-mail attachments are files sent along with an e-mail mes-
sage. An attachment can be any kind of file, including formatted word-processed documents, spreadsheets,
databases, graphics, and even software. The e-mail message should explain to the recipient the type of file or
file format (e.g., Word document, Excel spreadsheet, text file, picture).

(Continued)
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■ USING CHAT

Tommy Eldridge is a high-school social studies teacher and an assistant football coach who
frequently used computers at home and in his classroom. Although he commonly required
his students to search Internet resources,he did not allow them to use the Internet for com-
munication. He realized, however, that many of his students had considerable experience
communicating via e-mail and in chat rooms.

As Coach Eldridge began adapting his social studies courses to include problem solv-
ing,he realized that the subject matter could not be adequately addressed with information
searches alone.Students need to communicate with experts and peers to better understand
the context of a problem and to obtain other perspectives in developing solutions. Conse-
quently, he invited online quest lecturers to chat with his classes, and his students enjoyed
the opportunity to interact directly with political leaders and scholars.

Building Your Toolkit:
Managing E-Mail Accounts and Sending/Receiving File Attachments (Continued)

STEP PROCEDURE

• Sending an attachment. With most e-mail programs it is easy to send and receive messages containing
attachments. To attach a file to an e-mail message, open a new mail message and use your e-mail program
to attach a file (usually by clicking on a paper clip icon). The program will display a Find or Browse dialog box,
and you can then select the file you want to attach from your computer. A copy of the file will then accom-
pany the message to your recipient.

• Opening an attachment. If you receive a file attachment, you should see a note or an icon with your mes-
sage, indicating that it includes an attachment. Some types of files may be viewable within the message, depend-
ing on the e-mail program you use. Usually, files must be viewed with an application that is capable of opening
the file. You can either double-click on the file’s icon in the message to launch the program and open the file, or
you can save the file on your computer. E-mail programs may designate a default folder on your computer
where attachments are automatically saved. It is best to save the file to your computer and then launch the ap-
plication that can find the file on your computer and open it. If you do not have the right program to open a file,
you may need to ask the sender to send the file in a format that a program on your computer can read, or you
may need to take the file to a different computer with the right program installed and open the file there.

3. To forward a copy of an e-mail you have received to someone else, select the forward option while you are
viewing the e-mail. Then type in the address field the e-mail address of the intended recipient, add any addi-
tional message, and press Send.

4. Again, locate the formatting options for your e-mail program. Then activate the auto-reply or vacation mail func-
tion; it is useful when you are away and cannot check your e-mail account. Create an auto-reply message, explain-
ing that you are unable to reply to the e-mail message. You can provide information in the auto-reply message
about the day of your return or the name of the person who is handling your responsibilities in your absence.

Go
to the Companion Website

and browse 4.1 Project Sample:

Cultural Exchanges Through Internet

Keypals. Use the project sample as the
foundation for a learning activity with
interpersonal information exchanges.

Adapt the project sample to the
subject area and/or grade level

that you teach.

Go
to the Companion Website

and browse 4.1 Building Your Toolkit

Enrichment Activity: Creating Information

Exchanges Using E-Mail Keypals. Use the
information in the enrichment activity to

develop learning activities using
information exchanges supported by

e-mail.
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In addition, because his coaching duties limit his availability during the school day and
after school, Coach Eldridge incorporated online office hours into his schedule and en-
couraged his students to e-mail their questions to him. He found that he could be virtually
available to any student at any time. Coach Eldridge has now become a dedicated user of
Internet communication features,which he affirms can add a rich and appealing dimension
to classroom learning activities.

Whereas e-mail permits asynchronous person-to-person communication,chat provides
real-time Internet conversations. Chat can be difficult to use in the classroom, however, be-
cause it is completely unstructured and often confusing. Furthermore, chat rooms are not
always safe educational environments; they are susceptible to uninvited guests contributing
misinformation or offensive remarks.

Nonetheless, if a teacher is comfortable using chat and moderating a chat room, this
communication tool can be quite effective. One of the best uses of chat is to

provide access to experts, which would otherwise not be possible. A
class chat session allows teachers and students as a group to interact

with a guest speaker in real time, thus providing students with
real-world experiences related to their subject matter. Before in-
teracting online, students should thoroughly research the topic
to be discussed, checking the FAQ page at the guest speaker’s
website, if available,and any online biography about the speaker.

Students should create questions ahead of time for such sessions;
they might use an interview approach to ask about a speaker’s pro-

fession, rather than a specific topic. After the chat session students
should be discouraged from sending unsolicited e-mail to the speaker.

Chat can also be used to conduct debates and student-led discussions.
Students can post a position on a topic, to which others can respond with their own argu-
ments, followed by a critique of those arguments.A student can also submit a question to
the classroom chat forum about material read or discussed in class.That student, then, is re-
sponsible for leading the discussion that ensues from the question.Thus, students can be-
come facilitators of their own chat sessions.

Moreover, as Coach Eldridge discovered, chat is a good way to provide additional sup-
port for students through virtual office hours.Having a virtual office hour outside the regular
school day allows teachers to provide instructional support for homework assignments at a
time when students are most likely to need assistance. However, the effectiveness and fair-
ness of virtual office hours (and other online communications with students) beyond the
regular school day is dependent on their having out-of-school access to the Internet.

Chat session transcripts can also provide an excellent resource for a number of activi-
ties; logs of a chat session can provide a study tool for students and an evaluative tool for
teachers. After each chat session teachers can post the transcript to a Web page or send a
copy to students through e-mail or a discussion list. Students can then read and review the
conversation that took place during the chat. And transcripts permit students who were
not present in a chat session to review what transpired.

�

FIGURE 4 –1 Procedures for Chat Sessions

1. A participant with a comment or a question should type ! for a comment or ? for a question.

2. Participants type comments one sentence or clause at a time and then press ENTER so the group does not have to look at white
space while typing occurs. Individuals with poor typing skills should type an entire statement before submitting it to the chat session.

3. Participants type three forward slash marks (///) at the end of a comment or a question to indicate that the next participant can begin.

4. To request the floor, participants can type ? or ! at any time; the first person to enter a ? or ! has the floor. All participants are
responsible for maintaining the flow of conversation.

5. Requests to change the topic of conversation are signaled by typing new ? or new ! If no one objects by typing ! or ?, the participant
proceeds with the new topic.

6. Private chats during the discussion are not acceptable.

Go
to the Companion Website

and browse 4.1 Building Your Toolkit

Enrichment Activity: Using Online Experts

to Support Classroom Learning. Use the
information in the enrichment activity to

create learning activities using
information exchanges with

external experts.
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FIGURE 4–2 Chat Expressions

AAIK as far as I know

AFK away from keyboard

ASAP as soon as possible

BBFN bye bye for now

BBL be back later

BBS be back soon

BRB be right back

BTW by the way

BWL bursting with laughter

C&G chuckle and grin

CID cringing in disgrace

CP chat post

C YA see ya

C YA L8R see you later

EMSG e-mail message

EOF end of file

FC fingers crossed

FMG filling my glass

FWIW for what it’s worth

FYI for your information

*G* giggle

(G) grin

GFN gone for now

GMTA great minds think alike

GTSY glad to see you

HAGU have a good un

HHIS hanging head in shame

IC I see

IMHO in my humble opinion

IMO in my opinion

IOW in other words

IRL in real life

JMO just my opinion

JTLYK just to let you know

KIT keep in touch

L8R later

LMHO laughing my head off

LOL laugh out loud/laughing online

LTNS long time no see

LTS laughing to self

OBTW oh, by the way

OIC oh, I see

OTOH on the other hand

OTTOMH off the top of my head

PM private message

PMFJI pardon me for jumping in

POAHF put on a happy face

POD piece of data

POOF left the chat room

QSL reply

RFD request for discussion

ROFL rolling on floor laughing

RSN real soon now

RTSM read the stupid manual

RUOK? are you OK?

SETE smiling ear to ear

SITD still in the dark

SO significant other

SUL see you later

SWL screaming with laughter

SYS see ya soon

TA thanks again

TIA thanks in advance

TIC tongue in cheek

TNX thanks

TPTB the powers that be

TTYL talk to you later

WB welcome back

WRT with regard to

Because students can get lost in the unstructured atmosphere of a chat session and can fail
to participate, chat sessions should always have a clear focus and a way to keep student
discussion on track.The teacher should act as a moderator, encouraging all students to con-

tribute to the chat discussion.
Chat rooms follow their own procedures (see Figure 4–1) and have

their own form of etiquette,called ➞ chatiquette, which defines the so-
cial conventions that structure and organize chat sessions.The purpose
of chatiquette is not to diminish conversation but to facilitate clear and
unambiguous communication. It is a way to make the nonverbal cues of

face-to-face conversations available to all participants. To reduce the num-
ber of keystrokes when posting messages online, chatiquette permits abbre-

viations and acronyms (see Figure 4–2).

Go
to the Companion Website

and browse Chapter 4 Lesson

Links: Chatiquette to learn more
about this topic.
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Lesson 4.2 Online Group Communication

FOCUS QUESTIONS
■ How can discussion lists be used to enhance teaching and learning in the classroom?
■ How do you subscribe to and unsubscribe from a discussion list?
■ How can message boards be used to enhance teaching and learning in the classroom?
■ How do message boards support online communication?

■ USING GROUP COMMUNICATION TOOLS ON THE INTERNET

Like interpersonal communication tools, group communication tools can expand the geo-
graphical boundaries of your classroom. The tools presented in this lesson utilize asynchro-
nous communication,so that time zones and geographical locations will not make a difference.
Thus,discussion can be initiated and continued indefinitely as it evolves into new topics.

Group communication tools are also useful in the classroom for facilitating group
work and collaborative learning. For example, like Ms. Peterson, the high-school English
teacher you met at the beginning of this chapter, you can establish online discussion
groups or classroom message boards to provide other options for engaging students in dis-
cussing curriculum content.

Before using group communication tools,however, you should have a clear understand-
ing of how they work,and you should be proficient in their use.If you model confidence and
enthusiasm, your students are much more likely to participate eagerly in the learning activi-
ties you have planned.

The instructional strategies you employ using Internet communication technologies
are not much different from what you would do in the conventional classroom. For exam-
ple, you want to use Internet technologies to support a community of learning in the class-
room,which can flourish when students understand the proper techniques for exchanging
views that contribute to the collective creation of knowledge. When students conduct their
own research and discuss it with peers, they increase the probability of correctly solving a
problem or successfully completing a project.

■ USING DISCUSSION LISTS

E-mail discussion lists are useful for facilitating communication among individuals. The In-
ternet contains thousands of discussion groups that are managed by a list server, commonly
referred to as a listserv,a list processor,or a list. As mentioned previously, the basic operation
of a listserv is to keep track of available e-mail discussion lists and the members of each list.
When messages come in for a particular list, the listserv program rebroadcasts that message
to all of the members of the list—as if someone had sent an e-mail message to all of the mem-
bers of a group by entering all of their e-mail addresses in the To field of the message. The
listserv program merely automates the process.Lists are often moderated by a list owner,but
some lists are simply a free-for-all discussion without anyone filtering the messages.

Most lists can be provided to the user either in a digest form or on a post-by-post basis.
Listservs can distribute electronic journals, or e-journals, and newsletters. Most lists and
e-journals can be joined by posting an e-mail to the listserv address.Any member of a dis-
cussion list can take part in a conversation or can begin a new topic.

To use a discussion list in her classroom, Ms. Peterson had to decide whether to have
her own classroom discussion list or to join an existing Internet discussion list. Several list-
serv programs are freely distributed on the Internet, and many school or school district net-
works are capable of supporting classroom listservs.Tools are also freely provided on the
Internet for setting up your own discussion group.

�

�
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Ms.Peterson decided to implement her own classroom discussion list. Thus, she had to
monitor list traffic, provide thoughtful questions, recommend useful resources, and work
behind the scenes to enforce the list guidelines and help list subscribers stay on topic. As
with face-to-face discussions in the classroom, good discussion list managers set a welcom-
ing tone, shape the focus of the discussion, manage technical issues and any debates that
ensue, and summarize the discussion.

There are social conventions and common courtesies that guide online discussions.
For example, when replying to a listserv message, you need to decide whether your reply
should go only to the original sender or to the whole list. If the original poster is asking for
a specific piece of information that would not be of interest to other list members, it is prob-
ably best to reply directly to the individual.But if the original e-mail and your reply are about
topics of general concern to list members, then replying to the list would allow them all to
follow the ongoing discussion. In general, the same rules of discourse and discussion that
pertain to the classroom should be applied to listserv discussions as well. Figure 4–3 pro-
vides some basic guidelines for Internet discussions.

�

FIGURE 4 –3 Netiquette for Online Discussions

• Be brief. Remember that the longer your message is, the fewer the people who will bother to read it.

• Use descriptive subject lines. Provide a title for the content of your message.

• Avoid typing in uppercase letters. Typing in uppercase is considered shouting on the Internet.

• Avoid getting flamed or flaming others. Members of discussion groups who do not follow the rules for the discussion 
group or who ask stupid questions may receive flame mail. Flaming is a heated retort of a personally demeaning or 
derogatory nature. Try to avoid sending flame mail even when someone else has not followed the list rules.

• Summarize and snip. Either summarize the previous person’s post and add your comments, or include the parts to which 
you would like to respond and delete the rest.

• Be careful with humor and avoid sarcasm. Because nonverbal cues and facial expressions are an important part of 
humor and sarcasm, it is easy for dry humor and sarcasm to be offensive in Internet communications.

• Pay attention to the reply address. Using the reply function on your e-mail program can send your reply directly to the 
person who posted the original message, or it can send your response to the entire group.

• Get to know the culture of the group. You may want to lurk for a while before offering your comments.

• Know your list addresses. Send commands to the administrative address and messages to the list address.

• It is more blessed to give than to receive. Take the time to share what you know when others make requests or submit
questions to the group.

• Your posts are a reflection on you. Read your message through before sending it because you will likely find misspellings,
missing words, or breaks in logic.

• Be careful what you say. Thousands of people may read your message, and what you say may come back to haunt you.

• When summarizing, summarize! When you request information from a discussion group, it is common courtesy to offer 
to summarize and report your findings so that others can benefit as well. The best way to do this is to take all the responses 
you received and edit them into a single message.

• Avoid dittos and me-toos. If you agree with what is posted, there is no need to add to the volume of mail in people’s 
boxes by saying ditto.

• Mark your spoilers. If the topic of your post could be difficult or painful for other list members to read, be sure to indicate 
this in your subject.

• Take it private. If a subject has evolved into a conversation between two or three people, correspond privately rather than 
sending your messages to the list.

• Save the welcome message. The system-generated message you receive when you have successfully subscribed to a list 
usually also contains other useful information (such as how to unsubscribe).

Source: From University of Kansas Academic Computing Services at http://www.ku.edu/acs/documentation/docs/listproc/netiquette.shtml. Reprinted with
permission.
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Five Simple Rules for Subscribing to and 
Unsubscribing from a Discussion List

1. Send e-mail messages as plain text. Allow message recipients to select for themselves what size
and font they prefer. Do not set your e-mail system to send formatted text.

2. Always read and keep a copy of the instructions/guidelines when you or your students
subscribe to a discussion list. You may need these instructions later for help in using the list ap-
propriately and for unsubscribing instructions.

3. Set up e-mail accounts in your contacts list or address book with the e-mail address
for posting messages as well as the e-mail address for the list manager. The e-mail ad-
dress for managing a list may be different from the e-mail address for posting messages to the list.

4. Never send subscribe or unsubscribe commands to the e-mail address you use for
posting a message. Posting such requests to the entire discussion list can be embarrassing to you
and frustrating to the members of the discussion list.

5. Unsubscribe from the exact e-mail address from which you subscribed. If you have sev-
eral e-mail addresses or your e-mail address can be written in several ways, make sure you use the
same address for subscribing and unsubscribing.

80 Chapter 4 Using the Internet for Communication

Subscribing and unsubscribing from discussion lists is accomplished by sending e-mail
messages to a prescribed address. With some discussion lists you can subscribe (or even un-
subscribe) from a link on a Web page that automatically sends an e-mail message. Correct
spelling and syntax are critical for subscribing and unsubscribing operations because key
phrases are parsed by a computer to automatically add you to or delete you from the list.

When you subscribe to a mailing list, you may receive a confirmation that includes the
e-mail address for unsubscribing from the list. You should keep that e-mail and any infor-
mation about additional addresses related to general questions and requests. It is important
that you understand the distinction among addresses. E-mail messages that you want dis-
tributed to other members of the list should be sent to the list address,whereas e-mail mes-
sages to the listserv program should be sent to the administrative address. Figure 4–4
provides a list of guidelines to help you remember the most important steps in subscribing
to and unsubscribing from a discussion list.

Building Your Toolkit:
Setting Up a Yahoo! Groups Account and Discussion List

You may be able to create discussion lists through your school or school district network. If not, you can create a personal
listserv, bulletin board, and/or chat forum using Yahoo! Groups, which is a free service that allows you to create and mod-
erate your own discussion list. Yahoo! Groups is an easy-to-use, privacy-protected, and spam-protected discussion envi-
ronment. You can use the service from the Yahoo! website or through any e-mail program.

Before setting up your discussion list, you should make certain preparations; you should define the purpose of your
list, decide who will participate, and choose your list format. Refining the focus of your list will increase its chances for suc-
cess. Ask yourself the following questions:

• What is the main purpose of the list (e.g., discussion, information exchange, coordination of learning activities)?
• What is my goal in creating a list (e.g., addressing a topic or issue, building a learning community, facilitating teamwork)?
• Which topics are appropriate for discussion, and which are not?
• How much message volume, or traffic, will there be on the list (usually measured by the number of e-mails per

subscriber per day)?
• Do I want the list restricted to specific participants or open to anyone?
• Do I plan to moderate the mailing list?

(Continued)

FIGURE 4–4

MILLMC04_0131105469.QXD  10/3/05  8:56 AM  Page 80



Online Group Communication 81

Building Your Toolkit:
Setting Up a Yahoo! Groups Account and Discussion List (Continued)

• How much time can I spend managing and moderating the list?
• Are the advertisements at the bottom of messages appropriate for my subscribers?

Once you have answered these questions, you are ready to develop guidelines for your mailing list to inform sub-
scribers about the objectives and operating parameters of the list. Because it is your list, you can designate any agenda and
establish any rules as long as you declare these rules at the start. If subscribers repeatedly violate list guidelines, you can un-
subscribe them from the list.

Mailing list software usually allows you to send a welcome or confirmation message to each new subscriber. Mailing
list managers can also send list guidelines periodically to remind subscribers of the rules. When using discussion lists in your
classroom, you may want your students to initiate the subscription process themselves, but in this exercise you will regis-
ter the e-mail addresses yourself. Thus, before starting the tutorial, you should invite two or more participants to join the
group created by this activity and obtain their e-mail addresses.

STEP PROCEDURE

1. Open your Web browser and then the Yahoo! Groups website at http://groups.yahoo.com/.
2. To sign up for membership in Yahoo! Groups, you must register. If you already have a Yahoo! e-mail account,

click on the Sign In link. If you do not have a Yahoo! account, go to New User? and click on Sign Up. Com-
plete all necessary information fields.

3. Once your registration is complete, go to Create Your Own Group, and click on Start a group now.

• Select a Yahoo! Groups category for your group. For example, you might choose to select Schools & 
Education > K-12. Then click on Place my group here.

• Enter a name, an e-mail group name, and a short description of the group. Click on Continue. If required,
enter the verification text, and click on Continue again.

• Once the group is set up, a confirmation screen will be displayed.

4. Return to the Yahoo! Groups home page. Go to My Groups and select the link for the group you created.
5. On the navigation bar on the left side of the window, select Invite to ask members to join the group. Enter the 

e-mail addresses of the participants who agreed to join your group. If you enter a message explaining why you are
inviting these people to join your group, it will be included with the e-mail in-
vitation. Click the Submit Invite button.

6. When your invited participants subscribe to your list, welcome
them by e-mail, and provide list guidelines.

7. From the navigation bar select the Management link, and
review the management categories listed. Manage your
own discussion list by performing the following functions:
• Post a general reminder of list guidelines and Netiquette.
• Post a friendly message to thank subscribers for their

contributions.
• Encourage list members to introduce themselves.
• Encourage and summarize discussions.
• Provide content to begin discussions.
• Post some resources that are relevant to the discussion.
• Subscribe and unsubscribe users as necessary.

Go
to the Companion Website

and browse 4.2 Building Your Toolkit

Enrichment Activity: Searching UseNet

and Posting to a Newsgroup. Use the
information in the enrichment activity to

create learning activities involving
newsgroup discussions among

students.

■ USING MESSAGE BOARDS

Before there were e-mail accounts, a World Wide Web, or even an Internet, online commu-
nication meant posting text messages on electronic bulletin boards where others could
read and reply to them. Now electronic bulletin board services are asynchronous commu-
nication tools on the World Wide Web. Message boards are useful for online communication
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because they are relatively easy to access.The information shared resides in an archive, and
discussions are threaded, making it easy to check student participation.

Unlike discussion lists,message board messages do not come to students directly by e-mail;
students must go to the message board to be able to read and post messages. An advantage
to this approach is that postings are collected in one place, specific to the subject at hand.
Furthermore, students do not have to have an e-mail account of their own to view mes-
sages. However, posting to a message board usually requires an e-mail account.

Online message boards are a great way to extend class participation beyond the
classroom. A message board allows students to discuss course topics online,respond to each
other’s comments,and share ideas. With a message board you can designate the participants,
suggest topics for discussion, and monitor students’ participation. When using message
boards in the classroom, you should build online discussions into your curriculum; students
are more likely to participate in online discussions if credit is given for participation.

Online discussions can increase the participation of students who are shy or uncomfort-
able speaking in front of the whole class. Because some students like to take time to reflect and
write their comments,teachers can accommodate a variety of learning styles or preferences by
grading participation based on in-class as well as message board discussions. In addition,
because message boards provide an opportunity for students to edit their postings,another ob-
vious benefit is the potential for students to practice and enhance their writing skills.

When using online discussions, teachers should allow students enough time to consider
their responses and post them. Teachers should also consider the size of the discussion groups;
students and teachers find it difficult to keep up with discussions if there are too many re-
sponses to read. An effective strategy is to create several smaller discussion groups for one class.

Teachers may choose to be active in the discussion or limit their participation, based
on the instructional goals of the discussion.However,successful discussions using message
boards are usually the result of the teacher taking an active role in structuring meaningful
discussions that are relevant at the current time and motivate students to think and make
contributions.Teachers can offer guidance by posing new questions and providing feed-
back, perhaps organizing discussion by chapter topics in an associated textbook.Teachers
should always validate student postings and provide more information when needed.

Online discussions work best if topics discussed on the message board are introduced in
class.Meaningful topics that relate to classroom learning activities will promote discussion and
facilitate a deeper level of thinking about a discussion topic. One useful instructional strategy
is online debates. Individuals or groups can be assigned different sides of a controversial topic,
and a vote can be taken at the end to see who had the most convincing argument.

Policies for online discussions need to be clear and well defined and should include
how individual students or groups are graded for their contributions to discussions. Guide-
lines might also specify a minimum number of responses and the minimum length of mes-
sages, to encourage students to think harder about the content of a message rather than just
replying with very short, superficial comments.

Building Your Toolkit:
Creating a Connected Classroom

Nicenet’s Internet Classroom Assistant (ICA2) allows virtually any classroom, even those with modest technology resources,
access to powerful Internet tools and technologies. ICA2 is a sophisticated communication tool that offers the following features:

• Conferencing: You can create your own private, threaded conferencing on topics you choose for the class or
allow students to create their own topics.

• Scheduling: You can put the class schedule online. With a 7-day advance notice on your class home page, students
will have a heads-up display of upcoming assignments and class events.

(Continued)
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• Document sharing: Both students and teachers have the ability to pub-
lish their documents on the site, using simple Web-based forms. No
knowledge of HTML is needed. Students are one click away from turn-
ing in their assignments online, giving their peers feedback on published
papers, and receiving teacher comments.

• Personal messaging: Similar to traditional e-mail but fully integrated with
document sharing and conferencing, personal messaging is a great way to
communicate with students, comment privately on conferencing postings,

or give private feedback on published papers.
• Link sharing: You can share links

to pertinent Internet resources
sorted by topics that you create.

Nicenet provides the
ICA2 free of charge for public
use with no advertising.
Nicenet makes no profit from

your participation, but you
must register with the Nicenet

website to take advantage of its
e-mail and chat features.

STEP PROCEDURE

1. Open your Web browser and then the website Nicenet.org at
http://www.nicenet.org. On the navigation bar on the right side of the
window, select the link Teachers: Create a Class in the New
Users Start Here box.

2. Complete the registration information, and click the button Create a
Class. After you create a class, you will be sent a class key code that
students can use to sign up for the class. Click Finish Registration.

3. Log in to see your classroom home page. Try out the various features of
ICA2 (see Figure 4–5) by making sample postings for the following features:
• Conferencing
• Link Sharing
• Documents
• Class Schedule
• Class Members

4. After you have browsed the features of ICA2, click the Log out link on
the navigation bar on the left side of the window.

Go
to the Companion

Website and browse 4.2 Building

Your Toolkit Enrichment Activity: Using a

Classroom Message Board. Use the
information in the enrichment activity to

create learning activities using
information exchanges among

students and the teacher.

Go
to the Companion Website

and browse 4.2 Project Sample: Ask an

Expert About a Topic. Use the project sample
as the foundation for a learning activity that

includes interpersonal information exchanges.
Adapt the project sample to the subject

area and/or grade level that you
teach.

FIGURE 4–5: The Features of
Nicenet’s Internet Classroom
Assistant.
Source: Retrieved August 25, 2004, from
http://www.nicenet.org. Reproduced with
permission.

Building Your Toolkit:
Creating a Connected Classroom (Continued)
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�
The computer has become one of Sherry Alarcon’s most valuable tools in the classroom. Ms. Alarcon, a
fifth-grade teacher, says that when teachers integrate technology into good instructional practices, they
add a new dimension to their teaching that can motivate and engage students. According to Ms. Alarcon,
most students today, even those in low socioeconomic areas, come from homes that are media rich with
electronic games, television, radio, CDs, and DVDs. She maintains that her students learn better when
they are in a classroom in which lots of technology resources are available for students to experience.

Ms. Alarcon has integrated computer technology and Internet use into almost every aspect of
her teaching. For example, while studying geography, her students use the Internet to explore geo-
graphy resources in the United States, getting material from websites such as the U.S. Geological
Survey (http://www.usgs.gov) and the National Geographic Society (http://www.nationalgeographic.
com/) to plan a class field trip. After searching the Internet, the school library, and the classroom book
collection, student teams choose a place or a location and map out the trip, describing the sights that can
be seen on the field trip. Next, students use a spreadsheet program to estimate the cost of the field trip
and create graphs or charts to project how much money needs to be made from various fund-raising ac-
tivities. Then, each student team creates and presents a multimedia slideshow or video to promote its
field trip idea, using maps and pictures downloaded from related websites. All class members then dis-
cuss which field trip they would most like to take and vote on the various proposals.

Ms. Alarcon says that information is growing so fast that the main problem faced by her students is
how to look at it and make judgments and decisions about it. She says her students need to know whether
information is good and how to use it appropriately. At the beginning of each school year Ms. Alarcon
presents an orientation to the Internet, explaining that information on the Internet is not always valid. She
then explains how to find reliable information on the Internet and how to evaluate its authenticity.

NEW TERMS

differentiated classroom evaluation criteria
digital library hybrid search engines
electronic journal Google
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information literacy searchable databases
invisible Web search directories
metasearch engines task-relevant knowledge
search engines virtual library

National Educational Technology
Standards for Teachers

The following NETS•T are addressed by the lesson
content and learning activities in this chapter:

I. Technology Operations and Concepts

A. Demonstrate understanding of technology
concepts and skills

B. Demonstrate continual growth in technology
knowledge and skills

V. Productivity and Professional Practice

A. Use technology for ongoing professional
development

B. Continually evaluate and reflect on professional
practice

C. Apply technology to increase productivity
D. Use technology to communicate and collaborate

VI. Social, Ethical, Legal, and Human Issues

A. Model and teach legal and ethical practice related
to technology use

B. Enable and empower diverse learners
C. Identify and use technology resources that affirm

diversity
D. Promote safe and healthy use of technology

resources
E. Facilitate equitable access to technology resources

National Educational Technology
Standards for Students

The following NETS•S are addressed by the lesson
content and learning activities in this chapter:

1. Basic Operations and Concepts
• Demonstrate sound understanding of technology
• Be proficient in the use of technology

2. Social, Ethical, and Human Issues
• Understand ethical, cultural, and societal issues

related to technology
• Practice responsible use of technology
• Develop positive attitudes toward technology

3. Technology Productivity Tools
• Use technology to enhance learning, increase

productivity, and promote creativity
• Use tools to collaborate, prepare publications,

and produce creative works

5. Technology Research Tools
• Use technology to locate, evaluate, and collect

information
• Use technology tools to process data and report

results
• Evaluate and select new information resources

and technology

OVERVIEW

Many constructive learning activities involve students collecting,compiling,comparing,and
reporting different types of information.Web-enhanced learning activities often involve in-
formation searches and the acquisition and processing of information. Both searching for
and validating information obtained from the Internet are important learning activities
when using Internet information resources.

The wealth of information available on the Web greatly broadens the scope of informa-
tion that is available to students in classrooms.There are virtual libraries and digital collec-
tions,websites for professional and standards-oriented organizations,government resources,
periodicals,newspapers,magazines and journals,books,encyclopedias,and educational con-
tent sites—all on the Web.When students are taught to use search technologies and effective
search strategies to solve problems and complete projects, they are better able to transfer
search techniques to other problem-solving contexts. Developing an information search
strategy for the classroom is the first step in addressing complex problems and issues re-
quiring critical thinking.
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Because there are no universal quality controls for publishing documents on the Inter-
net, anyone with the know-how and access rights to a Web server can publish pages on the
Web.Thus, the information published on Web pages may not have undergone the scrutiny
of peers, experts, or professionals and thus may be inaccurate.When an Internet search is
conducted, it is important for teachers and students to distinguish resources that are rele-
vant and appropriate from those that are not.

Lesson 5.1 Identifying Internet Sources of Educational Information

FOCUS QUESTIONS
■ What kinds of information resources are available on the Internet?
■ How can Internet information resources be used for educational purposes?
■ What is the invisible Web?

■ LOCATING EDUCATIONAL INFORMATION ON THE INTERNET

The information students need and use to complete project-based learning activities can
come from a number of sources, including personal experiences, books, articles, expert
opinions, encyclopedias, and the World Wide Web. One of the greatest features of the Inter-
net is that it offers students relatively inexpensive access to a wealth of information across
a vast range of fields, which can increase students efficiency in searching for information.
Indeed, information searches are the most basic function of Web use. However, the in-
creased amount of information that can be accessed requires students to become adroit at
locating appropriate sources. A variety of Internet search technologies, content-related
websites, and Web databases are available to help them.

Virtual Libraries and Digital Image Collections

A virtual library is designed to extend or simulate in a virtual space many of the services
and capabilities of brick-and-mortar libraries. Usually managed by libraries and librarians,
these virtual libraries identify electronic resources referred and reviewed by professionals,
particularly librarians.Virtual libraries filter out many of the irrelevant, personal, and corpo-
rate pages that commercial search engines produce. Although copyright and subscription
issues may limit the capability of virtual libraries to provide references to scholarly articles
and books, newspaper articles, and professional magazine pieces, many of these resources
can be acquired by academic or fee-based library or subscription services. Some examples
of virtual libraries include the following:

■ The Librarian’s Index to the Internet (http://lii.org/) is a searchable, annotated sub-
ject directory with thousands of Internet resources selected and evaluated by librar-
ians for their usefulness to users of public libraries. This index provides a
well-organized point of access for reliable and trustworthy Internet resources.

■ Infomine (http://infomine.ucr.edu/) is a virtual library of Internet resources rele-
vant to faculty, students, and research staff at the university level. It contains useful
Internet resources such as databases, electronic journals, electronic books, bulletin
boards, mailing lists, online library card catalogs, articles, directories of researchers,
and many other types of information. Infomine was built by librarians from several
colleges and universities.

■ The Internet Public Library (http://www.ipl.org) is a project of the University of
Michigan School of Information and is designed to provide students and professionals
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in the library and information science profession with a place to learn about the prac-
tice of librarianship in the digital age.Hundreds of students have been involved in de-
signing, building, creating, and maintaining this website and its various services, and
volunteer librarians throughout the world have been involved remotely in answering
reference questions.

These virtual libraries are designed to be user friendly; the records produced by basic
and advanced searches are filtered through librarian checks for authenticity, currency, and
impartiality of content.Teachers should encourage students to use virtual libraries because
of their reliability.

A digital library, digital collection, or digital image collection uses electronic-
information technologies to digitize primary source documents, assemble them into collec-
tions, and present them online. The Digital Library Federation (DLF) is a consortium of
libraries and related agencies that are pioneering the use of electronic-information tech-
nologies to extend their collections and services. The DLF promotes sustainable, scalable
digital collections and encourages the development of new collections and collection services.
The DLF website at http://www.diglib.org/ provides links to over 30 DLF partners. Some
examples of digital libraries include the following:

■ The National Science Digital Library (NSDL; http://nsdl.org) is a digital library of re-
source collections and services in support of science education at all levels.NSDL is
a comprehensive,online source for science, technology,engineering, and mathemat-
ics education. Its purpose is to extend science literacy through access to materials
and methods that reveal the nature of the physical universe and the intellectual
means by which it is discovered and understood. A partnership of NSDL-funded
projects, the NSDL is a center of innovation for digital libraries and a virtual com-
munity center for groups focused on digital-library-enabled science education.

■ The Library of Congress (http://memory.loc.gov/) features a digital library with
over 100 collections, as well as a section for teachers (i.e.,The Learning Page) that
provides lesson plans, interactive puzzles, learning games, classroom projects, and
professional development activities.

■ Exploratorium (http://www.exploratorium.edu) is a virtual museum. The bricks-
and-mortar Exploratorium is a museum of science, art, and human perception lo-
cated in San Francisco, California. In 1993 it became one of the first science
museums to build a site on the World Wide Web, which now includes more than
12,000 Web pages and many sound and video files exploring hundreds of different
topics. Many of the resources on the website are simple uses of information tech-
nology. For example, the site presents over 500 simple experiments, for which in-
structions can be viewed on any type of Web browser and easily printed out.The
website extends the educational experiences available on the museum’s floor.

Professional and Standards-Oriented Organizations

Professional and standards-oriented organizations publish curriculum standards, teaching
resources, and lesson plans on the Web.The following professional organizations cover al-
most all of the national curriculum standards in various subject areas:

■ National Council of Teachers of Mathematics (NCTM; http://illuminations.
nctm.org/) provides Internet resources to improve the teaching and learning of math-
ematics, including ready-to-use, interactive multimedia math lessons, lessons devel-
oped by expert math teachers, interactive programs to demonstrate math concepts,
video vignettes, research reports, and articles.

■ National Council for the Social Studies (http://www.socialstudies.org/) provides
teaching resources categorized by the 10 themes of the curriculum standards for so-
cial studies, lists of online classes and learning opportunities,forums to discuss social
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studies education,classroom tips,general topics related to the education of effective
citizens, listings of organizations, article citations, and resources related to social
studies education.

■ National Council of Teachers of English (NCTE; http://www.ncte.org/) provides
links to teaching ideas selected from NCTE publications or submitted directly by
teachers and organized according to ESL, journalism, literature, reading, technology,
writing, and vocabulary, as well as a forum where teachers share ideas, strategies,
problems, and solutions.The NCTE and the International Reading Association (IRA)
sponsor a website called Read•Write•Think (http://www.readwritethink.org/),
which provides educators and students with access to teaching practices and re-
sources in reading and language arts instruction, including a collection of lessons, a
description of IRA/NCTE standards,and Web resources reviewed by an expert panel
to ensure selection of the best resources for English language arts teachers.

■ American Association for the Advancement of Science (AAAS; http://www.aaas.org/)
sponsors an educational website,Science NetLinks (http://www.sciencenetlinks.org/),
which provides Internet-based learning activities for the classroom,Web resources re-
viewed by a panel of editors and supportive of standards-based teaching and learning,
and the benchmarks for science literacy established by an AAAS initiative addressing
K–12 science education.

■ National Geographic Society (http://www.nationalgeographic.com/) sponsors a
website, Xpeditions (http://www.nationalgeographic.com/xpeditions/), which
describes U.S. geography standards and provides forums to discuss geography edu-
cation, an interactive learning museum, online and off-line learning activities, and 
lesson plans written by educators and tested in the classroom. In addition, the Na-
tional Geographic Society website provides an education section (http://www.
nationalgeographic.com/education/) with lesson plans, online adventures, and on-
line mapping, including dynamic maps, atlas maps, country profiles, printable maps
with black-line masters optimized for overhead transparencies, and star charts.

■ National Council on Economic Education (NCEE; http://www.ncee.net/) sponsors
a website called EconEdLink (http://www.econedlink.org/), which provides class-
room-tested, Internet-based economics lesson materials for K–12 teachers and their
students.The materials are centered on curriculum standards and the essential prin-
ciples of economics.

National standards and examples for arts education are provided by the ArtsEdge website
(http://artsedge.kennedy-center.org/). ArtsEdge includes teaching materials focused on
national art education standards and provides K–12 teachers with curriculum units, lesson
plans, activities and other ideas for integrating the arts into classroom teaching, a directory
of instructional Web resources, and a lesson submission and exchange system.

Government Resources

Federal and state government departments and agencies publish a considerable amount of
information on the Internet.Most online government publications,books,articles, statistics,
and releases are authored by specialists and scholars and are closely reviewed by field ex-
perts. In general, teachers can encourage students to utilize electronic government re-
sources with little concern over quality or authorship.Most of these resources are available
at no charge and without subscription requirements.

The information available at specific departments or agencies is probably the most use-
ful information resource for students.For example, the U.S.government sponsors a website
with health and nutrition information at http://www.nutrition.gov/. And the National
Archives and Records Administration provides excellent history and social studies
resources, including document-based lesson plans and student research activities, in its dig-
ital classroom at http://www.archives.gov/. In addition, the U.S. Department of Justice
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sponsors a website called Justice for Kids and Youth (http://www.justice.gov/kidspage/),
which provides information on safety, substance abuse prevention, criminology, current
events, technology, science, and history.

The FirstGov for Kids website (http://www.kids.gov) is an interagency portal for chil-
dren that provides links to U.S. government children’s sites and some of the best children’s
sites from other organizations. Further, federal agencies and institutions like the National
Aeronautics and Space Administration (http://www.nasa.gov/), the Smithsonian Institutes
(http://www.si.edu/), the National Weather Service (http://www.weather.gov/), and the
U.S. Geological Survey (http://www.usgs.gov/) maintain websites that are rich in educa-
tional resources and suitable for use in developing Web-enhanced learning activities.Several
agencies, such as the Bureau of Labor Statistics at http://www.bls.gov/ and the Census Bu-
reau at http://www.census.gov/, produce student-friendly materials relevant to multiple
curriculum themes and career information.

Much of the content contained on these governmental websites can help students
obtain data and information for project-based learning activities. However, these sites also
provide numerous documents intended for an advanced audience, which may require in-
structor intervention and guidance to prevent students from becoming overwhelmed with
massive amounts of information not intended for educational purposes.

Regional Technology in Education Consortia

Regional Technology in Education Consortia (R*TECs) help states, schools, teachers, school
library and media personnel, school administrators, and other education personnel and en-
tities successfully integrate technologies into K–12 classrooms, library media centers, and
other educational settings, including adult literacy centers. The Office of Educational
Research and Improvement of the U.S. Department of Education funds 10 R*TECs
(http://www.rtec.org) to establish and conduct regional activities that address professional
development, technical assistance, and information resource dissemination to promote the
effective use of technology in education. R*TECs put special emphasis on meeting the
documented needs of educators and learners in the region they serve and foster regional
cooperation and resource sharing.They provide a number of Web tools and resources that
are useful for creating Web-enhanced learning activities.

Encyclopedias

Online encyclopedias are a good place to begin research on a topic that may be unfamiliar
to a student, especially a younger student. Some useful online encyclopedias include the
following:

■ Encyclopedia.com (http://www.encyclopedia.com/) is a good place to start a re-
search activity. It is a free Internet service that provides more than 57,000 frequently
updated articles from the Columbia Encyclopedia (sixth edition).Each article is en-
hanced with links to newspaper and magazine articles as well as pictures and maps.
Each entry is short but includes hyperlinked references to other encyclopedia arti-
cles,as well as links to periodicals and images in the fee-based e-Library. A Search En-
carta button in each article performs a related search of Encarta.

■ Encyclopedia Britannica (http://www.britannica.com/) provides free access to
condensed articles by keyword search, by browsing alphabetically, or by subject,
with access to the full text of the hard-copy Encyclopedia Britannica available only
to paying subscribers.

■ Encarta (http://encarta.msn.com/) offers thousands of articles from the CD-ROM en-
cyclopedia,hundreds of related multimedia clips,a talking dictionary,a world atlas,and
a resource for educators.The Web pages do contain a fair number of advertisements.

■ Encyclopedia Smithsonian (http://www.si.edu/resource/faq/start.htm) features
answers to frequently asked questions about the Smithsonian Institution and links to
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Smithsonian resources on subjects from art to zoology. Because there is no search
function, A-to-Z the only way to navigate is to browse through a topic listing.

■ Information Please (http://www.infoplease.com/) is an encyclopedia, dictionary,
and almanac that integrates the various Information Please Almanacs on sports,en-
tertainment, and general knowledge with Random House Webster’s College Dictio-
nary and the Columbia Encyclopedia. It can be navigated by an integrated search
function, and the almanacs can be browsed by topics.

Educational Content Sites

Educational content sites on the Internet can provide high-quality content for use in lesson
building, primarily lesson plans and curriculum resources. Some of the most popular Inter-
net content sites include the following:

■ Blue Web’n (http://www.kn.pacbell.com/wired/bluewebn/) is an online library of
hundreds of Internet sites categorized by subject, grade level, and format (i.e., les-
sons, activities, projects, resources, references, and tools).You can search by grade
level, subject area, or specific subcategories. New sites are added regularly, and you
can receive a list and description of these additions by e-mail by registering with the
website.

■ DiscoverySchool.com Lesson Plans Library (http://school.discovery.com/lessonplans/)
provides innovative teaching materials for teachers, useful and enjoyable resources
for students,and advice for parents about how to help their kids enjoy learning and ex-
cel in school.A link to Teaching Tools gives access to Puzzlemaker,Lesson Planner,Quiz
Center, and Worksheet Generator. The site is constantly reviewed for educational
relevance by practicing classroom teachers in elementary school, middle school, and
high school.

■ Education World (http://www.educationworld.com) is designed as a kind of Web
portal for educators, a place for teachers to gather and share ideas, as well as a com-
plete online resource where educators can find lesson plans and research materials.
Website resources include a search engine for educational websites only, lesson
plans, practical information for educators, information on how to integrate technol-
ogy in the classroom, articles written by education experts, website reviews, daily
features and columns, teacher and principal profiles, chats with important individu-
als in education, and employment listings.

■ Educator’s Reference Desk Lesson Plans (http://www.eduref.org/Virtual/Lessons/
index.shtml) is a collection of more than 2,000 unique lesson plans that have been
written and submitted by teachers from all over the United States and the world.

■ EduScapes (http://www.eduscapes.com) is designed to work with teachers, par-
ents,and children around the world to effectively integrate technology into teaching
and learning environments.The website includes a weekly project section that con-
tains a thematic topic with selected Web resources, ideas and activities, vocabulary,
lesson plans,WebQuests, and student-produced materials.

■ Federal Resources for Educational Excellence (FREE) (http://www.ed.gov/free/)
provides easy, one-stop access to learning resources from dozens of federal organi-
zations, including the Library of Congress, National Aeronautics and Space Adminis-
tration (NASA), National Archives and Records Administration (NARA), National
Endowment for the Humanities (NEH), National Gallery of Art, National Park
Service, National Science Foundation (NSF), Peace Corps, and Smithsonian Institu-
tion.Resources include teaching ideas, learning activities,photos,maps,primary doc-
uments, data, paintings, sound recordings, and more—on thousands of topics.

■ Gateway to Educational Materials (GEM;http://www.thegateway.org/) provides ed-
ucators with quick and easy access to thousands of educational resources found
on various federal, state, university, nonprofit, and commercial websites. GEM is a
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consortium of over 400 organizations and individuals providing substantial but un-
catalogued collections of Internet-based educational materials.

■ MarcoPolo Internet Content for the Classroom (http://www.marcopolo-education.
org/) provides high-quality educational resources for teachers and students:
lessons plans, student materials, reviewed Web resources, primary source materi-
als, interactive learning activities, and assessments. All are developed by world-
renowned organizations that are experts in their fields. MarcoPolo content covers
arts integration, economics, geography, the humanities, mathematics, reading, lan-
guage arts, and science; and all lessons are developed to support, align with, or ex-
tend national standards. Classroom-ready lesson plans and other teaching
materials make it easy to begin integrating Internet resources into the classroom.
And grade-specific research lists help teachers customize materials to teaching
style and needs.

■ PBS TeacherSource (http://www.pbs.org/teachersource/) provides educational re-
sources by curricular subject, topic, and grade level; in-depth professional develop-
ment services; tips on how to effectively teach with technology; best practices
information from other teachers; tools for teaching, such as recommended books
and websites; and much more.

Electronic and Online Journals

Electronic journals include journals,magazines,e-zines or webzines,newsletters, and any
other type of serial publication that is available on the World Wide Web. There are many
electronic journals currently available, and new ones are always being added, so it is best to
use a directory to locate electronic journals in a particular field. Many different libraries,
consortia, and organizations have developed lists and guides. Some of the better and more
comprehensive sites with directories of electronic journals are listed here:

■ Electronic Journal Miner (http://ejournal.coalliance.org/) is sponsored by the Col-
orado Alliance of Research Libraries. This site includes primarily e-journal sites as
they are offered by the publishers, accessed through a series of indexes. No evalua-
tion of the titles is provided, but a unit record that gives some information about
scope and content must be viewed before launching to a title of interest. New titles
are added as they are discovered.

■ New Jour:Electronic Journals & Newsletters (http://gort.ucsd.edu/newjour/) is the
Web archive of the New Jour discussion list for new journals and newsletters avail-
able on the Internet.The website provides a daily listing of new serial publications.
This website is located at the University of California, San Diego but is actually a col-
laborative effort of many librarians at different institutions.

■ University of Pennsylvania Library E-Resources (http://www.library.upenn.edu/
and then select E-Resources � È-Journals) allows a search of electronic journals by
title and more than 70 broad subject categories. It also has a listing of newspapers
and other electronic journal sites.

Searchable Databases

Searchable databases are useful for organizing large amounts of disparate information;
most search engines like Google contain searchable databases. For many of these databases
the search results are dynamically generated and then virtually delivered in Web pages as-
sociated with a specific search.Such pages are not stored anywhere because it is easier and
cheaper to generate the answer page for each query than to store all the possible pages con-
taining all the possible answers to all the possible queries.

The visible Web refers to the links listed on the results pages from general search en-
gines and in directories. The ➞ invisible Web refers to what is not returned with the
search results, that is, the contents of thousands of specialized searchable databases.You can
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find searchable databases and other invisible Web content in the course of
routine searching in most Web directories:

■ Direct Search (http://www.freepint.com/gary/direct.htm) consists
of several long pages listing and describing searchable databases on

many academic topics.

■ Profusion (http://www.profusion.com/) from Intelliseek is a Yahoo-
like directory with a large collection of searchable databases, including many aca-

demic subjects. It is a high-quality, human-edited and indexed collection of highly
targeted databases that contain specific answers to specific questions.

■ The Big Hub (http://www.thebighub.com/) maintains a directory of over 1,500 subject-
specific searchable databases in over 300 categories. Listings for each database feature
both annotations and search forms to directly access the database. However, these
search forms do not include most advanced searching features offered by each database
on its own site.

■ Web Lens (http://www.weblens.org/invisible.html) provides a collection of re-
search tools for mining the invisible Web.

Go
to the Companion Website

and browse Chapter 5 Lesson Links:

The Invisible Web to learn more
about this topic.

Building Your Toolkit:
Building a Classroom List of Educational Resources on the Internet

Go
to the Companion Website

and browse 5.1 Building Your Toolkit

Enrichment Activity: U.S. Government and

R*TEC Online Resources. Use the Web
resources listed in the enrichment activity

to create learning activities that specify
information resources on the

Internet.

Go
to the Companion

Website and browse 5.1 Project

Sample: Planning a Research Project

Using an Online Encyclopedia. Use the
project sample as the foundation for a
learning activity that builds skills for
conducting Internet-based research.

Adapt the project sample to the
subject area and/or grade level 

that you teach.

You should start building a list of Internet resources that are appropriate for the grade level and/or subject you teach. You can
create your list by browsing through the Internet resources that were discussed in this lesson; and if a particular resource (or
some part of it) seems appropriate for use in your classroom, you can include the title, URL, and a short description on your list.

STEP PROCEDURE

1. Open your Web browser and browse through several of the Internet resources discussed in this lesson.
2. A virtual library: Librarian’s Index to the Internet at http://lii.org/.
3. A digital library: National Science Digital Library at http://nsdl.org/.
4. A virtual museum: Exploratorium at http://www.exploratorium.edu/.
5. Curriculum standards: National Geographic Society Xpeditions at

http://www.nationalgeographic.com/xpeditions/.
6. Government resources: FirstGov for Kids Web at http://www.kids.gov.
7. Regional Technology in Education Consortia: High Plains R*TEC at http://www.hprtec.org/.
8. Online encyclopedia: Encyclopedia.com at http://www.encyclopedia.com/.
9. Educational content: Gateway to Educational Materials at http://www.thegateway.org/.

10. Online journals: Electronic Journal Miner at http://ejournal.coalliance.org/.
11. Searchable databases: The Big Hub at http://www.thebighub.com/.
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Lesson 5.2 Searching for and Researching Information on the Internet

FOCUS QUESTIONS
■ What types of search engines are available to search the Internet,and how are they used?
■ What are the advantages of using Google as a search engine in the classroom?
■ How are Internet search engines used as part of a general research strategy?

■ USING COMMERCIAL SEARCH ENGINES

Commercial search engines are usually employed to support project-based learning activi-
ties. To perform productive searches, teachers and students should be skilled in using
search engines effectively. Internet searches can be as much about eliminating inappropri-
ate sources as about locating appropriate ones. Well-known, commercially backed search
engines are usually the best choice because they are more likely to be well-maintained and
upgraded, producing more dependable results.And because search engines do not cover
every Web page published on the Internet, you should use more than one. The website
SearchEngineWatch.com (http://www.searchenginewatch.com/) provides an online
guide to the major search engines.

Search engines are most useful when you first begin a research task.The main rule to
remember is that it is important to be specific because of the vast quantity of information
available. You usually go through several trials to refine your search for more specific and
appropriate information.

Types of Search Engines

Search engines have a variety of ways to refine and control searches. Some use menu sys-
tems, whereas others require special commands as part of the query; some use a

combination of approaches. Some search engines provide filtering settings to
control searches; children’s search engines can filter results and/or search

criteria. As a consequence of the ➞ Children’s Internet Protection Act,
most public schools run filters that prevent students from accessing in-
appropriate links as the result of a search. Because there are numerous

Internet search engines and various ways in which they perform searches,
it is important to understand how they work.

Search Directories

Search directories are hierarchical databases with references to websites. The websites
that are included are handpicked by real people and classified according to the rules of that
particular search service.Yahoo! is an example of a search directory. Directories are useful
when you have only a general idea about how to search.The first page normally gives you
the most general categories, and then you click down through the hierarchy to the appro-
priate category and select a website. If you use the search form with a search directory, you
are not searching the text of actual Web pages but are searching the text of the site title and
the site description, as composed by the directory editors. Most directories also search the
words contained in category titles and descriptions.

Search Engines

Search engines use programs that crawl, or spider, the Web. The spider visits a Web
page, reads the information in it, and then follows links to other pages within that site.

Go
to the Companion 

Website and browse Chapter 5

Lesson Links: Children’s Internet

Protection Act to learn more 
about this topic.
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The spider returns to each website periodically to look for changes.Everything the spider
finds goes into a catalog, or index. Much like the index of a book, the search index con-
tains a reference to every Web page the spider finds. If a Web page changes, the index is
updated with new information. Search engines then examine the millions of pages refer-
enced in the index to find matches to the search subject and rank them by relevancy.
Search engines should be your first choice when you know how to search for your topic
because they cover a much larger part of the Web than do the directories.

Hybrid Search Engines

Hybrid search engines use both crawler-based results and human-powered listings.The
distinction between search engines and search directories is not always clear because all
the major search directories provide results from a search engine if they cannot find the
subject in their own directory. For example,Yahoo! uses the search engine Google for this
purpose. Hybrid search engines may provide information from search directories before
data from the search engine’s database and may even favor one type of listing over another.
For example, MSN Search is more likely to present human-powered listings although it also
presents crawler-based results.

Metasearch Engines

Metasearch engines search several search engines and directories at the same time and
extract the most relevant hits, or results, from all of them.Metasearch engines are useful for
gaining a general understanding of what information is available on a topic. Examples of
metasearch engines are Vivisimo (http://vivisimo.com) and Ixquick (http://www.ixquick.
com). Sherlock is a metasearch engine on Macintosh.For complex searches you should use
the relevant search engine because metasearch engines provide only a small number of
the results from each individual search engine. Metasearch engines send queries to multi-
ple search engines and other data sources and then collate the results and format them to-
gether into a single hit list for display. (Metasearch engines do not search Google.) The data
sources used by metasearch engines may include internal indexes, associated-text search
engines, database search engines, message archives, and Web search engines. Like single
search engines,metasearch engines generate lists of documents that must be evaluated,but
they do provide a quick way to determine which engines are retrieving the best results for
a search.

Searches with Google

Google (http://www.google.com) is a widely used search engine that provides depend-
able search results and will be used for many of the examples in this textbook.Google ranks
Web pages based on algorithms that examine the entire link structure of the Web and de-
termine the importance of a Web page based on which other Web pages link to it and how
often. Google then determines which pages are relevant to the specific search being con-
ducted.Although Google runs related ads above and next to its results, it does not sell place-
ment within the results themselves; thus, no one can buy a higher page ranking. Google
searches are an easy, honest, and objective way to find websites with information relevant
to a specific search.

To learn more about Google features,services,and tools,browse the following pages on
the Google site:

■ Google Web search features at http://www.google.com/help/features.html

■ Benefits of a Google search at http://www.google.com/technology/whyuse.html

■ Google services and tools at http://www.google.com/options/index.html
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Building Your Toolkit:
Search Engine Basics

The following exercise demonstrates techniques that increase the precision of search criteria to produce more relevant and
useful search results with Google.

STEP PROCEDURE

1. Open your Web browser and then the Google search engine at http://www.google.com. A Web page
similar to that shown in Figure 5–1 should be displayed.

2. The plus (�) symbol is useful when you do a search and are overwhelmed with information. To ensure that a
search engine finds pages that contain all the keywords you enter, use the � symbol. For example, to find infor-
mation about the English colonization of North America, enter Pilgrims and notice that you obtain more than
a half-million hits. To refine your search by locating references to both Pilgrims and Plymouth, enter �Pilgrims
�Plymouth, using a space before the plus sign (case does not matter). Because the number of results is still
substantial, try to refine your search further by entering �Pilgrims �Plymouth �Mayflower.
NOTE: Google ignores common words and characters such as where and how and certain single digits and single letters that
can slow down a search without improving the results. Google indicates such an exclusion by displaying details on the results
page below the search box. If a common word is essential to a search, you should put a � in front of it. Another method is
to conduct a phrase search by putting quotation marks around two or more words (see Step 4).

3. The minus (�) symbol is also useful when you get too many hits that are unrelated to your topic. To ensure that a
search engine finds pages that contain one keyword but not another, use the � symbol. To find information about
the pilgrims in relation to the colonization of American, enter �pilgrims �pilgrimage, again using a space before
the minus sign. Continue to subtract terms until you get better results. Most major search engines allow you to ex-
clude certain words to narrow a search. If you want to locate information about Baron Manfred von Richthofen,
Germany’s greatest WWI fighter pilot, but do not know his name or even how to spell it, enter red baron. Your
hit list includes references to a well-known comic strip, so enter red baron –peanuts –snoopy. Your hit list still
includes many irrelevant hits, so enter red baron –peanuts –snoopy –game –pizza –motorcycle.

4. A phrase search is a good way to obtain specific results, words enclosed in double quotation marks appear to-
gether in all results. Phrase searches are especially useful when searching for famous sayings or proper names
(e.g., “to be or not to be”). Enter “Pilgrims at Plymouth” to locate pages about the settlement of Plymouth
by the English colonists.

(Continued)

FIGURE 5–1: Google Search Screen
Source: Retrieved September 30, 2003, from http://www.google.com. Reproduced with permission.
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■ USING RESEARCH STRATEGIES

Information that is relevant to a learning task can have a direct effect on search perform-
ance (Spilker & Barrick, 2001); therefore, teachers may need to advocate different research
strategies for different learning tasks. The San Diego State University (SDSU) library and
information-access website suggests the following strategy to provide a benchmark for
teaching search and research techniques to students. This resource is located at http://
infodome.sdsu.edu/research/guides/strategy.shtml.

1. Analyze your research problem. What do you need to know about the topic of your
research? What do you already know about this topic? What do you need to learn
about the topic?

2. Determine your information requirements. What types of information do you
need to find—brief or thorough, scholarly or popular, factual or descriptive, histori-
cal or current, primary or secondary?

3. Identify your information source needs. What sources of information do you need
to search—books, periodical articles,Web documents? What library resources will
help you fulfill your information needs? Are these resources accessible electronically
or in print or both?

4. Conduct your information search. Translate your research topic into phrases or
keywords. Gather relevant information using appropriate resources.

5. Critically interpret, evaluate, and synthesize your information search results.
Conduct additional information searches if necessary.

You can adapt this research strategy to your own classroom by focusing or broadening its
scope to support a specific learning activity in a way that is appropriate for your specific
grade level or subject matter.

Researchers have provided insight into factors influencing the search process that ulti-
mately affect decisions. For example, Spilker and Barrick (2001) considered the effects of
task-relevant knowledge and decision aids. They maintained that task-relevant knowl-
edge affects the search strategy, which affects search performance. Specifically, they ana-
lyzed the extent to which decision makers implemented directed search strategies
(searching for specific information) and sequential search strategies (searching available
data according to its presentation order).The researchers found that in an unaided search
more knowledgeable subjects implemented more directed search strategies than less
knowledgeable subjects did. They also concluded that the presence of a keyword(s)

Building Your Toolkit:
Search Engine Basics (Continued)

STEP PROCEDURE
5. Once you have mastered adding, subtracting, and “multiplying,” you

can combine symbols to easily create targeted searches. For ex-
ample, the Red Baron search would be better conducted as a
phrase search. Enter “red baron” and then combine it
with other search criteria, using both addition and subtrac-
tion. Enter each of the following terms, one at a time, and
check the number of hits as you include each term: “red
baron” –peanuts –snoopy –game –pizza –motor-
cycle �war.

Go
to the Companion 

Website and browse 5.2 Building 

Your Toolkit Enrichment Activity: Google

Advanced Search Features. Practice the 
skills presented in the enrichment activity 

to perform advanced searches 
with Google.
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helped less knowledgeable subjects locate relevant resources to a greater extent than it
helped more knowledgeable subjects.

In planning Web-enhanced learning projects, Ms. Alarcon takes into ac-
count the search strategies that students will use. Understanding the influ-

ence of search strategy on search performance is not only important in
improving the efficiency and effectiveness of search processes,but it also
allows teachers to support students at their varied points of readiness to

learn.In ➞ differentiated classrooms teachers can provide mechanisms
that allow students at multiple knowledge levels to optimize their search for

relevant information and thus their achievement of learning objectives.

Go
to the Companion

Website and browse Chapter 5

Lesson Links: Differentiated

Classrooms to learn more
about this topic.

Building Your Toolkit:
An Online Research Strategy

It is important to establish a procedure for conducting Internet searches that is appropriate for the grade level and subject
you teach. You may want to present a lesson about searching. The library at the University of California, Berkeley provides
an online tutorial that features the latest searching strategies and tools.

STEP PROCEDURE

1. Open your Web browser and then the University of California, Berkeley library tutorial. “Finding Information on
the Internet” at http://www.lib.berkeley.edu/TeachingLib/Guides/Internet/FindInfo.html.

2. On the tutorial page browse each of the following topics:
• Things To Know before you begin searching. . . .
• Recommended Search Strategy: Analyze Your

Topic & Search with Peripheral Vision
• Three Families or Types of Search Tools

3. Choose a topic such as a hobby or an interest to use for
an Internet search.

4. Open the Recommended Search Engines and Recom-
mended Directories at http://www.lib.berkeley.edu/
Help/search.html. Use the search engines and directories
to conduct a comprehensive search of your topic.

Go
to the Companion Website

and browse 5.2 Building Your Toolkit

Enrichment Activity: Developing a

Comprehensive Research Strategy. Practice
the skills presented in the enrichment
activity to develop a comprehensive

search strategy for your
classroom.

Lesson 5.3 Evaluating the Quality of Internet Information

FOCUS QUESTIONS
■ What criteria are used to evaluate the quality and credibility of websites?
■ How can a URL be examined to provide information about the quality and credibility of

a website?
■ What procedure should be used to evaluate websites?

■ A SOURCE OF GOOD AND BAD INFORMATION

While two middle-school students were researching the Holocaust together as part of a unit on World
War II, they located information on the Internet that contradicted their textbooks’ and their teacher’s
versions of events. A website claimed that Nazis had not really murdered millions of Jews, as falsely
reported elsewhere. The students also read on the website that these false reports were the result of
a worldwide conspiracy, and the website listed numerous national governments, religions, industries,

�
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and ethnic groups that were participating in this conspiracy. The students began to think that their
teacher and the school might be part of the conspiracy and, at first, were afraid to ask about their new
information. In this case a website not only misinformed these students but generated mistrust and
suspicion as well.

Information searches on the Web are essential to Web-enhanced learning activities.
Unfortunately, the wealth of information on the Internet presents teachers and students
with the enormous challenge of determining when information is accurate and credible
and when it is incorrect and unreliable. Students can participate safely in the many bene-
fits of the Internet if they are taught to protect themselves from misinformation. Thus,
the evaluation of information published on the Web is an important aspect of information
collection.

Unlike information published in textbooks and journals,which have usually undergone
a rigorous procedure called peer review, the information published on Web pages may not
have been subjected to the scrutiny of anyone knowledgeable of the topic. There are no
universal quality controls for Internet publication. Consequently, a person browsing a par-
ticular Web page who is unfamiliar with the content presented may have difficulty distin-
guishing between accurate and inaccurate, reliable and questionable,current and outdated,
or authoritative and fallacious information.

■ STRATEGIES FOR EVALUATING INFORMATION QUALITY

The evaluation of websites is an important skill for both teachers and students.Not only do
they need to find information on the Internet, but they also need to utilize it appropriately
and effectively. Both teachers and students should learn to judge the value of any facts, fig-
ures, reports, or other information found on the Internet, much as they evaluate what they
hear on the radio, see on television, or read in newspapers and books.

Although there is no single set of criteria to be applied to Internet information, the
evaluation criteria of accuracy, authority, objectivity, currency, and coverage that are ap-
plied to other media can also apply to the Internet. Appropriate evaluation criteria also de-
pend on the needs of the user and the purposes of the information.For example,the criteria
applied by researchers to online articles used in scholarly research would differ from the
criteria applied by a librarian developing a subject guide or a teacher developing a lesson
plan.There can even be differences in the evaluation criteria applied by elementary and sec-
ondary classrooms.Kathy Schrock’s Guide for Educators provides evaluation guides for ele-
mentary-, middle-, and high-school levels (http://school.discovery.com/schrockguide/
eval.html).

Alan November (2001) contends that an examination of the uniform resource loca-
tor (URL) can be the first step in determining whether an online resource is credible.
Much can be learned from deconstructing a URL into its component parts, removing one
element at a time from right to left.Thus, students should be taught the general structure
of URLs, which are composed of words separated by dots (.) and slashes (/ ). Table 5–1
describes the component parts of the URL just presented for Kathy Schrock’s evaluation
guides.

Once credible URLs have been identified, further evaluation is still necessary. The Web
document and the home page of the website publishing it should be evaluated using one of
several protocols or procedures. November (2001) recommends the following plan:

1. Examine the structure of the URL, and know how different search engines order
their results.

2. Identify the sponsor of the website,and/or investigate the credentials of the website
author.

3. Determine the purpose of the website,whether to present objective information,or
to advocate for a cause or an issue.
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Building Your Toolkit:
Evaluating a Website

Kathy Schrock’s Guide for Educators (http://school.discovery.com/schrockguide) is a website started in June, 1995, to help
teachers identify curriculum-related Web resources to enhance teaching and learning in the classroom. In 1999 Schrock
partnered with Discovery Channel School to provide a well-rounded and robust site. Schrock is the technology adminis-
trator of the Nauset Public Schools in Orleans, Massachusetts, but is well known for her website, which provides tools and
advice for integrating technology in the classroom. In the following exercise you will use some of Kathy Schrock’s tools for
evaluating websites.

STEP PROCEDURE

1. Open your Web browser and then Kathy Schrock’s home page at http://www.KathySchrock.net.
2. Click on the Support for Presentations tab, and on the next page select the text link that says Web 

Evaluation to open The ABC’s of Website Evaluation page (http://www.kathyschrock.net/abceval/ ).
3. In the bulleted list after the first paragraph, click on the link to Classroom Connect (or Updated 7/15/02

for the most recent version). Read (or print and read) “The ABC’s of Website Evaluation” article. Go Back to
The ABC’s of Website Evaluation home page.

4. The sites listed below the bulleted list are useful for viewing pages with a specific critical purpose in mind. Several
questions are asked about each site to cause you to reflect on the appropriateness of the website. If available, work
with a partner or a small group, click the links to some of the sites, and answer the questions about the sites.

5. In the bulleted list after the first paragraph, click on Links to critical evaluation sheets and other articles, 
and then click on the Critical Evaluation Survey for the grade level you teach (HTML or PDF version).
Review and print the evaluation survey. Go Back to The ABC’s of Website Evaluation home page.

(Continued)

The evaluation of websites is important in determining the authority, authenticity, and
applicability of information located on the Internet.You should adopt, adapt, or develop an
evaluation procedure that is appropriate for the grade level that you teach and that your stu-
dents can use easily as part of their Internet research strategy.

TABLE 5–1 The Components of the URL for Kathy Schrock’s
Evaluation Guides—http://school.discovery.com/
schrockguide/eval.html—Deconstructed from
Right to Left

Component Description

eval.html The name of the Web page, or file, containing the evaluation guides
(html is the file name extension)

shrockguide The name of the folder containing the Web pages 

com The domain, or Internet classification, of this website (com suggests
a commercial enterprise)

discovery The name of the primary Web server for the domain (similar to a
family’s last name)

school The name of a secondary Web server or a location on a Web
server (similar to the first name of a family member)

www Indicates a location on the World Wide Web (included in some
URLs but not in others, like this one)

http Indicates the protocol the browser will use to load the Web page
(most modern versions of browsers default to http)
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assignment schedules) and a list of the kinds of information that would be appropriate
for static Web pages.As you create these two lists, remember that the information
contained in the databases (i.e., the invisible Web) would not be found by search en-
gines, whereas the information on static pages would be.

■ Differentiated Classrooms. Write a short position paper on one or more of the fol-
lowing issues related to the role of technology in differentiating instruction in the
classroom:

• Is differentiating instruction feasible in the typical one-teacher classroom? Why or
why not?

• In what ways can technology support differentiated classrooms?

• What roles do intelligence, meaning, and challenge play in differentiating instruc-
tion in the classroom?

Set 2: Expanding Your Skills

Advanced Searching Techniques. You can increase the power and accuracy of a search
by including some operations that refine the searching capability of your keywords.

Step Procedure

1. One of the powerful features of a search engine is the ability to control which sites
are included in or excluded from a search. If you want to limit your search to a par-
ticular website, you can use Google to search only that domain by using the site
command. For example, if you wanted to prepare a lesson on nutrition, you might
want to see all the pages on the U.S. Department of Agriculture website that refer-
ence the word nutrition. You could enter nutrition site:www.usda.gov.
NOTE: There is no space between site: and the domain.

You could also place the search criteria at the end of the search command:
site:www.usda.gov nutrition.

To obtain all pages about nutrition from any U.S. government website, you
would enter nutrition site:gov.

You can also use the plus (�) and minus (�) symbols to further refine your search.
For example, to search the USDA website for the food guide pyramid for children only,
you would enter �children �adults site:www.usda.gov “food guide pyramid”.
NOTE:You can place the search criteria at either end of the search command or at both.

2. Several search engines offer the ability to search within the text of a URL. If you start
a search with inurl:, Google will restrict the results to those pages with the search
criteria in the URL. For example, to find any Web page that contains nutrition in the
URL, you should enter inurl:nutrition.

If you start a search with allinurl:, Google will restrict the results to pages con-
taining those words in the URL. For example, to find Web pages with the words
nutrition and children in the URL, you should enter allinurl:nutrition/children.
NOTE: Use a slash between the search criteria. Google will return results with the
search criteria in any order in the URL. In this example the search could return Web
pages with URLs in which children comes before nutrition.

3. You can search for variations of words using a wildcard character,which is useful when
you do not know the spelling of a word. The asterisk (*) symbol is used as the wildcard
symbol in most major search engines. For example, to find Web pages that have
nutrition and child or children on the Web page,you would enter �nutrition �child*.

4. Boolean search commands are also useful for refining a search. The Boolean OR
command is used to allow any of the specified search terms to be present on the
Web pages listed in the results. Some search engines perform an OR search by de-
fault. Google supports the use of the OR operator if you include an uppercase OR
between search criteria.To locate pages with either nutrition or healthy on the Web
page, you should enter nutrition OR healthy.
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Step Procedure

The Boolean AND command is used to require that all search terms be present
on the Web pages listed in the results. For example, to retrieve pages that contain
both nutrition and healthy on the Web page, you should enter nutrition AND
healthy.
NOTE: Some search engines such as Google perform an AND search by default so
that you obtain the same results by entering �nutrition �healthy or simply
nutrition healthy as the search criteria.

The Boolean NOT command is used to require that a keyword not be present on
Web pages listed in the results.The NOT operator is the same as an exclude search.
You would use the command like this: nutrition children NOT adult.
NOTE: You could accomplish the same search by entering �nutrition �children
–adult. The plus, minus, and phrase searches you learned earlier in this chapter pro-
vide most of the same basic functionality as Boolean commands and are also sup-
ported by all the major search engines.

5. Nesting allows you to build a complex search by using parentheses. For example, to
search for Web pages containing nutrition and either fast food, junk food, or snack
food on the Web page, you should enter nutrition AND (“fast food” OR “junk
food” OR “snack food”).

Set 3: Using Productivity and Web-Authoring Tools

■ Develop a Research Strategy. Use a graphic organizer program such as Inspiration
to create a research protocol that can be used by students in your classroom for col-
lecting and evaluating Internet resources.

■ Develop a Web Evaluation Tool. From Kathy Schrock’s Guide for Educators
(http://school.discovery.com/schrockguide/eval.html), download the document
version of the evaluation survey that is appropriate for the grade level you teach,and
modify it for use in your classroom.

Set 4: Creating Your Own Web-Enhanced Lesson

■ A Project for Internet Searching and Researching. When designing WEL lesson plans,
you should perform the procedures specified in the lesson plan prior to using it in the
classroom.The following WEL lesson plan uses the Berkeley library Web tools and re-
sources presented earlier in this chapter,as well as other search tools and resources,to
identify an Internet search strategy. Use this WEL lesson plan as an example for devel-
oping your own project lesson plan for searching and researching strategies.

Title Topic Simply Searching the Internet

Problem task Productive searches require an established search procedure using
efficient and effective search strategies and appropriate Internet and
Web resources.

Curriculum area Information technology

Grade level 6–12

Standards of learning ISTE NETS•S:Technology research tools

• Students use technology to locate, evaluate, and collect
information from a variety of sources.

• Students use technology tools to process data and report results.

• Students evaluate and select new information resources and
technological innovations based on the appropriateness for
specific tasks.
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Title Topic Simply Searching the Internet

Objectives Students will

• use basic and advanced features of common search engines

• identify different types of search engines and explain how they
work

• develop effective and efficient Internet search strategies

• locate appropriate Internet and Web information resources

Background Because the Internet and the Web allow for relatively inexpen-
information sive access to large volumes of information, it is important to become

skillful and efficient in locating appropriate sources of information.
A variety of Internet search technologies, content-related websites,
and Web databases are available to facilitate searches. Commercial
search engines also provide a useful and practical means of locating
information.

Scenario Students will conduct a Web search of a hobby or an interest, answer-
ing the following questions as they conduct their search:

Which search engine(s) did you use?

What keywords did you use to find your information?

What other resources or tools did you discover or use for your search?

Procedures 1. Students should individually complete the following online tutori-
als and exercises:

• “What Is the Internet, the World Wide Web, and Netscape?”

• “Things to Know Before You Begin Searching”

• “Noodle Tools: Choose the Best Search Strategy for Your Infor-
mation Need”

2. In small groups students should use the resource “Recommended
Search Strategy: Analyze Your Topic & Search with Peripheral Vi-
sion” to conduct their search of a hobby or an interest. Each group
should keep a record or notes of its search strategy, including key-
words, search results, and resources.

3. Each small group should create a graphic organizer representing
the steps of the search process it used and should then present it
to the whole class.

4. The class should select the best graphic organizer (or should syn-
thesize all into one) and should then develop a high-quality version
to be posted in the classroom.

Resources • “What Is the Internet, the World Wide Web and Netscape?” from
http://www.lib.berkeley.edu/TeachingLib/Guides/Internet/
WhatIs.html

• “Things to Know Before You Begin Searching” from
http://www.lib.berkeley.edu/TeachingLib/Guides/Internet/
ThingsToKnow.html

• “Noodle Tools: Choose the Best Search Strategy for Your
Information Needs” from http://www.noodletools.com/debble/
literacies/information/5locate/adviceengine.html

• “Recommended Search Strategy:Analyze Your Topic & Search with
Peripheral Vision” from http://www.lib.berkeley.edu/Help/search.
html

Teaching learning • Uses individual, small-group, and whole-class learning 
strategies activities

• Uses several Internet search engines and information resources
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Title Topic Simply Searching the Internet

Assessment • A written record of search engines, keywords, results, and re-
sources used

• Participation in small-group and class discussions about search
strategies and techniques

• A graphic representation of effective search strategies (developed
in small groups)

■ WEL Lesson Plans. Expand one of the project samples presented on the Companion
Website for this chapter—Planning a Research Project Using an Online Encyclope-
dia or Just Because It’s on the Internet Doesn’t Mean It’s True: Critically Evaluating
Web Pages—into a WEL lesson plan that is appropriate for the grade level and/or
subject that you teach.
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A
adware: A type of malicious code that displays
unsolicited advertising on your computer.

anti-virus software: Computer software
designed to block malicious programs, code,
and software (called viruses or malware) from
your computer.

B
blog: A diary or personal journal posted on a
Web site, usually updated frequently. A blog
may be set as private or available to be viewed
by the general public.

bots: Computer programs that automatically
perform repetitive tasks, such as searching
through Web sites or indexing information.

browser: Software, such as Firefox, Safari, and
Internet Explorer, used to navigate and search
the Internet. Most browsers have several secu-
rity and privacy settings built in.

buddies (buddy list): A list of friends you
interact with online through various services
such as instant messaging.

buddy search: When two (or more) Internet
users search the Web together; both users see
the search results at the same time.
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C
chat room: An online site used for socializing with others, usually
based on a topic or theme.

content filter: A program that allows you to block certain types of con-
tent from being displayed on your computer screen. Some of the things
you can screen for include coarse language, nudity, sex, and violence. In
addition, many Internet browsers have parental controls to help protect
your grandchildren from stumbling onto inappropriate sites. You can
often choose separate levels of security for yourself and each child
based on ages and maturity levels.

cookie: A small piece of code that is downloaded to computers to keep
track of the user’s activities or preferences. Cookies may simply help a
site enhance it’s service for consumers, or may be used by criminals to
track personal information.

cybercriminals: People who commit criminal activity that targets 
computers — or people who leverage computers and online informa-
tion to find real-world victims.

cybersex: Also called computer sex, Net sex, and hot chat. People can have
virtual sexual encounters through text, images, voice, and/or video.

D
discussion board: Also called Internet forums, message boards, and bul-
letin boards. This feature of some Web sites allows users to post com-
ments on a particular topic and respond to each other.

download: Transfer of material from a server or remote computer to
your computer, mobile device, or game console.

E
e-mail: A message initiated in an e-mail program, such as Outlook, that
is sent to another e-mail user electronically via the Internet.
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e-mail signature: A block of text added to the end of e-mail messages,
usually automatically. A signature might contain your full name, your
job description, location, phone number, and an inspirational quote.

emoticons: Small graphic symbols (such as smiley faces) used to indi-
cate emotional state, opinion, or response. Emoticons are useful when
no body language provides clues to feelings.

F
file sharing: The ability to store files either in a central place that one
or more people can share. Files can be stored on the Internet or on any
computer that provides access to other computers. File sharing allows
those who have permission to access shared files to modify or down-
load them.

firewall: A security system, usually made up of hardware and software,
that is used to block hackers, viruses, and other malicious threats to
your computer. It is delivered through a network such as the Internet.
Installing or activating a firewall feature on your computer is one of the
most important actions you can take to help protect your computer and
information.

for-pay items (winks, avatars): Low-cost add-on products that allow
users to customize their experiences on cell phones or other instant
messaging devices. These may be cartoon-like images (called avatars) or
animated cartoons (called winks) that you receive or send to others.

G
game console: A machine that is specifically designed for playing video
games (although it might also play movies), often hooked up to a TV
or computer monitor for viewing. Not all game consoles are capable of
Internet connections, but if they are connected, they allow users to play
games with others remotely.

gamer tag: The nickname that a user is identified by when playing
interactive games.
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gaming: Playing or participating in online games.

grooming: The systematic way in which sexual or financial predators
manipulate their victims into trusting and depending on them. Sexual
predators groom with the goal of meeting a contact in person.
Grooming usually involves invoking sympathy, using subtle techniques
to alienate the victim from others, and flattery. Grooming might also
involve money or gifts.

GSM (Global System for Mobile communications): A digital cellular
telephone technology. This system is used mainly in Europe, Australia,
and the Middle East, and it is now becoming popular in the United
States.

H 
handle: (as in blog handle) A nickname that an Internet user chooses to
display to others online.

I
identity theft (ID theft): Stealing someone’s identity in order to imper-
sonate him/her, usually for financial gain.

instant messaging: A real-time, text-based communication used on
desktop computers, cell phones, and other devices to send short mes-
sages between individuals.

interactive gaming: The act of playing games online, interacting with
other players. The term covers a broad spectrum of activities, from chil-
dren’s games to online gambling.

Internet: The large network of computer servers that host and enable
the transmission of information via computer connections.
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K
keystroke logging: A legitimate way for software developers to under-
stand what is happening as they write code. This technique is also used
to track a user’s activities online to either monitor or spy on (depend-
ing on motivations) what users type and which sites they visit. This
type of program can also be downloaded onto your computer without
your knowledge by a cybercriminal, who then can gain information
about your online activities and even steal your account numbers and
passwords.

L
location application: A program that enables you to locate anybody
logged onto the Internet physically using a variety of devices (such as a
cell phone).

M
malware: Malicious software. This includes any type of harmful code
(Trojans, worms, spyware, adware, and so on) that infiltrates a com-
puter without the user’s consent. Malware is designed to damage a
computer, collect information, or allow the computer to be taken over
and used remotely to send spam.

Multimedia Messaging Services (MMS): A method for sending mes-
sages that may include audio, video, or images from mobile phones.

mobile computing: Use of a portable device that provides computer
functions and can usually connect to the Internet when such access is
available.
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P
parental controls: Products or services that offer options to parents
and other caregivers to help restrict their child’s experiences with media
or filter media content. These restrictions are currently applied to televi-
sion services, computer and video games, and Internet access.

peer-to-peer: A method of sharing files directly over the Internet from
one Internet-enabled device to another (computer, mobile phone, and
so on). This is often done with music files, for example, which might
violate copyright laws if the people involved make copies of the mate-
rial without permission.

persona: The person an Internet user chooses to appear to be, rather
than using his true identity. For example, a 65-year-old man might
assume the persona of a 12-year-old girl to meet other 12-year-old girls
on a social networking site.

personal digital assistant (PDA): A small, handheld computing device
typically used to track appointments, contacts, and e-mail.

phishing: The practice of scamming someone into divulging confiden-
tial information that she normally would not provide to a stranger. The
lure is typically via e-mail that brings the user to a scam Web site. The
purpose of phishing is to gather information needed to steal a victim’s
money or identity.

posting: Uploading information to the Web.

predator: Anyone who preys on others.

R
remote access: The ability to access somebody’s computer from
another location. Remote access is often used in technical support as a
way to fix problems, as it provides full access to the information stored
on the computer through a data link.

➟352

Using the Internet Safely For Seniors For Dummies

24_457450-bgloss.qxp  2/26/09  11:08 PM  Page 352

AMEL
Text Box

AMEL
Text Box
116



S
scam: To con, cheat, trick, swindle, sting, or rip off others. Online
scams may take the form of deceptive e-mails or other communications
via instant messaging, blog comments, and so on, designed to part you
from your money or identity.

search engine: An Internet service that allows you to search for infor-
mation and documents on the Web.

smart phone: A handheld device that incorporates features of a mobile
phone, with PDA functions such as a calendar or contact database.
Smartphones allow you to install additional features.

SMS (Short Message Service): A form of text messaging used on cell
phones, sometimes used between computers and cell phones.

social networking: A category of Internet applications used to help
connect friends, business associates, or others using a variety of com-
munication tools.

spam: Unsolicited e-mail messages that attempt to sell you something.
Also known as junk e-mail.

spim: Spam sent via instant messages.

splog: Spam sent via blogs.

spyware: Software that collects information about you without your
knowledge or consent and sends it back to whoever wrote the spyware
program. Spyware might look for your bank account numbers, personal
information, and so on. Spyware is illegal and pervasive.

Subscriber Identity Module (SIM card): A small card used in most cell
phones that holds your identity, authentication, address book, and so on.

surfing: Similar to channel surfing on television, Internet surfing
involves users browsing around various Web sites, following whatever
interests them.
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T
text messaging: A method of sending short messages (also called
SMSes, texts, or texting) between mobile phones, other computing
devices, and even some landline phones.

U
URL (Uniform Resource Locator): A unique Internet address of a file
or destination. To find a particular site or document online, type the
URL into the address field of a browser and press Enter.

upload: To post content on the Internet.

username: The name a person chooses to be identified by, for example
on a computer within a network, or in an online gaming forum (also
called a nickname or gamer tag).

V
videocams: Also called Web cams, these video cameras are attached to
or built into computers. Web cams are used to send a video images to
others while communicating online.

virus: A self-replicating software program that spreads by sending
copies of itself to other devices hidden in code or attached to docu-
ments. Viruses are often deliberately destructive to any device that
becomes infected, often destroying data or disabling the device’s oper-
ating system.

Voice over Internet Protocol (VoIP): Use of an Internet protocol to
transmit voice communications. VoIP allows you to hold voice conver-
sations over the Internet.
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W
Web browser: See browser.

Web site: A collection of documents called Web pages.

Web hosting: A service that provides individuals, organizations, and
businesses with online storage space to store and share information,
images, blogs, video, or any other content accessible through the Web.

Wiki: A collaborative tool which allows users to contribute information
and ideas on a Web site.

World Wide Web (Web): The system of documents stored online,
which you can locate using a Web browser such as Internet Explorer.
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